
SIEBEL REMOTE AND
REPLICATION MANAGER
ADMINISTRATION GUIDE
VERSION 7.5, REV. A

JANUARY 2003

12-EDXI13



Siebel Systems, Inc., 2207 Bridgepointe Parkway, San Mateo, CA 94404
Copyright © 2002 Siebel Systems, Inc. 
All rights reserved.
Printed in the United States of America

No part of this publication may be stored in a retrieval system, transmitted, or reproduced in any way, including 
but not limited to photocopy, photographic, magnetic, or other record, without the prior agreement and written 
permission of Siebel Systems, Inc.

Siebel, the Siebel logo, TrickleSync, TSQ, Universal Agent, and other Siebel product names referenced herein 
are trademarks of Siebel Systems, Inc., and may be registered in certain jurisdictions.

Other product names, designations, logos, and symbols may be trademarks or registered trademarks of their 
respective owners. 

U.S. GOVERNMENT RESTRICTED RIGHTS. Programs, Ancillary Programs and Documentation, delivered 
subject to the Department of Defense Federal Acquisition Regulation Supplement, are “commercial computer 
software” as set forth in DFARS 227.7202, Commercial Computer Software and Commercial Computer Software 
Documentation, and as such, any use, duplication and disclosure of the Programs, Ancillary Programs and 
Documentation shall be subject to the restrictions contained in the applicable Siebel license agreement. All 
other use, duplication and disclosure of the Programs, Ancillary Programs and Documentation by the U.S. 
Government shall be subject to the applicable Siebel license agreement and the restrictions contained in 
subsection (c) of FAR 52.227-19, Commercial Computer Software - Restricted Rights (June 1987), or 
FAR 52.227-14, Rights in Data—General, including Alternate III (June 1987), as applicable. Contractor/licensor 
is Siebel Systems, Inc., 2207 Bridgepointe Parkway, San Mateo, CA 94404.

Proprietary Information
Siebel Systems, Inc. considers information included in this documentation and 
in Siebel eBusiness Applications Online Help to be Confidential Information. 
Your access to and use of this Confidential Information are subject to the terms 
and conditions of: (1) the applicable Siebel Systems software license 
agreement, which has been executed and with which you agree to comply; and 
(2) the proprietary and restricted rights notices included in this documentation.



Contents
Introduction
How This Guide Is Organized  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Revision History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Chapter 1. Siebel Remote Concepts
Siebel Remote Architecture . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

Elements in Siebel Remote Architecture . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Siebel Remote Flow Diagram . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Siebel Remote Data Store Components . . . . . . . . . . . . . . . . . . . . . . . . . 27

Siebel Database Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

Siebel File System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Local Database and File System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Siebel Remote Client Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Siebel Remote Server Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

Creating Siebel Server Directories for Mobile Web Clients . . . . . . . . . . . . . . 31

Generate New Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

Database Extract  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Synchronization Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Transaction Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Transaction Router . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Transaction Merger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Using Siebel Remote . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Registering a Mobile User . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Generating a Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36

Extracting a Mobile Web Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 3



Contents
Initializing the Local Database  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
Synchronizing a Mobile Web Client . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40

How Changes Are Propagated to and from a Mobile Web Client  . . . . . . . . . 42

Synchronizing a Mobile Web Client Machine . . . . . . . . . . . . . . . . . . . . . . . 48

Security and Authentication  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Authentication During Synchronization with Server Database . . . . . . . . . . . 49

Authentication During Normal Operations . . . . . . . . . . . . . . . . . . . . . . . . . 50

Locking and Concurrency . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Conflict Detection and Resolution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Update Conflicts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Duplicate Conflicts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Delete Conflicts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Merge Conflicts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Chapter 2. Implementing Siebel Remote Server
Setting Siebel Remote System Preferences  . . . . . . . . . . . . . . . . . . . . . . 58

MRG: System Conflict Resolution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

MRG: Docking Timestamp Source . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Docking: Transaction Logging . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Docking: Get All PostnCon rows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

CSM Logging  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

MRG: Txns Per Commit  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

MRG: User Friendly Notification  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

LOGMGR: Vis Rules Per Statement  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

DBX: Vis Rules Per Statement 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

DBX: Vis Rules Per Statement N  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Enterprise DB Server Code Page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Choosing Assignment Manager Settings for Siebel Remote . . . . . . . . . . . 65

Disabling Local Access to All Views . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Starting Siebel Remote Server Components . . . . . . . . . . . . . . . . . . . . . . 67
4 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Contents
Transaction Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68
Transaction Router . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Transaction Merger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

Synchronization Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

Enabling Windows NT Rights on Siebel Remote Server  . . . . . . . . . . . . . 76

Changing the Local Database Administrator Password  . . . . . . . . . . . . . . 77

Generating a New Database Template . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Creating a New Empty Database File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

Running the Generate New Database Component . . . . . . . . . . . . . . . . . . . . 80

Distributing Database Templates to Siebel Remote Servers  . . . . . . . . . . . . . 82

Chapter 3. Setting Up Mobile Web Clients
Setting Up Mobile Web Client Hardware and Software  . . . . . . . . . . . . . . 84

Enabling Network Connectivity . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

Establishing Autodial Preferences  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

Setting Synchronization Preferences . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Synchronization Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 87

Using Autosynchronization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

Filtering Regional Workflows  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

Enabling Encryption for Synchronization Networking . . . . . . . . . . . . . . . . . 91

Using a Different Data Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 93

Registering a Mobile Web Client  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 94

Routing Rules and Dock Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Routing Rules . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Dock Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 98

Using Routing Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .100

Field Sales Representative Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 101

Field Sales Manager Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Field Technician . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 102

Senior Field Engineer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 104
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 5



Contents
Field Engineer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 110

Consultant . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 114

Analyst  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

Minimal Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

Mobile Partner User  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Mobile Client – Standard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Mobile Client – Extract Only . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Executive Management . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Limiting Views Available to Mobile Web Clients  . . . . . . . . . . . . . . . . . . 118

Using the Responsibilities View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

Using the Views View . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

Creating Mobile Web Client User Accounts and Privileges  . . . . . . . . . . . 121

Chapter 4. Extracting Databases for Mobile Web Clients
Database Extraction for a Mobile Web Client  . . . . . . . . . . . . . . . . . . . . 124

Database Extraction for Multiple Users  . . . . . . . . . . . . . . . . . . . . . . . . . . 126

Example of Extracting Databases for Multiple Users  . . . . . . . . . . . . . . . . . 127

Performing a Database Extract to a CD Directory  . . . . . . . . . . . . . . . . . . . 128

Parameters of the Database Extract Component  . . . . . . . . . . . . . . . . . . . . 130

Initializing a Mobile Web Client Database  . . . . . . . . . . . . . . . . . . . . . . 134

Enabling the Stand-Alone Synchronizer  . . . . . . . . . . . . . . . . . . . . . . . . 136

Viewing Session Details on Mobile Web Clients  . . . . . . . . . . . . . . . . . . 138

Chapter 5. Administering Siebel Remote
Starting and Stopping Siebel Remote Server Components . . . . . . . . . . . . 142

Transaction Processor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Transaction Router . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 143

Transaction Merger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145

Monitoring Siebel Remote Operations  . . . . . . . . . . . . . . . . . . . . . . . . . 146

Monitoring Mobile Web Client Status . . . . . . . . . . . . . . . . . . . . . . . . . . . . 146
6 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Contents
Monitoring Transaction Logs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 154

Monitoring Siebel Remote Server Operation Status . . . . . . . . . . . . . . . . . . 157

Data Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 159

Managing Synchronization Frequency . . . . . . . . . . . . . . . . . . . . . . . . . . . 159

Auto Synchronization . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 160

Sending Messages to Mobile Users . . . . . . . . . . . . . . . . . . . . . . . . . . . .161

Refreshing a Client Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 162

Deactivating and Reactivating a Mobile Web Client  . . . . . . . . . . . . . . . 164

Deleting a Mobile Web Client  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 166

Changing Routing Models . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 168

Adding New Mobile Users . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169

How to Set Client-Side Logging  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170

Event Levels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170

Log File Naming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Archiving . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Log File Location  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 172

Event Tracing for Locking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 174

Handling Failure and Recovery  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176

Siebel Remote Transmission Failure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176

Siebel Remote Server Failure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176

Siebel Remote Server Media Failure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 176

File Server Media Failure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Database Server Failure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 177

Server Database Records Truncated or Changed . . . . . . . . . . . . . . . . . . . . 178

Database Server Media Failure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178

Siebel Client Database Failure . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 180

Recovery from Client Initialization Failure  . . . . . . . . . . . . . . . . . . . . . . . . 180

Restoring the File System After Recovery from a Previous Image . . . . . . . . 181
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 7



Contents
Chapter 6. Siebel Remote Reports
Status Reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 184

Using the Outbox Analysis Report . . . . . . . . . . . . . . . . . . . . . . . . . . . . 189

Chapter 7. Siebel Replication Manager Concepts
Siebel Replication Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

Comparison with Siebel Remote  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 194

Benefits of Siebel Replication Manager . . . . . . . . . . . . . . . . . . . . . . . . . . . 195

Siebel Replication Manager Architecture  . . . . . . . . . . . . . . . . . . . . . . . 195

Routing Groups and Routing Rules  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Components of Siebel Replication Manager  . . . . . . . . . . . . . . . . . . . . . . . 199

Components Supported on a Regional Node . . . . . . . . . . . . . . . . . . . . . 202

Chapter 8. Implementing Siebel Replication Manager
Installing a New Enterprise Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . 211

Installing the Siebel Name Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

Installing the Siebel Server  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 212

Installing the Siebel Database Server . . . . . . . . . . . . . . . . . . . . . . . . . . . . 213

Installing the Siebel File System  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 214

Defining the Regional Node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 215

Registering a Regional Node  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
Adding Mobile Users to the Regional Database . . . . . . . . . . . . . . . . . . . . . 218

Extracting the Regional Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 219

Initializing the Regional Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . 224

Configuring Regional Node for Mobile Web Clients . . . . . . . . . . . . . . . . 231

Starting Replication Agent  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 232

Setting Up Additional Application Servers on Regional Nodes . . . . . . . . . 234
8 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Contents
Chapter 9. Administering Siebel Replication Manager
Managing Mobile Databases on a Regional Node . . . . . . . . . . . . . . . . . 236

Adding Connected Users to a Regional Node . . . . . . . . . . . . . . . . . . . . 237

Managing Synchronization  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238

Resolving Synchronization Conflicts  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238

Replication Agent Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 239

Changing the Routing Group for a Regional Server . . . . . . . . . . . . . . . . 242

Monitoring Regional Application Servers  . . . . . . . . . . . . . . . . . . . . . . 244

Managing Security and Authentication . . . . . . . . . . . . . . . . . . . . . . . . 244

Performing Backup and Recovery of Data . . . . . . . . . . . . . . . . . . . . . . 245

Managing Backlog in the Transaction Log Table . . . . . . . . . . . . . . . . . . 246

Deactivating and Reactivating a Regional Node . . . . . . . . . . . . . . . . . . 247

Chapter 10. Upgrading Regional Nodes
Upgrading the Repository for a Regional Node . . . . . . . . . . . . . . . . . . . 250

Repository Upgrade with Siebel Anywhere  . . . . . . . . . . . . . . . . . . . . . .251

Repository Upgrade Without Siebel Anywhere . . . . . . . . . . . . . . . . . . . 252

Chapter 11. Troubleshooting Remote and Replication Manager
Setting Up Remote Server and Remote Clients . . . . . . . . . . . . . . . . . . . 256

Replication Agent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 258

Replication Agent Failure Due to Special Characters During an Update  . . . 258

Synchronization Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260

SynchMgr Situation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 260
FAQ: What to Do with an Initialization or Synchronization Problem  . . . . . 262

FAQ: Long Initialization/Synchronization Times . . . . . . . . . . . . . . . . . . . . 262

FAQ: Cannot Connect to Server During Synchronization . . . . . . . . . . . . . . 263

What to Do When Transaction Merger Fails  . . . . . . . . . . . . . . . . . . . . 266

Users Who Cannot See Records When Connected Locally . . . . . . . . . . . 268

How to Handle a Large Transaction Backlog  . . . . . . . . . . . . . . . . . . . . 270
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 9



Contents
Appendix A. Client-Side Merge Issues on the Server
Definition of the Problem . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 274

Solution  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 276

Appendix B. Docking Object Changes
Routing Definition Differences in Docking Objects  . . . . . . . . . . . . . . . . 280

Visibility Level Changes for Docking Objects  . . . . . . . . . . . . . . . . . . . . 287

New Regional Docking Objects  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 290

Appendix C. Routing Models for Financial Services
Using Routing Models in Siebel Financial Services  . . . . . . . . . . . . . . . . 292

Analyzing the Use of Routing Models  . . . . . . . . . . . . . . . . . . . . . . . . . . . 294
Descriptions of Financial Services Routing Models . . . . . . . . . . . . . . . . . . 296

Index
10 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Introduction
This guide provides information necessary to implement, configure, and administer 
Siebel Remote and Siebel Replication Manager.

Although job titles and duties at your company may differ from those listed in the 
following table, the audience for this guide consists primarily of employees in these 
categories:

The guide assumes users have an understanding of their system and network.

Database 
Administrators

Persons who administer the database system, including data 
loading, system monitoring, backup and recovery, space 
allocation and sizing, and user account management.

Siebel Application 
Administrators

Persons responsible for planning, setting up, and maintaining 
Siebel applications.

Siebel System 
Administrators

Persons responsible for the whole system, including installing, 
maintaining, and upgrading Siebel applications. 
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How This Guide Is Organized
How This Guide Is Organized
This guide includes three areas: Siebel Remote, Siebel Replication Manager, and 
Troubleshooting. Also, there are two appendices: Client-Side Merge Issues on the 
Server and Docking Object Differences.

The first two areas discuss concepts, implementation, and administration of Remote 
and Replication Manager. The third area provides troubleshooting information 
using scenarios and FAQs to help administrators resolve problems. 

The first appendix discusses repair of orphaned server records that may appear from 
time to time when you invoke the merge functionality from a client. The second 
appendix describes the differences in the Docking Objects between Siebel 7.5 and 
Siebel 7.0.3. The third appendix describes the routing models in Siebel Financial 
Services that are different from the routing models in Siebel Remote and Replication 
Manager.
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Revision History
Revision History
Siebel Remote and Replication Manager Administration Guide, Version 7.5, Rev. A

January 2003 Bookshelf
Table 1. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision

“Siebel Remote Flow Diagram” on page 20 Added information about unsupported SQL 
changes in Table 1 on page 21. 

“Siebel Database Server” on page 27 Expanded description of master transaction 
log table.

“Siebel Remote Client Software” on page 30 Added prohibitions concerning local 
databases, directory names, and DX files.

“File Attachments and Siebel Remote” on 
page 47

Added information about how Siebel 
Remote handles file attachments.

“Duplicate Conflicts” on page 54 Added information about the column 
CONFLICT_ID.

“Docking: Transaction Logging” on page 61 Added recommendation about EIM batch 
sizes.

“Choosing Assignment Manager Settings 
for Siebel Remote” on page 65

Added this topic.

“Transaction Router” on page 71 Modified usage notes for TS Cache Size 
parameter and added entry for Id Db Size 
parameter in Table 6 on page 71.

“Creating a New Empty Database File” on 
page 79

Added note concerning dbinit utility.

“Running the Generate New Database 
Component” on page 80

Modified usage note for SQL Anywhere 
Database parameter in Table 9 on page 81.

“Dock Objects” on page 98 Added note about actions to take after any 
database schema change.

“Creating Mobile Web Client User Accounts 
and Privileges” on page 121

Modified wording to clarify context and 
details.
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Revision History
Additional Changes
■ Added Appendix C, “Routing Models for Financial Services.” This appendix was 

formerly a separate document, Siebel Remote and Replication Manager 
Administration Guide Addendum for Financial Services. It contains information 
that applies to the Siebel Financial Services product only.

“Database Extraction for a Mobile Web 
Client” on page 124

Added paragraph about database schemas 
and private dock objects.

“Database Extraction for a Mobile Web 
Client” on page 124

Changed default value for Database 
Template File Name parameter in Table 12 
on page 130.

“Components Supported on a Regional 
Node” on page 202

Expanded and modified topic to reflect 
current details.

“Extracting the Regional Database” on 
page 219

Expanded and modified information 
concerning parallel database extract utility 
(pdbxtract). Includes changes to relevant 
procedures.

“Initializing the Regional Database” on 
page 224

Added paragraph about database user ID 
requirements for use with srvrinit utility.

Table 1. Changes Made in Rev. A for January 2003 Bookshelf

Topic Revision
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Siebel Remote Concepts 1
This chapter provides an overview of Siebel Remote. This includes architecture, 
components, software, setup, security, and resolution of data conflicts between the 
two users.

Siebel Remote allows mobile Web clients (typically operating remotely, in 
disconnected mode on laptops) to connect to a Siebel Server and exchange updated 
data and files, a process known as synchronization. Siebel Remote supports mobile 
computing by allowing field personnel to share current information with members 
of virtual teams of other mobile and connected users across the organization. 

As mobile users enter and update information in their local databases, Siebel 
Remote client software tracks the changes as synchronization transactions. 
Subsequently, when the user connects to the Siebel Remote server (through a 
modem, LAN, WAN, or other network to include a VPN), these transactions are 
uploaded from the mobile Web client to the server. 

Between synchronization sessions, the Siebel Remote server prepares transactions 
applied to the database server by other users. Siebel Server components then write 
these transactions to a separate outbox for each mobile user. The transactions—
combined with updated, published, or requested marketing literature, 
correspondence templates, and other types of file attachments—are downloaded to 
the mobile Web client during the next synchronization session.

New or Enhanced Capabilities
Siebel 7.5 includes the following enhanced or new capabilities for Remote and 
Replication Manager:

■ Reduction of enterprise data routed to mobile Web clients. This helps to 
optimize the size of the local databases.

■ Filtering workflow processes from the local database that apply only at the 
regional level. This helps optimize the size for the local databases.
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■ Enhanced tracing capability that helps with system diagnostics.

■ Standardized Status reports added to increase availability of status and 
diagnostic information.

■ Autosynchronization to improve the frequency of synchronization. This reduces 
the outbox backlog and therefore shortens the average synchronization time for 
mobile Web clients.

■ Enhanced routing model support with new local access management for views.

■ Language filtering for multilingual deployment.

NOTE: This guide assumes that you have successfully installed your Siebel 
application and completed the implementation steps described in Applications 
Administration Guide.
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Siebel Remote Architecture
Siebel Remote Architecture
This section describes the architecture for Siebel Remote and illustrates the process 
flow. 

■ “Elements in Siebel Remote Architecture”

■ “Siebel Remote Flow Diagram” on page 20

Elements in Siebel Remote Architecture
Figure 1 illustrates major elements in the Siebel Remote architecture.

Siebel database. A computer on which the Siebel database resides. Tables in this 
database store information about your organizational structure, job responsibilities, 
sales personnel, sales territories, accounts, sales opportunities, and product lines. 
Other enterprise-wide databases may also reside on this server.

Figure 1. Siebel Remote Hardware Architecture
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Siebel Remote Architecture
Siebel File System. A directory structure that contains the Siebel Encyclopedia items, 
correspondence templates, file attachments, and other files for client access and 
download. The Siebel Remote server must have network connectivity to the Siebel 
File System, which may be located on a Siebel Server, Siebel database server, or 
other server on the network. For more information on the Siebel File System, see 
“Siebel File System” on page 28.

Database access. The combination of hardware and software that enables a Siebel 
Remote server to access the Siebel database server. This connectivity is typically 
established using an ODBC driver and the database vendor’s specific connectivity 
package. Due to the volume of data exchanged between the Siebel Remote server 
and the database server, this access needs to be provided over a 100 MB or faster 
network connection, such as Fast Ethernet or FDDI.

Siebel Remote server. A Siebel Server that runs the Siebel Remote components and 
manages synchronization sessions with mobile Web clients. Each Siebel Remote 
server manages a distinct group of mobile users who are assigned to that specific 
server. Other Siebel Server components, such as Assignment Manager and 
Enterprise Integration Manager, may run on the same Siebel Server.

To maintain a high level of integrity and availability, the Siebel Remote server is an 
interim storage area for data required to synchronize mobile databases with the 
Siebel database server. To make sure of the integrity and availability of this data, 
administrators should implement a redundant disk configuration for the Siebel 
Remote server. Using redundant disk configuration will reduce the likelihood of 
losing data on the Remote server caused by malfunctioning hardware. However, if 
it does occur, a reextract of all mobile Web clients registered on the affected Remote 
server will be necessary. 

Siebel Remote Client. Siebel Remote client software installed on the Siebel Mobile 
Web Client. During synchronization, it communicates directly with the 
Synchronization Manager component on the Siebel Server to synchronize the 
mobile node with its parent. 

Components of Siebel Remote client are (a) Local Database and File System, and 
(b) Local Database Initialization Program.

Modem, LAN, or WAN. The combination of hardware and software that enables a 
mobile Web client to communicate with the Siebel Remote server. Mobile Web 
clients must communicate with the Siebel Remote server using the TCP/IP protocol.
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Client. A computer running the Siebel applications client software. The mobile Web 
client is used for Siebel Remote. 

Siebel Mobile Web Client. A computer (typically a laptop) that normally operates as 
a stand-alone unit, with a portion of the server database downloaded to a local 
database. This technique provides efficient access to the user’s specific data. Mobile 
Web clients periodically connect to, and communicate with, a Siebel Server using a 
modem across public telephone lines, LAN or a WAN.

The Siebel Mobile Web Client also runs inside a standard Web browser. However, 
layers of the Siebel eBusiness Applications architecture, including the local 
database, reside on the user’s personal computer and execute business logic locally. 
This client requires installation and periodically connects to a server to synchronize 
the server and the local databases. 
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Siebel Remote Architecture
Siebel Remote Flow Diagram
Figure 2 illustrates the Siebel Remote flow process. Numbers in the diagram relate 
to explanations in Table 1 on page 21. The purpose of this diagram and table is to 
provide a general overview of the process.

After Table 1 on page 21, there are smaller diagrams for the two parts of the Remote 
flow process—data downflow (Figure 3 on page 25) and data upflow (Figure 4 on 
page 26).

Figure 2. Siebel Remote Flow Diagram
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Table 1. Steps in the Siebel Remote Flow Diagram

Step Explanation of the Diagram

1 ■ Every action in the Siebel database is considered a transaction.

■ These include adds, deletes, updates, merges, and so on.

■ A copy of each transaction is stored in the Master Transaction Log (S_DOCK_TXN_LOG), 
provided that the transaction is accomplished using Siebel software. Direct SQL modification of 
Siebel tables is not supported. SQL changes that are executed outside the Siebel application are 
not recorded in the Master Transaction Log (S_DOCK_TXN_LOG) and therefore will not be routed 
to mobile clients. 

■ When using EIM to import records to the database, transactions are logged in the File System to 
improve performance. If mobile Web clients will have read/write access to the records imported 
during a particular EIM session, it is strongly recommended that the administrator use the row-
by-row logging method. For additional information about this topic, see Siebel Enterprise 
Integration Manager Administration Guide.

■ Transactions are stored at the field level to minimize the size of S_DOCK_TXN_LOG. When 
Transaction Logging is turned on and an action occurs, only changes to the fields are captured as 
transactions. This helps to optimize the synchronization process. 

2 ■ The Transaction Processor picks up the transactions stored in S_DOCK_TXN_LOG and copies 
them to the Applications Server directory DOCKING\TXNPROC.

■ The Transaction Processor also picks up some transactions from the file system and copies them 
to DOCKING\TXNPROC. These file system transactions are of type External File.

■ After the transactions are copied to Applications Servers, TXNPROC clears the 
S_DOCK_TXN_LOG of the transactions.

3 ■ Transaction Router picks up the transactions from DOCKING\TXNPROC and determines which 
mobile users should receive them.

4 ■ The first time Remote Administrator creates a database extract for a remote user, this action 
triggers the creation of a docking directory on the remote server (a Siebel Server) for that user.

■ It creates an inbox and an outbox. 

■ The outbox stores any future extracts as well as DX files from Transaction Router.

■ It then sends these DX files to each Remote client’s outbox on the server in the docking directory 
based upon visibility and routing rules.

■ After Transaction Router completes its task, it instructs Transaction Processor to purge the DX 
files in the DOCKING\TXNPROC directory base on the Transaction Processor’s parameter: Clean 
.dx files iterations.
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5 ■ During implementation of Siebel eBusiness Applications, at least one Siebel Server is designated 
as a Remote server. It will host all or some of the Remote users. 

■ This server contains the Docking Directories for remote users to transfer the files involved with 
the synchronization process. These files include:

■ New database templates (from the Generate New Database task)

■ Database extracts (used with the templates to initialize the local DB)

■ DX files (.dx)

■ TOC files (.toc)

■ Visibility data for the Remote clients (visdata.dbf and dobjinst.dbf)

6 ■ Remote clients process transactions in their local database while in disconnected mode. 

■ A copy of each transaction is stored in the Local Transaction Log (similar to the Master 
Transaction Log on the server side).

7 ■ When the user starts the synchronization process, the Remote Client creates DX files from the log 
and moves these DX files to the Remote client’s outbox on the local machine.

8 ■ The synchronization process starts when the Remote client initiates a synchronization session. 

■ Synchronization Manager must be running and will authenticate the Remote client, based upon 
the type of authentication in the Component Parameters.

■ The synchronization process includes handling communication between the mobile Web clients 
and the file system.

■ The process moves the DX files from the docking directory outbox to the Remote client’s inbox. It 
will move files from the Remote client’s outbox to the docking directory’s inbox.

■ Any attachments, correspondence, or templates that the Remote client creates are copied to the 
Siebel File System.

9 ■ Changes do not occur in the server database until the synchronization session finishes and the 
mobile Web client disconnects. 

■ The Remote client begins applying the DX files to the local database when it completes the file 
exchange with the server.

Table 1. Steps in the Siebel Remote Flow Diagram

Step Explanation of the Diagram
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10 ■ Transaction Merger, a component on the server side, pulls the DX files from the inbox within the 
Docking Directory.

11 ■ Transaction Merger applies the changes to the server.

■ It also identifies conflicts.

■ A setting for System Preference, MRG: System Conflict Resolution, specifies whether the server or 
client wins during conflict resolution. The value can be Server Wins or Client Wins.

■ Conflicts will be communicated to the Remote user during the next synchronization.

■ Transaction Merger deletes the DX files from the inbox within the Docking Directory.

Table 1. Steps in the Siebel Remote Flow Diagram

Step Explanation of the Diagram
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Table 2 lists notes on the Siebel Remote flow process (Figure 2 on page 20).

Table 2. Siebel Remote Flow Diagram Notes

Topic Comments

Remote Configuration File ■ The DockConnString is the logical Siebel server name. This 
represents the server where a mobile client was extracted. It should 
be populated when the client is first initialized. 

■ An important configuration parameter, AutoStopDB, is part of the 
Local configuration. Its default is FALSE, which means the local 
database engine will keep running after Siebel eBusiness 
Applications shut down. This will help shorten the startup time when 
the user restarts Siebel eBusiness Applications. If AutoStopDB is set 
to TRUE, the local database engine will shut down automatically 
when the Siebel eBusiness Applications shut down.

■ In the local database connecting string, -q means the local database is 
started in quiet mode. This prevents a SQL Anywhere window from 
showing up. However, a SQL Anywhere icon will appear on the 
Windows task bar, whether or not the -q parameter is used. This 
provides the user with a way to manually stop the database engine, if 
the user leaves the engine running after Siebel eBusiness 
Applications shut down.

■ On the local database connect string, the - m means truncate 
transaction log after checkpoint; -x NONE means do not load any 
network drivers; -gp 4096 tells the engine that the database page size 
is 4,096 bytes;
-c40m -ch60m sets the initial cache size to 40 MB, with a maximum 
of 60 MB. The cache sizes are suggested values that the user can 
adjust. However, the SQL Anywhere engine will determine the actual 
cache size within the given range of values.

■ In Siebel 7.5, users can specify the sorting order on Local and Sample 
databases. To enable this feature, users modify their CFG file (for 
example, siebel.cfg, uagent.cfg). The SortCollation parameter in the 
CFG file determines the sorting order of the SQL Anywhere database. 
For more details about this topic, see Siebel Web Client 
Administration Guide.
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Figure 3 illustrates the Remote downflow of data. See Table 1 on page 21 for 
explanation of the numbered steps.

Authentication A Synchronization Manager component parameter—you identify the 
type of authentication used during synchronization. Options include:

■ Siebel. Synchronization Manager will compare the password used to 
login to the local db to the Sync Password stored in a Siebel table 
within the server database. 

■ Siebel/db password. Synchronization Manager will compare the 
password used to login to the local db to the mobile Web client’s user 
name and password to connect to the server database.

■ Operating system password (Win 2000 and UNIX). Synchronization 
Manager will compare the password used to login to the local db to 
the operating system password for the user on the application server.

Synchronization Frequency Siebel Systems recommends that mobile users synchronize against the 
server at least daily. There is an automatic mechanism to help enforce 
frequent synchronization. Users can invoke autosynchronization on their 
laptops. For more detail about this topic, see “Using 
Autosynchronization” on page 89.

Table 2. Siebel Remote Flow Diagram Notes

Topic Comments

Figure 3. Remote Down Flow Diagram
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Figure 4 illustrates the Remote upflow of data transactions. See Table 1 on page 21 
for explanation of the numbered steps.

Figure 4. Remote Up Flow Diagram
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Siebel Remote Data Store Components
This section describes the various components that store data used by Siebel 
Remote:

■ “Siebel Database Server”

■ “Siebel File System” on page 28

■ “Local Database and File System” on page 29

Siebel Database Server
The database server stores data for users, with both stationary and mobile Web 
clients.

The database server contains:

■ Siebel applications metadata

■ Siebel applications tables that store user data

■ A master transaction log table that stores changes made since the last database 
extraction, provided that the changes are accomplished using Siebel software. 
Direct SQL modification of Siebel tables is not supported. SQL changes that are 
executed outside the Siebel application are not recorded in the Master 
Transaction Log and therefore will not be routed to mobile clients. 
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The Transaction Processor and Transaction Router components of Siebel Remote, 
which run on the Siebel Remote server, route the transactions from the master 
transaction log to the outbox directories of mobile Web clients. The Transaction 
Processor purges rows from the log after transactions from S_DOCK_TXN_LOG 
have been written into DX files in the txnproc directory. Do not directly modify the 
contents or structure of the master transaction log under any conditions.

CAUTION: Truncation of the S_DOCK_TXN_LOG table in a Server Database causes 
the txn_id values assigned to new transactions to be reset. However, the 
corresponding txn_id values in the S_DOCK_STATUS table are not reset. 
Consequently, new transactions inserted into the S_DOCK_TXN_LOG table will 
have a txn_id mismatch as compared to the values in the S_DOCK_STATUS table. 
Transaction Processor will not process these transactions and will purge them from 
the S_DOCK_TXN_LOG table.

If the S_DOCK_TXN_LOG table is truncated, then all mobile Web clients must be 
reextracted and all existing transactions and the local database must be deleted 
before the these clients can be reinitialized.

Siebel File System
The Siebel File System stores attachments, correspondence, templates, and other 
types of unstructured data for Siebel users through the File System Manager (FSM). 
Connected users access files from the Siebel File System. The Siebel Remote server 
can transfer files between mobile users and the File System during synchronization.

The File System Manager (FSM) server component manages the Siebel File System 
and handles interplatform security. FSM handles most of the interaction with the 
Siebel File System within the Siebel applications. However, synchronization 
manager also interacts with the Siebel File System during synchronization sessions. 
Web Clients, Dedicated Web Clients, and server components requiring operations 
on files make requests, through the Server Request Broker, to the FSM.

For more information see Siebel Server Administration Guide.
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Local Database and File System
Mobile Web clients use a local database to store data for user access. The local 
database contains Siebel application tables that store user data. 

The local database also contains a local transaction log to store transactions created 
by the mobile user. Siebel Remote forwards these transactions to the Siebel Remote 
server when the client synchronizes. Do not directly modify the local transaction 
log under any circumstances. The Siebel Remote synchronization client 
automatically purges the local transaction log table when appropriate.

NOTE: Users should run only one instance of a local database at any given time. In 
addition, users should defragment their hard drives regularly to optimize 
performance. For further instructions on the defragmentation process, follow your 
local policies.

Also, the local database is designed for only one user and does not support multiple 
logins to a single remote database.

Mobile Web clients also use a local Siebel File System to store files from the Siebel 
File System. Mobile users can request specific files to download to their local File 
System during synchronization. Also, the Siebel administrator can specify files that 
should be published or distributed to mobile users. The Siebel Remote server 
retrieves the files from the Siebel File System and sends them to the local Siebel File 
System. These files are available when the mobile user disconnects from the Siebel 
Server. 

Files that mobile users add to their local File Systems while disconnected are 
uploaded to the Siebel Remote server during synchronization. Then the Siebel 
Remote Server sends these files to the Siebel File System.
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The Siebel Remote client software runs on the Siebel Mobile Web Client and 
manages the synchronization process between the client and the Siebel Remote 
server. 

Mobile users can start the Siebel Remote client in two ways: 

■ Background synchronization

While the Siebel client is running, mobile users can choose File > Synchronize 
Database from the application-level menu. This launches the Siebel Remote 
client as a background process so that work can continue within Siebel 
applications or in other Windows applications during the synchronization 
process.

■ Stand-alone synchronization

Mobile users can launch Siebel Remote in stand-alone synchronization mode 
using the Siebel Remote icon or a third-party scheduling program. This allows 
users to synchronize without starting the Siebel application. The Auto-
Synchronization functionality also uses this method to perform synchronization 
when it starts a synchronization session

The Siebel Remote client uses the TCP/IP protocol to communicate with the Siebel 
Remote server over a modem using dial-up networking, a local area network or a 
wide area network.

The Siebel Remote client connects to the Siebel Remote server; the Siebel Remote 
server then starts a synchronization session for the mobile Web client. Transactions 
(DX files) and file attachments are sent down to the client machine from the server 
and up from the client machine to the server. 

Each Siebel Remote Client installation must be used with exactly one local database. 
Do not rename directories that contain Siebel Remote Client software, or attempt to 
use additional local databases. Do not rename or delete DX files. 

NOTE: Transactions are not lost after a client reextract.
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This section discusses the Siebel Remote server components that operate on the 
Siebel Server and provides an overview of the administration tasks you need to 
perform for each component.

■ “Creating Siebel Server Directories for Mobile Web Clients”

■ “Generate New Database” on page 32

■ “Database Extract” on page 33

■ “Synchronization Manager” on page 33

■ “Transaction Processor” on page 34

■ “Transaction Router” on page 34

■ “Transaction Merger” on page 35

Creating Siebel Server Directories for Mobile Web Clients
Each registered mobile Web client requires a separate directory on the Siebel 
Remote server. The Database Extract program creates the appropriate directory and 
its subdirectories for each mobile Web client.

NOTE: The installation program also places a directory called txnproc in the docking 
subdirectory within the Siebel server root directory. Do not modify the contents of 
this directory under any circumstances.

The following example shows a portion of the server directory tree after you run 
Database Extract for mobile Web clients named Adams and Scott:

siebel
docking

adams
inbox
outbox

scott
inbox
outbox

txnproc
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Generate New Database
The Generate New Database component creates the local database template for a 
given database schema version. The component reads the database schema 
definition from the Siebel repository, then creates Siebel tables and indexes in a 
database template file stored on the Siebel Remote server in the dbtempl 
subdirectory.

The Local Database Initialization program uses the local database template when 
initializing a new database on the mobile Web client.

NOTE: Dicdata.dat and diccache.dat are the same dictionary file. Dicdata.dat is 
named differently for mobile Web clients. These files store metadata about schema 
definitions, vis-rules, and other items. 

The Generate New Database component copies diccache.dat to the 
dbtempl\\dicdata.dat file. The dicdata.dat file is downloaded to mobile Web clients 
and used by the synchronization process whenever transactions are applied to the 
local database. 

If you need to interchange the dicdata.dat file between mobile Web clients for 
different languages, contact Siebel Tech Support to determine if the languages are 
interchangeable.

Administration of the Generate New Database Component
You must generate a new database template whenever the Siebel database schema 
changes in cases such as:

■ Immediately upon installing the Siebel database server

■ Following an upgrade to a new version of Siebel applications

■ Extending the database schema using Siebel Tools—except when using Siebel 
Anywhere to deliver a database schema upgrade kit

If your deployment requires a different collation template not provided by Siebel 
eBusiness Applications, please contact Siebel Expert Services for assistance in 
creating a new collation template.
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Optimal Size for Local Databases
The recommended size for the SQL Anywhere local database depends upon several 
factors. These include the mobile Web client user’s position and responsibilities. 
Also, the Data Routing Model assigned to the client impacts the volume of data to 
be stored in the local database. The local database should not be larger than 700 
MB. For further information on this subject, or if a local database will exceed this 
number, contact Siebel Systems.

Database Extract
The Database Extract component creates a database snapshot file for a given mobile 
user. The file contains the data required to initialize the user’s local database. 
Database Extract retrieves data according to routing rules that define the level of 
access to information for each mobile Web client.

Synchronization Manager
The Siebel Remote server starts a Synchronization Manager task for each incoming 
synchronization request from a mobile Web client. For each request, the 
Synchronization Manager:

■ Verifies the mobile Web client status and password (if Siebel Remote 
authentication is enabled)

■ Transfers the local database template and local database extract if applicable

■ Exchanges transaction files

■ Transfers file attachments to and from the Siebel File Server
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Each Synchronization Manager task services only one mobile Web client at any one 
time, but many synchronization tasks can be started concurrently.  This behavior is 
configured by a Synchronization Manager parameter called Max Task. The 
Synchronization Manager component must be enabled for Siebel Remote mobile 
users to be able to connect to the Siebel Remote server for synchronization. 
Synchronization Manager tasks start automatically; you do not need to start tasks 
for this component manually.

NOTE: The Siebel File System parameter for Synchronization Manager component 
determines the file system location for mobile Web clients.

Transaction Processor
The Transaction Processor component scans the master transaction log on the 
Siebel database server and prepares transactions for visibility checking and routing 
by a transaction router. Transaction Processor leaves the last log entry on DB2 and 
leaves 1000 on MS SQL to avoid deadlock problems. 

You can run only one transaction processor on each Siebel Remote server. Upon 
start-up, the transaction processor verifies that another transaction processor is not 
running on the same Siebel Remote server.

Transaction Router
The Transaction Router performs visibility checking and routing of transactions 
from the DX files created in the txnproc directory by the Transaction Processor.

Dock Objects and Routing 
Routing rules determine the subset of Dock Object instances that Siebel Remote 
replicates to each mobile Web client. Dock objects are groupings of tables in the 
database that logically form Siebel business components. Dock objects are similar 
to business components.

Each dock object is classified according to a visibility level. The three classes are:

■ Enterprise 

■ Limited 

■ Private 
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For an Enterprise visibility dock object, Siebel Remote sends all data in the object 
to the mobile Web client. For a Limited visibility object, Siebel Remote sends the 
object to a mobile Web client only if the instance is visible to the mobile user. 
Private dock objects are not routed to a mobile Web client from a Siebel server.

Siebel applications provide preconfigured user routing rules. As delivered, the 
Siebel routing rules encompass a combination of implicit security rules (based on 
responsibility) and assignment rules that determine a user’s access to information. 

If your deployment contains a large number of high level objects such as Assets, 
Accounts, or Activities, you may want to contact Siebel Expert Services to help 
reconfigure certain routing rules for optimal performance.

In Siebel 7.5 some Dock Objects were added, and some were dropped from those 
included in Siebel 7.0.3. Also, some visibility levels were changed. See Appendix B, 
“Docking Object Changes” for a listing of detailed changes in Dock Objects.

Administration of the Transaction Router
You must run at least one transaction router on each Siebel Remote server. For better 
performance, you should run multiple transaction routers on the same Siebel 
Remote server.

NOTE: Changing the definition of organizations (positions and divisions) can cause 
routers to reevaluate visibility for objects related to the objects that have changed. 
This can affect the performance of the Transaction Router. To alleviate this situation, 
reextract all your mobile Web client databases.

Transaction Merger
The Transaction Merger component applies transactions to the Siebel database 
server that were uploaded into the appropriate Application server inbox by a Siebel 
Remote mobile user. The application of these transactions to the Siebel database 
takes place after the synchronization session finishes and the mobile Web client 
disconnects.

You must run at least one transaction merger on each Siebel Remote server. For 
better performance, you can run multiple transaction mergers on the same Siebel 
Remote server. 
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Using Siebel Remote
This section provides a high-level overview of the logical steps involved in 
extracting, initializing, and synchronizing a Siebel Remote mobile user. Procedures 
for completing each step are covered in other chapters in this guide.

■ “Registering a Mobile User”

■ “Generating a Database”

■ “Extracting a Mobile Web Client” on page 37

■ “Initializing the Local Database” on page 37

■ “Synchronizing a Mobile Web Client” on page 40

■ “How Changes Are Propagated to and from a Mobile Web Client” on page 42

■ “Synchronizing a Mobile Web Client Machine” on page 48

Registering a Mobile User
Before a mobile user is registered, that person must be in the system as a user. 
Mobile users typically operate in disconnected mode and synchronize frequently to 
keep their local databases in balance with the Server database. For information on 
adding users, see Applications Administration Guide.

Generating a Database
If you are setting up a Siebel Remote server for the first time, you will also need to 
generate a new database template. Generate a new template by running the 
Generate New Database component. On the Application server, this component 
creates a template and places it in the dbtempl directory on the Application server. 
For information on generating a new database template, see “Generating a New 
Database Template” on page 79.
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Extracting a Mobile Web Client
The first step in creating a local database for a new mobile user is to extract the 
database on the Siebel Remote server. Extract mobile Web clients by running the 
Database Extract component. This component extracts visible data for the mobile 
user into a snapshot file in the mobile Web client’s outbox directory on the 
Application server. 

NOTE: Each local database is a different entity. Therefore, a user cannot use multiple 
machines as the same Remote client.

Initializing the Local Database
When users log in and specify the Local database as the data source the first time, 
Siebel Remote will detect that a local database does not exist. This prompts the user 
to connect to the Siebel Remote server in order to retrieve it.

This process performs the following tasks:

■ Prompts for mobile Web client connection information. Enter the user’s name, the 
mobile Web client name (a given user may have multiple mobile Web clients, 
such as two clients on two separate computers), and a confirmation password. 
If started from the Siebel Mobile Web Client, Siebel Remote uses the username 
and password entered by the user in the Siebel Mobile Web Client.

■ Connects. If specified by the user, the synchronization client dials the modem to 
connect to the application server. The synchronization client connects to the 
Siebel Server—if the user has access to this server and the Synchronization 
Manager port is open. Then a new synchronization thread services the mobile 
Web client.

For example, a VPN setup may require the user to enter a special PIN and 
security token number such as an RSA.
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 37



Siebel Remote Concepts

Using Siebel Remote
■ Validates mobile Web client. The Synchronization Manager validates the mobile 
Web client’s node name against the list of valid users in the server database. The 
Synchronization Manager also checks that the mobile Web client is connected 
to the correct Siebel Remote server. Finally, if Siebel Remote authentication is 
enabled, the Synchronization Manager authenticates the mobile Web client’s 
password. 

■ Checks for database extract. The Synchronization Manager verifies that a 
database extract is pending in the application server outbox. During this 
verification, the Synchronization Manager checks for UAF files (.uaf) and TOC 
files (.toc) in the mobile user's outbox subfolder. If they are not there, the 
synchronization client asks the user to contact the Siebel administrator to 
perform a database extract.

■ Downloads snapshot and file attachments. If the UAF and TOC files are present, the 
mobile user will be prompted to download a new database during the 
synchronization session. The synchronization client downloads the extract and 
file attachments to the mobile Web client’s inbox directory. 

■ Disconnects. The synchronization client closes the connection with the 
Synchronization Manager. The mobile user can disconnect from the network at 
this point.

■ Creates and loads database. The synchronization client shuts down the Siebel 
client or Siebel Remote program and starts the Siebel Upgrade Wizard. The 
Siebel Upgrade Wizard creates a new local database, loads data from the extract 
file into the local database, and applies file attachments to the local File System.
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Figure 5 shows the processes that occur when a local database is initialized.

For additional details on initializing the mobile Web client database, see 
“Initializing a Mobile Web Client Database” on page 134.

NOTE: In order to load the mobile Web client faster, you can enable Siebel 
QuickStart. Check the box titled Enable Siebel QuickStart on the Siebel Login Screen 
for the Mobile Web Client. Siebel.exe will be preloaded to the memory at the system 
login time. Then every subsequent client session will call the existing process 
instead of creating a new one, until the user disables QuickStart. For more 
information about QuickStart, see Siebel Web Client Administration Guide. 

Figure 5. Initialize Local Database
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Synchronizing a Mobile Web Client
This section describes the processes for synchronizing a mobile Web client.

Routing and Merging
On the Siebel Remote server, the Transaction Router and Transaction Merger 
components continuously route and apply transactions for mobile Web clients. 
These two tasks process data asynchronously from the synchronization sessions in 
order to minimize the connection time between the mobile Web client and the 
Siebel Remote server.

■ Transaction router. One or more transaction router tasks on the application server 
continuously route outgoing transactions (in the txnproc directory created by the 
Transaction Processor) to the mobile Web client’s outbox folders.

■ Transaction merger. One or more Transaction Merger tasks on the application 
server continuously merge incoming transactions from the mobile Web client’s 
inbox directories to the server database and the Siebel File System.

Figure 6 shows the processes that occur when a mobile Web client is synchronized.

Figure 6. Synchronizing a Mobile Web Client (Routing and Merging)
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Synchronization Session
To synchronize an existing mobile Web client, the mobile user launches Siebel 
Remote, either from within the Siebel mobile Web client or in stand-alone mode. 
Siebel Remote executes the following steps:

■ Connects. If specified by the user, Siebel Remote dials the modem to connect to 
the Siebel Remote server, using connection information from the Windows 
phone book. Once network connectivity is established, the Siebel Remote client 
connects to the Siebel Server. If the user is already connected through a LAN or 
WAN connection, then it merely performs a handshake to validate a network 
connection exists.

■ Validates mobile Web client. The Synchronization Manager validates the mobile 
Web client’s name against the list of valid users in the database server. The 
Synchronization Manager also verifies that the mobile Web client is connected 
to the correct Siebel Remote server. 

If this is not the case, the Synchronization Manager reconnects the mobile Web 
client to another Siebel Remote server and updates the client’s local 
configuration information. 

Finally, if Siebel Remote authentication is enabled, the Synchronization Manager 
authenticates the mobile Web client’s password.

■ Check for correct version. The Synchronization Manager checks, against the 
server, that the mobile Web client is running with the most up-to-date version of 
the application.  If not, it will prompt the user to download a new version of the 
application.

■ Checks for database extract. The Synchronization Manager checks whether a 
database extract is pending for the mobile Web client. If not, the synchronization 
session continues. If there is a database extract pending, the synchronization 
client reinitializes the mobile Web client, using the same process described in 
“Initializing the Local Database” on page 37. Then another synchronization 
session begins.

■ Retrieves transactions and file attachments. The client retrieves transaction files—
created by the Transaction Router—from the mobile Web client’s outbox 
directory on the Siebel Remote server and stores the transaction files in the 
mobile Web client’s local inbox directory. The client also retrieves requested, 
published, or broadcasted file attachments from the Siebel File Server.
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■ Sends transactions and file attachments. The Siebel Remote client extracts pending 
transactions from the local transaction log into transaction files, and sends the 
transaction files to the user’s inbox directory on the Siebel Remote server. 

■ Applies changes to the server database. After disconnecting, Transaction Merger 
applies the incoming transaction files from the mobile Web client’s inbox 
directory on the server to the server database and Siebel File Server.

■ Applies changes to the local database. The Siebel Remote client applies the 
incoming transaction files from the mobile Web client’s inbox directory on the 
mobile Web client to the local database and applies retrieved file attachments to 
the local file system. The mobile user can use the Siebel client while the Siebel 
Remote client applies the changes to the local database.

■ Disconnects. Siebel Remote then closes the connection with the Siebel Remote 
server. If the Siebel Remote client created the network connection automatically, 
it also disconnects the modem; otherwise, the mobile user can manually 
disconnect from the network at this point. 

■ Cleans up. This refers to those files (.dx) that were successfully applied during 
the previous synchronization session. The Siebel Remote client deletes the 
transaction files in the mobile Web client’s local outbox directory that the 
Transaction Merger successfully applied to the database server during the 
previous synchronization session. On the Siebel Remote server, the 
Synchronization Manager deletes the transaction files in the mobile Web client’s 
outbox directory that were successfully applied to the local database during the 
previous synchronization session.

How Changes Are Propagated to and from a Mobile Web Client
Between synchronization sessions, the Siebel Remote server prepares transactions 
applied to the database server by other users—mobile and dedicated. Siebel Server 
components write the transactions to a separate directory for each mobile user. 
These transactions, combined with items from the File System, are downloaded to 
the mobile Web client during the next synchronization session. Items from the File 
System include updated, published, or requested marketing literature, 
correspondence templates, and other types of file attachments. 

A similar process occurs on the client as well, although without the server 
component. 
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Process Flow for Changes by Connected Users 
This section describes the process flow for downloading changes on the server 
database to local databases. The flow takes place from the time a connected user 
creates a new opportunity until it appears in a local database.

This specific process flow includes an example of a telesales representative in a Call 
Center. The telesales person talks to potential customers responding to a new 
advertising campaign.

The telesales person decides to create a new opportunity record for one of the more 
promising responses. Figure 7 illustrates this flow. The numbers in the diagram 
correspond to the list immediately following the diagram.

Figure 7. Process Flow for Changes by Connected Users
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The process flow for the example above includes the following steps:

1 The telesales person creates a new opportunity record—a transaction saved in 
the opportunities table on the server database. A copy is saved to the master 
transaction log.

a Transaction Processor copies this transaction, and others, to the Apps Server.

b A Transaction Router task writes each transaction from the TXNPROC 
directory to transaction files in separate outbox directories for each mobile 
Web client.

The mobile Web client outbox directories are stored on the Siebel Remote 
server.

2 A mobile user invokes a synchronization session from the laptop.

During the synchronization session, the following steps occur to download the 
new Opportunity record to the mobile user’s local database:

a The Siebel Remote client on the laptop dials the modem to connect to the 
Siebel Remote server.

This can be handled by an existing modem or LAN connection.

b The Siebel Remote client connects to the Siebel Remote server.

c The Siebel Remote server starts the synchronization session for the mobile 
Web client.

d The Synchronization Manager validates the mobile Web client’s node name 
against the list of valid mobile users in the server database. 

The Siebel Remote client receives transaction files going to and from the 
Synchronization server, and retrieves file attachments.

e The client retrieves transaction (.dx) files from the user’s outbox directory on 
the Siebel Remote server and stores them in the mobile user’s local inbox 
directory. The client also retrieves the user’s requested, published, or 
broadcasted file attachments from the Siebel File Server.
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f The new opportunity record is inserted into the Opportunity table in the 
user’s local database.

g The Siebel Remote client closes the connection with the Siebel Remote 
server.

The mobile user can use the Siebel client while the Siebel Remote client 
applies the changes to the local database.

CAUTION: Users should never directly modify the local transaction log. The Siebel 
Remote synchronization client automatically purges the local transaction log table. 

Process Flow for Changes Made by Mobile Users
Mobile Web clients use a local database to store data for user access. The local 
database contains Siebel eBusiness Applications tables that store user data. The 
local database also contains a local transaction log to store transactions created by 
the mobile user. Siebel Remote forwards these transactions to the Siebel Remote 
server when the client synchronizes. 

This section provides a description of each phase of the process flow, from the time 
when the mobile user modifies the new opportunity until the time when the 
modifications appear in the Server database. For this example, assume that a mobile 
user is meeting with a potential new client, represented by the opportunity record 
entered by the telesales representative in the previous section.
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Figure 8 illustrates this flow. The numbers in the diagram correspond to the list 
following the diagram.

1 As a result of the meeting, the mobile user makes changes to the Opportunity 
record in the local database on the laptop. The user enters these changes 
immediately after the meeting while working offline.

2 The modified opportunity record is saved to the Opportunities table in the local 
database. A transaction record is saved to the Local Transaction log.

Figure 8. Process Flow for Changes by Mobile Users
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3 The Siebel Remote client extracts pending transactions from the Local 
Transaction log into transaction files (.dx). The client then places these DX files 
in the outbox directory on the laptop.

4 The mobile user synchronizes the laptop.

During the synchronization session, the following steps occur to record the 
changes to the opportunity record:

a Siebel Remote dials the modem to connect to the Siebel Remote server.

If the user is in the office, a LAN connection will also work.

b Siebel Remote client connects to the Siebel Remote server.

c Siebel Remote server starts the synchronization session for the mobile user.

d Synchronization Manager validates the mobile Web client’s node name 
against the list of valid mobile Web clients in the server database. 

e Synchronization Manager sends the transaction files in the outbox directory 
on the laptop to the mobile user’s inbox directory on the Siebel Remote 
server.

f Siebel Remote closes the connection with the Siebel Remote server.

g The changed Opportunity record is inserted into the Opportunity table on the 
Server database.

File Attachments and Siebel Remote
This section provides additional information about how Siebel Remote handles file 
attachments.

When a Siebel Remote client attaches a file to a record in the local Siebel database, 
the meta-data concerning the file is stored in the local Siebel database, and the file 
is stored in the local Siebel file system. When the client synchronizes with the Siebel 
Remote Server, normal synchronization procedures result in the file being copied to 
the server's Siebel file system, and meta-data concerning the file being copied to the 
server's Siebel database. 
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If the record to which the file is attached is accessible to another Siebel Remote 
client, such as another member of a sales team, then ordinarily file meta-data is 
transferred to that team member's local Siebel database when that team member 
next synchronizes. However, the file attachment, itself, usually is not transferred to 
the local Siebel file system until it is specifically requested. (The exception is that 
certain types of file attachments, such as Literature items, have a Distribution 
Method setting. If Distribution Method is set to Publish, the file is automatically sent 
to Siebel Remote users, without needing to be requested.) 

A Remote client requests a file attachment by clicking its link in a Siebel application, 
or by selecting its Request File check box. When this is done, a request for the file 
is queued. In order to actually receive the file, the client must synchronize again, 
which will result in the file being copied to the local Siebel file system. Once the 
synchronization is complete, the client must click the link again to view the file.

Synchronizing a Mobile Web Client Machine
Mobile users must synchronize frequently to obtain and view possible updates in 
the server database. Also, there may be updates to the store of documentation, 
marketing literature, and sales brochures in the file system. 

To synchronize a mobile Web client

1 Start your Siebel application, such as Siebel Sales, in the Siebel program group 
on the mobile Web client machine.

2 From the application-level menu, select File > Synchronize Database.

3 Choose the synchronization options.

See Siebel Web Client Administration Guide for options.

4 Click Synchronize.
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Security and Authentication
This section discusses security and authentication for mobile users.

■ “Authentication During Synchronization with Server Database”

■ “Authentication During Normal Operations” on page 50

Authentication During Synchronization with Server Database
The Siebel Remote Synchronization Manager authenticates incoming mobile Web 
client requests to make sure that a mobile Web client is valid. 

The Synchronization Manager validates the following information when a mobile 
Web client synchronizes with the server database:

Mobile Web client name. Validates the mobile Web client’s name against the list of 
valid mobile Web clients in the server database and validates that the effective end 
date is valid or NULL.

Application server. Verifies that the mobile Web client has connected to the correct 
Siebel Remote server. If the mobile Web client connects to the wrong Siebel Remote 
server, the Synchronization Manager reconnects the mobile Web client to another 
Siebel Remote server and updates the client’s local configuration information. 

Password. Validates the mobile Web client’s password by using one of the following 
authentication methods, represented by the parameter name. The Siebel 
administrator specifies the password authentication method in the Siebel Server 
Component Parameters for Synchronization Manager, and in the appropriate CFG 
file located at the mobile client.

■ None. Does not validate the mobile Web client’s password. This is the default.

■ Database. Uses the mobile Web client’s user name and password to connect to 
the server database.

NOTE: You cannot use the Database authentication model if you have enabled 
password encryption. This would require the mobile user to use the encrypted 
password to log into the local database. For more information about password 
encryption, see Siebel Server Administration Guide.
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■ Siebel. Verifies that the password is the same password stored in a table in the 
server database.

■ AppServer. Verifies that the password is the operating system password for the 
user on the application server.

Authentication During Normal Operations
Another situation where mobile users may use password authentication occurs 
when they are connecting to the local database, which is the normal operation for 
mobile Web clients. The authentication process checks the user password set during 
client initialization against the Local database.

CAUTION: The Mobile web client does not support third-party or customer 
proprietary authentication methods.
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Locking and Concurrency
The following are concurrency rules and behaviors of the Siebel Remote 
components:

■ A transaction processor can run while any other Siebel Remote server 
component is running.

■ There can be only one transaction processor for each Applications server.

■ Only one instance of the Transaction Router, Transaction Merger, 
Synchronization Manager, or Database Extract can process a given mobile Web 
client at any one time. Two transaction routers, therefore, cannot route 
transactions to the same mobile Web client at the same time, nor can two 
transaction mergers merge transactions from the same mobile Web client at the 
same time. Multiple instances of these components can be running on one 
Applications server for better performance.

■ The Transaction Router, Transaction Merger, or Synchronization Manager cannot 
process a mobile Web client while a database extract is in progress for that 
mobile Web client.

■ The Transaction Router, Transaction Merger, and Synchronization Manager, on 
the same server, can process the same mobile Web client at the same time. 

■ Multiple instances of Database Extract running at the same time allow the 
extraction of multiple lists of mobile users, thus reducing the overall extract 
duration. 
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Conflict Detection and Resolution
Siebel Remote supports team selling and field service by allowing different mobile 
users to access data. This creates the possibility that two users may make conflicting 
changes to the same data when they are disconnected from the server. Siebel 
Remote automatically detects update conflicts by comparing transactions at the 
field level. To accomplish this, Siebel Remote uses specific rules to resolve conflicts 
for three types of database data changes:

■ Updating values in an existing row

■ Deleting an existing row

■ Adding a new row

More complex conflicts involve deleting and adding database rows. One user may 
change a value in a database row and another may delete the entire row. One user 
may add a database row to a local database, but the user primary key of the row 
may be in use by an existing row in the server’s database or in another mobile Web 
client’s database. Over time, if such changes go undetected or unresolved, the 
databases on various machines become less synchronized, a phenomenon called 
data divergence. Siebel Remote incorporates conflict detection and resolution logic 
to prevent data divergence between server and mobile Web client databases.
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Update Conflicts
An update conflict occurs if, for example, one user changes a contact’s area code to 
415 and another user changes it to 408. Siebel Remote detects and consistently 
resolves conflicts by using one of two rules: Client Wins or Server Wins. The Client 
Wins rule states that the mobile Web client database value overrides the server 
database value. The Server Wins rule states that the server database value overrides 
the mobile Web client database value. The default setting, Server Wins, is strongly 
recommended to resolve such conflicts because data changes will converge more 
quickly. The Client Wins rule will work as well but will take longer for data to 
converge.

CAUTION: To maintain integrity across databases, the same conflict resolution rule 
must be in effect for client and server databases. You should specify the rule as part 
of the initial Siebel Remote implementation on your database server, and before 
running a database extract for any client so that the rule is replicated consistently 
to the clients.

Siebel Remote applies the same logic to databases to  make sure that they remain 
synchronized. During the initial Siebel Remote implementation, the Siebel 
administrator sets a system preference to reflect which rule is to be in effect.

NOTE: Mobile Web client transactions are processed in the order in which the users 
synchronized. Any successful database update sent from a mobile Web client to the 
server becomes a server transaction for the purpose of conflict resolution. 

If Siebel Remote rejects an update from a mobile Web client, the mobile user can 
determine whether an update conflict has occurred. If the result of Siebel’s conflict 
resolution is inappropriate, the user can manually reapply the change to the local 
database. It will be sent to the server again during the next synchronization session 
when the mobile Web client sends database changes to the server. If other changes 
have not been made to the data value since the last synchronization session, the 
change will not conflict and will succeed on the server.
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Duplicate Conflicts
Although a user may successfully add a database row to a client database (or the 
server database), the added transaction may duplicate a new entry in another 
database residing elsewhere and not yet processed by the server. Siebel Remote 
determines that a duplicate conflict exists when a new row’s user primary key 
matches that of an existing row.

Because Siebel Remote cannot determine whether the transaction is a true duplicate 
or simply an erroneous use of the same identifier for two different data entities, 
Siebel Remote cannot ignore the duplicate transaction. Instead, Siebel Remote adds 
the new row and sets the column CONFLICT_ID, which is normally Zero, to the 
record's ROW_ID. This both indicates that the row is a duplicate and assures a 
unique value for the _U1 index. The mobile user can determine whether a duplicate 
conflict has occurred. 

For example, the user might change the user primary key and resubmit the update. 
As the user resolves the conflict, Siebel Remote captures the database update for 
transmission to, and resynchronization with, the server during the next 
synchronization session.

NOTE: The local database treats null as a unique value and consequently allows 
duplicates if you leave a key field null for two or more records.

The system administrator must monitor and resolve conflicts created on the server. 
To resolve a duplicate conflict, you can perform a merge on the duplicate records 
using the user interface Merge Record feature (Edit > Merge Records). The Merge 
Records option is enabled only after you select more than two records in the applet.

You can also change the user keys of one of the duplicate records to resolve the 
conflict.

Until these conflicts are resolved, EIM cannot be used to merge the records, since 
the conflict flag is not reflected in the interface table columns.
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Delete Conflicts
A potential delete conflict arises whenever one of the database changes is to delete 
a row. A single rule applies to delete operations and overrides other transactions. 
Whenever Siebel Remote encounters a delete transaction, delete always wins 
whether or not the transaction is in conflict with another update. If one transaction 
updates a database row and another deletes the row, Siebel Remote ignores the 
update and deletes the row.

NOTE: This rule supersedes the System Preferences Conflict Resolution rule set 
during initial implementation.

When detecting delete conflicts, deleted records appear in the User Preferences 
screen > Remote Status view > Session Actions list after the user synchronizes. 
However, the deleted records appear only if the system preference MRG: User 
Friendly Notification is set to TRUE. See “Setting Siebel Remote System Preferences” 
on page 58 for more information.

Merge Conflicts
A potential merge conflict arises when records are merged separately on both the 
mobile Web client and the database server. The following example illustrates the 
problem: 

1 On the mobile Web client, data from account A may be merged with account B. 

2 On the server database, data from account B may be merged with account A. 

3 Since delete transactions have the highest priority in Siebel Remote, this may 
lead to two delete transactions—one from the mobile Web client and one from 
the database server. 

4 In this case, data from both accounts will be deleted. To avoid this potential 
problem, do not merge data on mobile Web clients.
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Implementing Siebel Remote Server 2
This chapter describes actions necessary to prepare the Remote server for use in the 
production environment. Table 3 includes these tasks.

Table 3. Tasks for Initial Siebel Remote Implementation

Task Where Performed

Setting Siebel Remote System Preferences on page 58 Siebel client application

Choosing Assignment Manager Settings for Siebel Remote on 
page 65

Use the connected 
Siebel client application 
or Server Manager to 
make the change to this 
Siebel Remote server 
setting. 

Disabling Local Access to All Views on page 66 Siebel client application

Starting Siebel Remote Server Components on page 67 Siebel Server Manager

Enabling Windows NT Rights on Siebel Remote Server on 
page 76

Siebel Remote server

Changing the Local Database Administrator Password on 
page 77

Siebel Remote server

Generating a New Database Template on page 79 Siebel Server Manager
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Setting Siebel Remote System Preferences
Several enterprise-wide preferences affect the way Siebel Remote manages database 
changes. During the initial implementation, you should use the System Preferences 
Administration view to set the system preferences.

NOTE: It is important to remember that mobile Web clients need to be reextracted 
whenever there is a change to any of the system preferences settings. To determine 
which changes will be routed to the mobile Web clients, check the Dock Object 
Visibility Rules under the SystemPref Dock Object in Siebel Tools. For more 
information on Dock Objects and Visibility Rules, please refer to the topic about 
controlling access to information in Siebel Tools Reference. 

To set Siebel Remote system preferences

1 From the application-level menu, select View > Site Map > Application 
Administration > System Preferences.

2 In the System Preferences list, select the desired record and enter the appropriate 
value in the System Preference Value field.

Table 4 lists the Siebel Remote system preferences that you may want to set. For 
more information about each system preference, see the related section in the 
following pages.

Table 4. Siebel Remote System Preferences

System Preference Default Value Other Values

MRG: System Conflict 
Resolution

Server Wins Client Wins

MRG: Docking Timestamp 
Source

Client Transaction Time Server Database Merge 
Time

Docking: Transaction 
Logging

TRUE FALSE
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Docking: Get All PostnCon 
rows

FALSE: Get only 
S_POSTN_CON rows on 
primary contact team 
member, the mobile Web 
client (or subordinate) 
position for a contact who is 
visible to the mobile Web 
client.

TRUE: Get all the 
S_POSTN_CON rows for a 
contact who is visible to the 
mobile Web client.

CSM Logging FALSE TRUE

MRG: Txns Per Commit 50 10 for DB2 

10 for Oracle

1 for Microsoft SQL Server

MRG: User Friendly 
Notification

Conflicts TRUE
FALSE

LOGMGR: Vis Rules Per 
Statement

50 20 for DB2

20 for Microsoft SQL Server 

20 for Oracle

5 for Sybase

DBX: Vis Rules Per 
Statement 1

20 for DB2

20 for Microsoft SQL Server 

20 for Oracle

5 for Sybase

Table 4. Siebel Remote System Preferences

System Preference Default Value Other Values
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DBX: Vis Rules Per 
Statement N

1 for DB2

1 for Microsoft SQL Server 

1 for Oracle

1 for Sybase

Enterprise DB Server Code 
Page

Value is set by the database 
installer.

■ utf-8

■ utf-16 (includes MS SQL 
and DB2 only) 

■ cp1252

■ cp932

■ cp1148 (for iSeries only)

The following are for 
development and migration 
only:

■ cp847 

■ cp936 

■ cp949 

■ cp950 

■ cp1250 

■ cp1251 

■ cp1253 

■ cp1254 

■ cp1255 

■ cp1256 

■ cp1257 

■ cp1258 

Table 4. Siebel Remote System Preferences

System Preference Default Value Other Values
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MRG: System Conflict Resolution
Siebel Remote uses one of two rules to resolve conflicting database updates:

■ Client Wins - Updates from a mobile Web client will take precedence and 
overwrite those already on the server.

■ Server Wins (the default) - Updates from a server will take precedence and 
overwrite those already on the mobile Web client.

These values are case sensitive. You should use the default setting.

MRG: Docking Timestamp Source
Siebel database table rows include the date a row was last changed. For rows 
updated by mobile Web clients, the date can be stamped with the time when the 
change was made on the client (client timestamp) or the time when the update was 
applied to the server (server timestamp):

■ Using the client timestamp promotes consistency across client and server 
databases, but can be misleading if a client’s clock is set incorrectly or if the 
client resides in a different time zone.

■ Using the server timestamp makes sure that timestamps are accurate, but causes 
the timestamps to differ for the same row on the client and the server.

■ Setting this preference does not affect Siebel Remote conflict resolution logic or 
priorities. Updated timestamps are stored for purely informational purposes.

■ To select Docking Timestamp Source, choose either Client Transaction Time (the 
default) or Server Database Merge Time.

Docking: Transaction Logging
This preference enables or disables docking transaction logging:

■ Enable transaction logging by setting the value to TRUE.

■ Disable transaction logging by setting the value to FALSE.

■ The default is TRUE. This value is case sensitive.
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■ If you change this value from TRUE to FALSE and then change it back to TRUE 
while mobile users are active, you must reextract and reinitialize the local 
databases.

■ Set this value to TRUE when performing a database extract. Transaction logging 
must be enabled during extraction to log changes to the local database.

CAUTION: Disabling Transaction Logging will prevent Siebel Remote from working. 

NOTE: To disable transaction logging, restart the Siebel server.

When using the Assignment Manager or EIM and Docking: Transaction Logging is 
set to TRUE (default), all the changes will be logged and the appropriate ones will 
be propagated to the Remote clients. The changes are all logged into the 
S_DOCK_TXN_LOG table.

With a large volume of data, it may take quite a long time for the Transaction 
Processor and Router tasks to process the changes for each of the Remote clients. It 
may take so long that it would be faster to reextract the mobile Web client and apply 
the extract remotely. 

Therefore, it is recommended that you turn off transaction logging when loading 
data using EIM to avoid the rapid expansion of the S_DOCK_TXN_LOG table. After, 
the data has been loaded and assigned, turn on transaction logging and reextract 
the mobile clients. This will also prevent the risk of overloading of the Transaction 
Processor and Router processes.

In general, bigger batches tend to enhance performance for EIM, but cause 
problems for Siebel Remote. If you are using both EIM and Siebel Remote, it is 
recommended that you limit batch sizes to 1000 or fewer records. 

Docking: Get All PostnCon rows 
Tells the Transaction Router and Database Extract components whether or not to get 
all records in the S_POSTN_CON table for a contact. This parameter is designed to 
improve Siebel Remote performance. The default value is FALSE, which means 
“Only get the row for the mobile user’s position.”
62 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Implementing Siebel Remote Server

Setting Siebel Remote System Preferences
Use this parameter with caution, because sometimes S_POSTN_CON table can 
become quite huge on a local database. If you do change this parameter, you need 
to reextract mobile users. Also, you need to restart transaction routers.

CSM Logging
Turns on logging of merge transactions. These are transactions created when 
connected users combine or merge two records of the same component, such as two 
opportunities into one. Information from this log can be used to relink orphaned 
records created when the merge process is crossed with an update process during a 
synchronization. This is only applicable if the installation uses Siebel Remote or 
Replication Manager.

MRG: Txns Per Commit
The value for this preference determines how many database transactions the 
Transaction Merger processes before it issues a database commit:

■ Setting a low value (1) reduces the frequency with which users encounter a 
locked database row and reduces the risk of deadlock.

■ Setting a high value (10) minimizes processing overhead.

■ For default values see Table 4 on page 58.

MRG: User Friendly Notification
This value determines whether Siebel Remote writes information about database 
updates to the Siebel Remote Status view on the mobile Web client:

■ The values are case sensitive.

■ If the value is TRUE, Siebel Remote writes information about database updates.

■ If the value is CONFLICTS, Siebel Remote writes information about database 
updates that caused conflicts.

■ If the value is FALSE, Siebel Remote does not write any information about 
database updates.
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LOGMGR: Vis Rules Per Statement
Sets the number of visibility or routing rules to be checked by the Transaction 
Router server component per SQL statement. For default values see Table 4 on 
page 58.

NOTE: Do not change this value unless instructed by Siebel Technical Services.

DBX: Vis Rules Per Statement 1
Sets the number of visibility or routing rules checked per SQL statement processed 
by the Database Extract component—for the first SQL statement with header 
information. For default values see Table 4 on page 58.

NOTE: Do not change this value unless instructed by Siebel Technical Services.

DBX: Vis Rules Per Statement N
Sets the number of visibility or routing rules checked per SQL statement processed 
by the Database Extract component for other SQL statements. For default values see 
Table 4 on page 58.

NOTE: Do not change this value unless instructed by Siebel Technical Services.

Enterprise DB Server Code Page
Siebel 7.5 supports non-Unicode code pages for the server database, while the local 
database only supports Unicode. This parameter is used by the mobile Web client 
to prevent mobile users from entering noncompatible-character-set data into the 
local database. The value of this parameter should be set to match the character set 
of the server database. Values for this parameter include: utf-8, utf-16, cp1252, 
cp932, and cp1148 (for iSeries only). Utf-8 and utf-16 are for Unicode, cp1252 for 
English and most western European languages, and cp932 for Japanese. For default 
values, see Table 4 on page 58.
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Choosing Assignment Manager Settings for Siebel 
Remote

Assignment Manager settings can affect which transactions are sent to a Siebel 
Remote client. In normal operation, Assignment Manager frequently updates the 
timestamps for large numbers of records, even if there are no other changes to many 
of those records. To avoid sending large numbers of transactions to a Siebel Remote 
client when the only change is to the timestamp, it is recommended that you set the 
LogTxnChgOnly parameter for the Assignment Manager component to TRUE. 

When the LogTxnChgOnly parameter is set to TRUE, Assignment Manager 
transactions are logged only when there is a net change in assignments, such as a 
change in the membership of a team or a change in the primary for a team. This 
parameter only affects the Assignment Manager transactions, so record changes 
made by other means are logged and sent to Siebel Remote clients normally.

For information about configuring Assignment Manager component parameters, see 
Siebel Assignment Manager Administration Guide. 
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Disabling Local Access to All Views
If the tables associated with the business objects have limited visibility, you should 
not allow mobile users to use any of the All views when connected to a Siebel 
Remote local database. The Siebel client attempts to fix foreign key relationships 
when displaying data. Siebel Remote sends this change to the server database and 
other mobile Web clients. This will corrupt the integrity of these databases.

An example using one of the All views illustrates this behavior, which is inherent 
in any of the All views. 

The All Opportunity List view resets the value of an opportunity’s primary account 
to NULL if the Siebel client cannot locate the account in the local database. Siebel 
Remote may replicate an opportunity to a local database because the opportunity is 
referenced by an activity owned by the mobile user. Siebel Remote replicates the 
opportunity so that the Siebel client can display the opportunity’s name with the 
activity in the Activity List view. However, Siebel Remote does not replicate the 
opportunity’s primary account if the mobile user is not a member of the 
opportunity’s sales team. Thus, if the mobile user employs the All Opportunity List 
view to display the opportunity, and the Siebel client does not find the opportunity’s 
primary account in the local database, Siebel Remote resets the opportunity’s 
primary account value to NULL and replicates this change to other databases.

To disable local access to the All Opportunity List view

1 From the application-level menu, select View > Site Map > Application 
Administration > Views.

2 In the Views list, select the appropriate view such as the All Opportunity List 
view and clear the Local Access check box.

Because this is an example that applies to All views, repeat this procedure for any 
of the responsibilities assigned to this user.
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Starting Siebel Remote Server Components
Use Siebel Server Manager to set values for start-up parameters for the following 
Siebel Remote server components:

■ Transaction Processor

■ Transaction Router

■ Transaction Merger

■ Synchronization Manager

The default parameter values for each component are described in the following 
sections. 

The following procedures describe how to configure these server components.

To start Transaction Processor – srvrmgr command line

■ From the srvrmgr command line, enter: 

start task for comp txnproc with <parameter1>= <value1>, 
<parameter2=<value2>,...

Values are from “Start-Up Parameters for Transaction Processor” on page 69.

NOTE: When logging into srvrmgr command line, indicate the server name. 
Otherwise srvrmgr will default to the Enterprise Server. For details regarding the 
Server Manager command-line interface, see Siebel Server Administration Guide.

To start Transaction Processor – GUI

■ In Siebel 7, the Transaction Processor cannot be started manually through the 
GUI Server Manager unless the Siebel Server is up and running. The component 
has been defined to start one task when the Siebel Server is started if the 
component is enabled. If the component is not started, navigate to Site Map > 
Server Administration > Servers > Server Components tab, and start the 
component. A new task should be started.

To start Transaction Router – srvrmgr command line

■ From the srvrmgr command line, enter: 
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start task for comp txnroute with 
<parameter>=<value>,<parameter2=<value2>,...

Values are from “Start-Up Parameters for the Transaction Router” on page 71.

To start Transaction Router – GUI

■ In Siebel 7, the Transaction Processor cannot be started manually through the 
GUI Server Manager unless the Siebel Server is up and running. The component 
has been defined to start at least one task when the Siebel Server is started if the 
component is enabled. If the component is not started, navigate to Site Map > 
Server Administration > Servers > Server Components tab, and start the 
component. A new task should be started.

To start Transaction Merger – srvrmgr command line

■ From the srvrmgr command line, enter: 

start task for comp txnmerge with 
<parameter>=<value>,<parameter2>=<value2>,...

Values are from “Start-Up Parameters for Transaction Merger” on page 73.

To configure Transaction Merger – GUI

■ In Siebel 7, the Transaction Processor cannot be started manually through the 
GUI Server Manager unless the Siebel Server is up and running. The component 
has been defined to start at least one task when the Siebel Server is started if the 
component is enabled. If the component is not started, navigate to Site Map > 
Server Administration > Servers > Server Components tab, and start the 
component. A new task should be started.

To configure Synchronization Manager - srvrmgr command line

■ Synchronization Manager is started automatically by the Siebel Server using the 
default configuration. It does not need an explicit configuration. For information 
on using Siebel Server Manager to manage and administer server components, 
see Siebel Server Administration Guide.

Transaction Processor
Table 5 shows the start-up parameters for the Transaction Processor. 
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Table 5. Start-Up Parameters for Transaction Processor

Name Alias Required/Optional Comments and Default Value

Sleep Time SleepTime Optional Time (in seconds) to sleep between 
iterations. When it wakes up, it will 
process transactions. The default is 
60.

Maximum Reads per Iteration MaxRead Optional Maximum number of operations to 
read per run. The default value is 0, 
which means it will read all 
outstanding operations in the Master 
Transaction Log.

Clean txns iterations CleanTxnsIter Optional Sets frequency for Txn Processor to 
delete txns from server database 
master txn log table. This parameter 
is specified in the number of 
iterations. Default is 10. 

Clean .dx files iterations CleanFilesIter Optional Sets frequency for Txn Processor to 
delete DX files from the Siebel 
server’s DOCKING\TXNPROC 
directory. The default is 1 iteration, 
default of 60 seconds per iteration as 
shown in SleepTime parameter.

Write compressed .dx files WriteCompressed Optional Writes DX files in compressed 
format. Default is FALSE and should 
not be changed unless advised by 
Siebel Technical Support or Siebel 
Expert Services.

TS Block Size TSBlockSize Optional Block size for dobjinst.dbf (visibility 
database) in bytes. Data is stored 
blocks. The block size here is 
different from Operating System 
block size. It is determined during 
dbxtract for a mobile Web client. 
The default is 4096 bytes.
Please do not modify this parameter 
without approval from Expert 
Services or Technical Support.
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TS Cache Size TSCacheSize Optional Cache size for dobjinst.dbf 
(visibility database) in kilobytes. 
The default is 4096 kilobytes. 
Please do not modify this parameter 
without approval from Expert 
Services or Technical Support.

TS DB Recreate TSDbRecreate Optional The default value is FALSE. If the 
parameter is set to TRUE, Txnproc 
will recreate its dobjinst.dbf 
(visibility database). It is necessary 
to do this because an older 
dobjinst.dbf database (file system 
recovery) will mismatch with the 
server database. The new one 
resolves the mismatch.

Table 5. Start-Up Parameters for Transaction Processor

Name Alias Required/Optional Comments and Default Value
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Transaction Router
The Transaction Router calculates visibility for transactions and routes data to 
mobile users. Table 6 shows selected parameters for the Transaction Router.

Table 6. Start-Up Parameters for the Transaction Router

Name Alias Required/Optional Default Value and Usage Notes

Sleep Time SleepTime Optional Time to sleep between iterations (in 
seconds). The default is 60.

Maximum writes per file MaxWrite Optional Maximum number of operations 
written per DX file. The default is 
5000.

Maximum reads per iteration MaxRead Optional Maximum number of operations 
processed by the Transaction Router 
for a given mobile user during each 
run. The default is 10000.

Set Application Server Name SetAppName Optional Upgrades mobile Web clients from 
previous versions of Siebel eBusiness 
Applications to v4.0 and above. The 
default is TRUE.

At start-up, the transaction router 
searches the server database for 
mobile Web clients whose Siebel 
Remote server value is not set and 
that have a docking directory on the 
local server. This parameter sets the 
application server name in the server 
database for each of these mobile 
Web clients.

Write compressed .dx files WriteCompressed Optional Write DX files in compressed format. 
The default is TRUE.

TS Cache Size TSCacheSize Optional Cache size for dobjinst.dbf database 
in kilobytes. The default is 2048 
kilobytes. Maximum value should 
not exceed the number of mobile 
users on the application server 
multiplied by the size of the largest 
dobjinst.dbf file.
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Read client list iterations ReadClientsIter Optional The number of runs before the 
Transaction Router refreshes the list 
of users it should be processing from 
the database. 

The default is 10 iterations.

Id Db Recreate IdDbRecreate Optional Recreates the visibility ID database, 
visdata.dbf. It is a cache storage for 
data required for the visibility check. 
The default is FALSE, which means it 
does not recreate the database every 
time Txnroute starts.

Id Db Size IdDbSize Optional Size of the visibility ID database, 
visdata.dbf. This parameter is used 
only when no visdata.dbf file is 
present, or when Id Db Recreate is set 
to True. The default is 10MB, which is 
optimal in most cases. Maximum 
value should not exceed 200 MB. 

Node Division Factor NodeDivFactor Optional Determines the maximum number of 
mobile users to process by a 
Transaction Router instance during 
every run. The component will 
process the fractional number of 
users computed using this parameter. 
For example, if the value of this 
parameter is 5 (the default) and there 
are 100 mobile users on the 
Application server, the component 
will process 100/5 or 20 users.

Maximum seconds per 
iteration

MaxSecs Optional Determines the longest duration that 
a Transaction Router instance will 
work on one mobile user during each 
run. The default is 300 seconds.

Table 6. Start-Up Parameters for the Transaction Router

Name Alias Required/Optional Default Value and Usage Notes
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Transaction Merger
Table 7 shows selected parameters for the Transaction Merger.

Table 7. Start-Up Parameters for Transaction Merger

Name Alias Required/Optional Default Value and Usage Notes

Error Mode ErrorMode Optional Determines how database errors are handled during 
a Transaction Merger process. Default is STOP. 
Available modes include:

■ STOP. Stops Transaction Merger.

■ IGNORE. Causes Transaction Merger to sleep if 
all nodes were ignored in an iteration.

■ DISABLE_NODE. Disables all nodes and stops 
Transaction Merger if an error recurs in the same 
row.
If the mode is set to DISABLE_NODE, 
Transaction Merger sets the effective end dates of 
clients with errors to the current time. You then 
need to reextract the mobile Web clients to 
reactivate them. 

Sleep Time SleepTime Optional Time to sleep between iterations (in seconds). 
Default is 60.
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Synchronization Manager
Table 8 shows the start-up parameters for the Synchronization Manager.

Table 8. Selected Synchronization Manager Start-up Parameters

Name Alias Required/Optional Default Value and Usage Notes

Authentication 
Method

Authentication Optional Method that Siebel Remote uses to authenticate 
mobile Web clients. The default is None.

■ None. Does not validate the mobile Web 
client’s password.

■ Database. Uses the mobile Web client’s user 
name and password to connect mobile Web 
clients to the server database.

■ Siebel. Validates the mobile Web client’s 
password against the password stored in the 
mobile Web client’s screen.

■ AppServer. Validates the password against the 
password on the Siebel Server operating 
system.

The mobile Web client’s NT password cannot 
contain lowercase letters.

Domain Name NTDomain Optional If you are using AppServer authentication, this 
parameter specifies the name of the Windows NT 
domain for the user name and password.

To use Windows NT password authentication, you 
must enable the Windows NT user rights for the 
Siebel Server.

Minimum Number 
of cached thread 
contexts

MinCtxCache Optional Minimum number of cached thread contexts 
maintained by a multithreaded server. The default 
is 2 cached contexts.

Maximum 
Number of cached 
thread contexts

MaxCtxCache Optional Maximum number of cached thread contexts 
maintained by a multithreaded server. The default 
is 10 cached contexts.

Maximum Task 
Number

MaxTasks Optional Maximum number of synchronization sessions 
Synchronization Manager can service 
simultaneously. Default is 100.
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The multithreaded Synchronization Manager maintains a collection of open 
database connections (context cache) that can be parceled out to the active task 
threads and be reused. By default, each server creates two connections during start-
up. Additional contexts may be created dynamically, but the server (by default) 
maintains a maximum of only 10 context caches. 

You can specify the minimum cache size using the MinCtxCache parameter and the 
maximum cache size using the MaxCtxCache parameter. A larger cache may be 
helpful for configurations where multiple mobile Web clients synchronize. Note, 
however, that an excessive number of inactive database connections can degrade 
system performance. 

The Synchronization Manager creates the number of cached contexts specified by 
the MinCtxCache parameter at start-up. A cached context decreases the time to 
initialize a new synchronization session. Increase the cache size if you have a large 
number of mobile Web clients to synchronize simultaneously.

The Synchronization Manager can service up to the MaxTasks number of 
synchronization sessions simultaneously, but it only keeps at most the 
MaxCtxCache number of cached contexts in memory.

Synchronization 
Port Number

SyncPort Optional The TCP/IP port number dedicated to the 
Synchronization Manager. Default value is 40400. 
Use the Siebel Server Administration screens to 
override the default value by specifying a value 
and restarting the Siebel Server. 
You can also specify this port number as a 
command-line option when starting this server 
component via Server Manager using the 
command-line interface.

Siebel File System FileSystem Optional Siebel File System location for mobile Web clients.

Encryption Type Crypt Optional Determines if the traffic of a synchronization 
session will be encrypted. Values are: RSA, 
MSCRYPTO, and NONE. 

Table 8. Selected Synchronization Manager Start-up Parameters

Name Alias Required/Optional Default Value and Usage Notes
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Enabling Windows NT Rights on Siebel Remote Server
The Administrator will need to enable Windows NT rights for the sadmin user on 
the Application servers. This section describes how to do this. See Siebel Server 
Administration Guide for more information.

This procedure is generally required for any Siebel server, not just Siebel Remote.

To enable the Windows NT user rights on the Siebel Remote server

1 From the application-level menu, choose Start > Programs > Administrative 
Tools > User Manager.

2 Choose Policies > User Rights.

3 Select the Show Advanced User Rights check box and then Act as part of 
Operating system (the Grant To field shows the current owner).

4 Click Add.

5 In the Add Users and Groups dialog box, click Show users.

6 Scroll to the appropriate name in the Names list, select the name, and click Add.

You only need to add the Act as part of Operating system user right to the user 
who will start the Siebel Remote server. You can add rights for domain users, 
such as HQ\Smith, or you can add local users.

7 Click OK and exit User Manager.

8 Log out and reboot to activate the new rights.
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Changing the Local Database Administrator Password
In some cases, you may want to change the local DBA password on mobile Web 
clients. To accomplish this task, you should change the DBA password in the 
database template file before generating the new database template.

The following procedure shows how to accomplish this task in the SQL Anywhere 
environment.

To change the local DBA password on mobile Web clients

1 In a DOS window on the server machine, run the Interactive SQL utility: 
dbisqlc.exe.

a At the DOS prompt, change to the \bin subdirectory within the Siebel server 
root directory:

cd \siebel_server_root\bin

b Run dbisqlc.exe by entering:

dbisqlc -c “UID=DBA;PWD=SQL;DBF=siebel\dbtempl\my_templ.dbf”

2 In the Command window, enter:

grant connect to user_id identified by new_password

For example, to set a new password of SQL2 for the user DBA, enter:

grant connect to DBA identified by SQL2

NOTE: You must use uppercase for every password in SQL Anywhere.

3 Click Execute.

4 Run the Generate New Database component using the new DBA password.

For information on running the Generate New Database component, see 
“Generating a New Database Template” on page 79.
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5 Run a Database Extract for mobile Web clients, and notify mobile users to 
initialize their databases.

For information about initializing a local database, see “Initializing a Mobile 
Web Client Database” on page 134.
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Generating a New Database Template
You must run the Generate New Database Template component to create a new 
database template when you:

■ Upgrade the server database.

■ Want to use a collating sequence other than the default.

■ Use Database Extensibility to add extension tables, extension columns, or 
extension indexes to the default Siebel schema. In this case, run the Database 
Template Utility each time you click the Apply button in the Siebel Schema 
screen. 

NOTE: When you create a new extension column in the Siebel schema, and define 
the Datatype as Character (CHAR), there may be padding issues with Remote. 
Specifically, TxnMerge may not work properly if the Datatype is CHAR with a length 
of more than 1. Use VARCHAR as the Datatype if its length is more than 1.

Creating a New Empty Database File
Beginning with Siebel 7.5, Siebel applications only support a Unicode local 
database. Thus, only the Unicode database template file sse_utf8.dbf is shipped 
with the application. With this database template, every collating sequence can be 
supported. The sorting sequence for the application is configured using a parameter 
SortCollation in the CFG file. If the parameter is not specified, the application will 
sort using the Unicode multilingual collation order. No other character set is 
supported for the local database.

NOTE: Some previous versions of Siebel Remote supported the creation of new 
empty database files through the use of a utility called dbinit, which was designed 
for use with SQL Anywhere databases. Siebel Systems no longer supports the use 
of this dbinit utility. 
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Running the Generate New Database Component
You should always use an SQL Anywhere transaction log file when creating the 
database template. The SQL Anywhere transaction log significantly reduces the 
time required to create the database template.

Use the Siebel Server Manager to run the Generate New Database component.

To generate a new database template (GenNewDb)

1 From the application-level menu, choose View > Site Map >Server 
Administration >Enterprise Operations.

2 Click the Component Requests tab. 

3 Click New.

4 In the Component /Job field, select Generate New Database.

5 Specify the server name  in the Server field.  

6 In the Component Request Parameters list, click New.

7 In the Name field, select SQL Anywhere Database from the pick list.

The Value field typically defaults to sse_utf8.dbf and appears automatically. 

8 Modify the values of other parameters as necessary by repeating Step 6 and 
Step 7.

Table 9 on page 81 lists the parameters and default values for the Generate New 
Database component.

You should set the UseDdlFile parameter to FALSE only when you run the 
Generate New Database component after a schema change.

9 In the Component Requests form, click the menu button and then click Submit 
request.

A new database file is generated. Typically, this take a few minutes. 
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Table 9 shows the start-up parameters for generating new database components.

Table 9. Selected Parameters for the Generate New Database Component

Name Alias Required/Optional Default Value and Usage Notes

SQL Anywhere Database DbfFile Required SQL Anywhere database filename to 
initialize. It is recommended that you use 
the default value, sse_utf8.dbf. This 
unicode file is provided with the system and 
supports all languages. 

DBA Password DbaPwd Optional Password for the DBA account. Default for 
SQL Anywhere is SQL. Set the DbaPwd 
parameter to the password for the DBA user 
ID in the empty database template file.

Table Space TSpace Optional Space name in DB template to store Siebel 
tables. Do not specify the Table Space 
parameter unless you intend to build a 
custom empty database file using the 
specified table space.

Index Space ISpace Optional Space name in DB template to store Siebel 
indexes. Do not specify the Index Space 
parameter unless you intend to build a 
custom empty database file using the 
specified index space.

Use Transaction Log File UseTxnLog Optional Use when creating a new template file. The 
default is TRUE.

Use DDL File UseDdlFile Optional Use when creating a new template file. The 
default is FALSE—it means that the schema 
is read directly from the database.

If the value is set to TRUE, it means the 
schema is read from the DDL file. 

When a schema change takes place in your 
environment, set the UseDDLFile parameter 
to FALSE. GenNewDb will then read the 
latest schema from the database rather than 
the DDL file.

Interface Tables IFaceTbls Optional Create interface tables and indexes. The 
default is FALSE.
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Distributing Database Templates to Siebel Remote Servers
If your deployment includes multiple Remote servers, this section describes how to 
distribute the database templates. You can distribute it to each Siebel Server by 
running the distmpl utility. This utility creates the proper directory on each Siebel 
Server and copies the database template into the directory.

Alternatively, run the generate new database component at each Siebel Remote 
server to create the necessary database template file. 

To invoke distmpl

1 In a DOS window, run the siebenv.bat file to set the appropriate environment 
variables.

2 Invoke distmpl.bat to create the destination directories and the database 
template files.

Example 1
Enter: distmpl \\apsrvr1\siebapp 

where appsrvr1 is the machine name of the remote server and siebapp is the 
remote server’s directory.

Example 2
Enter: distmpl s:\siebapp 

where s: is the drive on which the remote server’s disk is mounted and siebapp 
is the remote server’s directory.

Warehouse Tables WarehouseTbls Optional Create Warehouse tables and indexes. The 
default is FALSE.

Client Db Type ClientDbType Optional Client database engine type. The default is 
SQL Anywhere.

Table 9. Selected Parameters for the Generate New Database Component

Name Alias Required/Optional Default Value and Usage Notes
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Setting up a mobile Web client involves certain tasks for both the Siebel Remote 
server and the mobile Web client. This chapter discusses the required tasks and 
how to perform them. You must repeat each of these steps for each mobile Web 
client. 

Whenever possible, you should implement the entire process of enabling new 
mobile Web clients, rather than relying on end users to finish the configuration.

The table below includes the required tasks for setting up mobile Web clients.

Table 10. Tasks for Enabling Mobile Web Clients

Task Where Performed

Setting Up Mobile Web Client Hardware and Software on page 84 Mobile Web client

Enabling Network Connectivity on page 85 Mobile Web client

Establishing Autodial Preferences on page 86 Mobile Web client

Setting Synchronization Preferences on page 87 Mobile Web client

Using a Different Data Source on page 93 Mobile Web Client

Registering a Mobile Web Client on page 94 Siebel Server Manager

Using Routing Models on page 100 Siebel Server Manager

Limiting Views Available to Mobile Web Clients on page 118 Siebel Server Manager

Creating Mobile Web Client User Accounts and Privileges on 
page 121

Siebel Remote server
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 83



Setting Up Mobile Web Clients

Setting Up Mobile Web Client Hardware and Software
Setting Up Mobile Web Client Hardware and Software
Install the necessary hardware and software on the mobile Web client. This step 
may include configuring users. You should not change the ODBC code page settings 
from multiple byte to single byte.

For more information, see Siebel Web Client Administration Guide.
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Enabling Network Connectivity
Install the necessary hardware and software on the mobile Web client to allow the 
this client to exchange files with the Siebel Remote server. This step may include 
choosing communication settings and installing networking cards, modems, and 
software.

For more information, see Siebel Web Client Administration Guide and Siebel System 
Requirements and Supported Platforms.
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Establishing Autodial Preferences
If using Microsoft dial-up networking, mobile users can set an option to 
automatically connect with their Siebel Remote server when synchronizing.

To establish autodial preferences

1 From the application-level menu, select File > Synchronize > Database.

2 In the Siebel Remote Synchronize dialog box, click Setup.

3 From the Siebel Remote Preferences dialog box, click the Connection picklist and 
choose the appropriate connection.

4 Click OK, and then Synchronize or close the dialog box. 

NOTE: You must first define your phone book entries using Microsoft Dial-Up 
Networking for Windows 2000, NT, and 98/95 platforms; there is a special situation 
with the Windows 98/95 setup. 
When setting up the dialup connection on Win98/95, you must establish the 
connection before using Siebel Remote to synchronize.
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Setting Synchronization Preferences
This section describes synchronization preferences. The Siebel Remote client reads 
configuration parameters in the Siebel configuration file (default is siebel.cfg) to 
specify the location of the Siebel Server directories, the Siebel File Server directories, 
and the Siebel Database installation. If a different CFG file is used, the shortcut 
created by the Installer should be changed. 

Before using Siebel Remote, you must set the values for the configuration 
parameters. The Siebel installation utility creates a siebel.cfg in the client bin 
directory with default values for each configuration parameter. 

If synchronization is performed within the application, that is, using File > 
Synchronize > Database, configuration information is read from the CFG file of that 
particular application. For example, if Siebel Call Center is used, then configuration 
information is read from uagent.cfg.

Siebel 7.5 includes an autosynchronization option to help maintain the frequency 
of synchronization. Frequent synchronization by mobile users can improve the 
performance of the system. After initializing their local database, mobile users 
enable or disable autosynchronization from User Preferences > DB 
Synchronization. For more information, see “Using Autosynchronization” on 
page 89.

Synchronization Parameters
The configuration parameters that Siebel Remote uses for synchronization include:

■ ClientRootDir. Name of the Siebel client installation directory.

■ DockConnString. Logical network address of the Siebel Server to which you want 
to connect for synchronization. It is recommended that every synchronization 
session occur within the corporate firewall. If your deployment must support 
synchronization through the Internet from outside the firewall, VPN is a good 
alternative. If this is the environment, the port for synchronizing with your 
server must be opened on your firewall. Also make sure your Internet Service 
Provider (ISP) does not block communication to this particular port. This 
parameter has the following format:
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siebel server name:network protocol:sync port #: 
service:encryption:compression

where:

■ logical siebel server name = logical network address of the Siebel 
Server to which you want to connect for synchronization.

■ network protocol = the name of the networking protocol to use. TCPIP is 
the only valid value and is the default value.

■ sync port # = the TCP/IP port number dedicated to the Synchronization 
Manager. The default value is 40400 if nothing is specified.

NOTE: You can use the Siebel Server Administration screens to override the 
default value by specifying a value for the Synchronization Manager 
(SynchMgr) component’s SyncPort parameter and restarting the Siebel 
Server. You can also specify this port number as a command-line option 
when starting the Siebel Server. If you change this value, the CFG file must 
also be updated.

■ service = the TCP/IP service you are requesting. SMI is the only valid value 
and is the default value.

■ encryption = the encryption package you are using. The encryption facility 
must match the type used by the server. Both MSCRYPTO and RSA are 
supported. 

Examples of valid values are:

SIEBAPP1:TCPIP:40400:SMI:RSA

SIEBAPP1:TCPIP:9000

SIEBAPP1

■ DockRepositoryName. Name of the Siebel repository that you are currently using. 
This parameter must have the same value as the Siebel Server repository.

■ TableOwner. Name of the database account on the local database where the 
Siebel schema is installed. Default is SIEBEL.
88 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Setting Up Mobile Web Clients

Setting Synchronization Preferences
■ DockTxnsPerCommit. Number of transactions that Siebel Remote applies to the 
local database before performing a commit. You should set this configuration 
parameter to a value that satisfies the needs at your site. The default is 500.

Using Autosynchronization
The purpose of autosynchronization is to improve the overall usability of the system 
by increasing the frequency of synchronization sessions. Frequent synchronization 
decreases the volume of transactions for each session and therefore shortens the 
average connect time.

The Autosynchronization Agent runs in the background at scheduled times to 
perform automatic synchronization when connected to the network.

Follow the procedure below to invoke autosynchronization and the available 
options. One of the options is a synchronization reminder that prompts the user to 
synchronize if a specified period passes without a synchronization session.

To enable autosynchronization

1 Verify that the local database is initialized.

2 Verify that the Siebel Autosync program was added to the Windows Startup 
Group during the installation process. 

If not, add it by copying it from the Siebel Program group. This allows the Auto 
Synchronization agent to start when the computer boots up.

3 Log in to the local database, and navigate to User Preferences > DB 
Synchronization.

4 Under Auto-Synchronization, define your options using the information below.

Field Description

Enable Auto-
Synchronization 
check box

 Required to enable autosynchronization.

User Confirmation 
check box

Optional.
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5 Under Synchronization Frequency, select a frequency from the Synchronization 
Frequency drop-down list, then use the other fields to further define the 
frequency.

6 Synchronization Frequency drop-down list values:

Maximum Retries 
drop-down list

Defaults to zero, but 2 or 3 is recommended.

Maximum 
Network Latency 
drop-down list

Sets a network latency that will prevent the autosynchronization 
agent from invoking a synchronization session. Required. The 
administrator establishes this policy. For example, at 56K the 
threshold may be 200 to 300 milliseconds or higher. 

Field Description

Option Description

Default Default is Empty. Same behavior as if autosynchronization is 
disabled.

System boot up Perform next synchronization after the computer is started and 
operational. If no network connection is available, try again the 
next time the computer is rebooted.

Mobile Client 
Start up

Perform synchronization after the Mobile Web Client is started. If 
no network connection is available, try again the next time the 
client is started.

Hourly Perform the synchronization every hour at the specified time 
increment chosen in the Hourly at picklist. If the computer is not 
operational at the specified time, then perform the 
synchronization at the earliest time when the machine is 
operational.
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7 In the Synchronization Reminder form, select the Enable Synchronization 
Reminder check box and select a minimum number of days from the Min Days 
Between Sync Sessions drop-down list to display the Synchronization Reminder 
dialog box when the mobile Web client is up and if the last synchronization was 
earlier than the “Minimum days between sync sessions.”

This will remind the user to perform synchronization. The reminder dialog will 
appear with the following text: “Perform database synchronization now?” The 
user can respond accordingly.

Filtering Regional Workflows
Siebel 7.5 workflow administration allows filtering out of workflow processes that 
only apply at the regional level. Therefore, only records associated with workflows 
needed on the mobile Web client will be routed to those nodes. This decreases the 
volume of data to help optimize local databases. For more information about this 
topic, see Siebel Business Process Designer Administration Guide.

Enabling Encryption for Synchronization Networking
To use encryption, both the server and the client must enforce encryption in their 
connection parameters. If these parameters do not match, connection errors will 
occur.

■ For the server, set the encryption server parameter to MSCRYPTO or RSA. You 
can use the Server Manager command line or the Server Administration screen.

Daily Perform synchronization every day at the specified time entered 
in the Daily at field. If the computer is not operational at the 
specified hour, then perform the synchronization at the earliest 
time when the machine is operational.

Weekly Perform synchronization every week on the specified day chosen 
in the Weekly On picklist, and at the specified time entered in the 
Weekly At field. If the computer is not operational at the specified 
time, then perform the synchronization at the earliest time when 
the machine is operational.

Option Description
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■ For the client, encryption is the fifth parameter in the DockConnString. Override 
the default NONE with MSCRYPTO or RSA. You may use either 
AASRVR:TCPIP:40400:SMI:MSCRYPTO or RSA, or APPSRV::::MSCRYPTO or 
RSA.

Siebel eBusiness Applications use MSCRYPTO or RSA to encrypt data traffic 
between the server and the mobile Web client. It is configured at the component 
level for replication with these clients and the server. It is not used to encrypt the 
local database nor the data in it. Also, it is not used for communication with the 
database. 
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Using a Different Data Source
You can use a different data source from the one specified in the [Local] section of 
the CFG file. Use the following procedure to do this.

To use a different data source 

1 In the [DataSources] section of the CFG file, add a statement for the new data 
source name.

For example, 

NewDSN = NewDSN

2 Under the [Local] section, create a new section for the new data source. 

You can copy the [Local] section and rename the section. For example,

[NewDSN]

3 Update the new section as appropriate and adjust the ConnectString parameter 
as necessary to read:

ConnectString=ClientRootDir\NewDSN\sse_data.dbf  -q -m -x NONE -
gp 4096 -c40m -ch60m
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Registering a Mobile Web Client
This section describes how to register a mobile Web client. It assumes the Siebel 
Administrator has previously set up this user as a user in the Siebel application.

If you need to add a large number of mobile Web clients to the application, you can 
consider using EIM to perform a batch load. If your deployment includes 
Replication Manager, keep in mind that this EIM functionality is only supported on 
the HQ node. For more information on how to load data into interface tables and 
then populate base tables, see Siebel Enterprise Integration Manager Administration 
Guide. 

Make sure that mobile users have access to the following views in their 
responsibilities:

■ Client Status view. Helps mobile Web clients resolve data merge conflicts on 
their local databases by showing conflict information after synchronization.

■ Mobile User Summary view. Contains information about the mobile client.

■ DB Synchronization view. Auto Synchronization view. Allows users to enable 
and configure autosynchronization after initializing their local database, mobile 
users enable or disable autosynchronization.

For additional information about setting up employees and adding access to views, 
see Applications Administration Guide.

To register a new mobile Web client on a node

1 Navigate to Site Map > Siebel Remote Administration > Mobile Clients.

2 From the Parent Server list, select the appropriate node. 

If your deployment does not use Replication Manager, then the appropriate node 
is HQ.

3 In the Mobile Clients list, click New.
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4 In the new Mobile Clients record, enter the mobile Web client name in the 
Mobile Client field.

CAUTION: The mobile Web client name must be entered in uppercase letters and 
be eight characters or less. It is recommended that you use the mobile Web client 
User ID (see next step) as the mobile Web client name. It can contain only 
Roman, alphanumeric, and the _ or - characters. It cannot include spaces, 
periods, or other invalid characters ( / \ : * ? “ < >|) as in the DOS file naming 
schema. Siebel Remote uses the mobile Web client name to create inbox and 
outbox directories on the Siebel Server.

5 In the User ID field, click the select button, and choose the User ID of the mobile 
user.

User ID is used to access the user’s local database during initialization and 
synchronization.

6 In the Routing Model field, click the select button, and choose the data routing 
model to which the mobile user belongs.

For information on data routing models, see “Using Routing Models” on 
page 100.
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7 In the Language(s) field, click the select button, and choose the preferred 
language or languages for the mobile user. If the preferred languages are not 
available, click New and follow the instructions in the dialog boxes to add these 
choices. 

A language preference allows the mobile user to download data in a preferred 
language, or languages, for the following dock objects that contain Translation 
Tables: LOV, Product, Literature, Catalog, Catalog Category. This helps optimize 
the size of the local databases. 

Dock objects are logical groups of tables with special schema structures to 
synchronize data between a server database and a mobile database in a coherent 
manner.

By default, the Language(s) field is empty, which means the mobile user will 
receive data in all the languages for these dock objects.

Data for each of the other dock objects is routed to mobile Web clients based on 
the normal visibility rules. 

8 Complete the remaining fields as appropriate.

The Sync Password field is used by the Synchronization Manager if the 
authentication method in the Siebel Server Component Parameters is set to 
Siebel. Set the password in this field and give it to the mobile user.

The App Server Name field is not populated until the Database Extract is run for 
the mobile user. At the time the mobile Web client record is created (S_NODE) 
the APP_SERVER_NAME field is NULL. 

NOTE: If you use EIM to load mobile user records, records without an HQ node 
as the parent node do not appear in the Mobile Clients view. The parent node is 
stored in the following two columns: EIM_NODE.par_name and 
EIM_NODE.par_node_type_cd. Although these columns are not required for 
EIM, they are required for Siebel Remote. When you enter mobile users using 
the Mobile Clients view, these columns are populated by default.
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9 If the data routing model assigned to this mobile user is Sales Representative, 
Analyst, Minimal Data, or Sales Manager, navigate to Applications 
Administration > Responsibilities > Responsibilities list, and select the 
corresponding Responsibility with the Routing Model suffix.

The corresponding Responsibility with the Routing Model suffix relates to the 
data routing model assigned in Step 6 above. For more information about 
corresponding routing models and how these help optimize the size of local 
databases, see “Limiting Views Available to Mobile Web Clients” on page 118. 

a In the Users list, add a new record.

b In the Add Users Selection dialog box, select the mobile user and click OK.
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Routing Rules and Dock Objects
This section provides an overview of routing rules and dock objects. 

Routing rules provide the logic for Database Extract and Transaction Router server 
components to perform their tasks. These rules reflect the data visibility and data 
access policies within the application. 

■ “Routing Rules”

■ “Dock Objects” on page 98

For additional information about this topic, see Siebel Tools Reference. 

Routing Rules
Routing rules are SQL statements that Transaction Router and or Database Extract 
use to evaluate what records should be routed to each mobile user. There are about 
1,500 active routing rules in Siebel 7.5. They are designed to accomplish the 
following: 

■ Protect data integrity

■ Allow the same visibility of data when users are connected to the server

■ Facilitate access control 

■ Maintain application logic and functionality

The types of routing rules are the means to implement these requirements.

You can see these routing rules in Siebel Tools Reference. However, you will not be 
able to update or modify these rules. Any such changes will require Siebel Expert 
Services working in conjunction with Siebel engineering. However, for extension 
tables generated using Database Extensibility, routing rules can be generated using 
a wizard provided within Siebel Tools.

Dock Objects
A Dock Object is a logical grouping of tables with a special schema structure to 
synchronize data between a server database and a mobile database in a coherent 
manner. Routing rules belong to dock objects. 
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Generally, there are three types of dock objects in the Siebel architecture: 

■ Enterprise dock objects

■ Private dock objects

■ Limited dock objects

Enterprise dock objects are those objects that are visible to all users within the 
application. Examples include currency and catalog. 

Private dock objects are those objects that will not be routed to mobile users. If data 
is created on mobile Web clients, it will be sent up to the server. However, updates 
to them will not be returned to the client. Data visibility of private dock objects to 
users is not used in the routing consideration. 

CAUTION: After making any change to the database schema, run the Generate New 
Database Template component and reextract all mobile clients, or use Siebel 
Anywhere kits to distribute the change to all mobile clients. It is strongly 
recommended that you do this even if the schema change only affects private dock 
objects, because individual tables in a private dock object may become visible to 
mobile clients at a later time, and problems can occur if server and local database 
structures do not match. 

Limited dock objects are those objects whose data may or may not be visible to a 
particular user—most user data is of this type. These objects have routing rules, as 
described earlier, that determine which records are routed to a particular mobile 
user.

Routing rules are SQL statements that determine whether a given piece of data 
should be routed to a given user. Routing rules embody the data visibility and data 
access built into Siebel eBusiness applications. Any transactions in the system are 
associated with a set of routing rules that may cause the transactions to be routed 
to a mobile user. 

A routing model is a collection of routing rules. The next section includes a detailed 
description of the routing models available. A mobile user can now be defined as 
associated with any of the routing models. Thus, transaction routing will behave 
differently for each mobile user, depending on the routing model the user is 
associated with.
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Using Routing Models
This section describes the Routing Models available to reduce the amount of data 
replicated to mobile users. For a majority of mobile users, the MOBILE CLIENT - 
STANDARD, MOBILE CLIENT - EXTRACT ONLY, or Executive Management routing 
model is adequate. However, for users who need to minimize their local database 
size, using one of the specialized routing models may be appropriate. 

NOTE: Before you deploy Siebel Remote with any of these specialized routing 
models, it is strongly recommended that you discuss this with a Siebel technical 
resource.

Routing models determine what data will be extracted to, and what follow-on 
transactions will be routed to, mobile users. By careful application of specific 
docking rules, local database sizes are reduced, and, as a result, so are 
synchronization times and transaction application times. The docking visibility 
rules determine which records from the server database are propagated to each 
mobile user.

The flexibility available through data routing models helps align more closely the 
extraction of data and routing of transactions with the specific needs of the mobile 
users. This helps minimize the size of the local databases and the connect time to 
download a database extract and to synchronize.

To match the data routed to mobile users assigned to some of the routing models, 
administrators can limit the views for these users. This functionality applies to 
mobile users assigned to the following out-of-the box routing models: 
Sales Rep Standard, Sales Mgr Standards, Field Technician, Analyst, 
Sr. Field Engineer, and Field Engineer.
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For more information about limiting views available to mobile users and how to do 
this, see “Limiting Views Available to Mobile Web Clients” on page 118.

CAUTION: Make sure Routing Models are consistent with the responsibilities and 
positions of the mobile users. The responsibilities and position of an employee 
determine the access that person has to the Server database. Balancing the data 
routing model with a user’s access helps to optimize the size of that user’s local 
database. This also helps to minimize synchronization time.

Each mobile user will be associated with one Routing Model. A Routing Model 
includes a set of routing rules. Union of the routing rules determines whether a 
record will be routed to a mobile Web client. 

The descriptions that follow include the Routing Models available out-of-the-box.

Routing models also impact what data will be extracted to, and what follow-on 
transactions will be routed to, regional servers. See “Routing Groups and Routing 
Rules” on page 197. for more details regarding routing groups for regional servers.

Field Sales Representative Standard
Users assigned the Sales Representative Standard routing model receive a database 
extract and follow-on transactions dealing with information relevant to a 
salesperson. 

The views associated with this model include the following:

■ Accounts

■ Activities / Calendar

■ Activity Plans

■ Assessments

■ Contacts

■ Competitors

■ Correspondence
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■ Currencies

■ Decision Issues

■ Employees

■ Expense Reports

■ Opportunities

■ Periods

■ Presentations

■ Proposals

■ Sales Methods

■ Sales Stages

Field Sales Manager Standard
Users assigned the Sales Manager Standard routing model will receive a database 
extract and follow-on transactions dealing with information relevant to a sales 
manager. The views associated with this model include those listed above for the 
Sales Representative Standard in addition to the manager's Team's Accounts, 
Contacts, and Opportunities.

Field Technician
Users assigned the Field Technician routing model receive a database extract and 
follow-on transactions dealing with information relevant to a field technician. It 
provides the Field Technician with the most basic or essential data to complete the 
required work in the most timely manner. The views associated with this model 
include the following:

■ Account

■ Action

■ Activities

■ Asset Mgmt - Asset
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■ Contact

■ Employee

■ Employee Skill

■ Employee Skill Item

■ Entitlement Account

■ FS Activity Parts Movement

■ FS Activity Recommend Parts & Tools

■ FS Activity Step

■ FS Asset Measurement Characteristics

■ FS Asset Measurement Readings

■ FS Bucket - Part Browser

■ FS Bucket Header - Part Browser

■ FS Expense Item

■ FS Instruction

■ FS Inventory Location

■ FS Inventory Transaction

■ FS InvLocProduct

■ FS Substitute Part Bucket - Part Browser

■ FS Transaction Assets

■ Internal Product

■ List of Values

■ Mapsearch

■ Order Entry-Orders

■ PS Project Team
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■ Salutation (eApps)

■ Service Agreement

■ Service Request

■ Session Action

■ Session Detail

■ Session Log

■ SI Account External

■ SI Broadcast Message

■ SI Employee External

■ SRF Screen

■ SRF Screen View

■ Time Sheet Daily Hours

■ User Preferences

Senior Field Engineer
Users assigned the Senior Field Engineer routing model receive a database extract 
and follow-on transactions dealing with information relevant to a senior field 
engineer. It includes data to support interaction with others and the service center, 
access to product and parts data, access to solution knowledge bases, basic sales 
functionality, and customer and asset data. The views associated with this model 
include those in the following list:

■ Account

■ Account External Product

■ Account Note

■ Account Private Note

■ Business Address
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■ Action

■ Activities

■ Asset Mgmt - Asset

■ Calendar Access

■ Contact

■ Contact Note

■ Contact Private Note

■ Cycle Counting

■ Cycle Counting Execution

■ Employee

■ Employee Skill

■ Employee Skill Item

■ Entitlement Account

■ Expense

■ Expense Item

■ Expense Approver list

■ Expense Unassoc Item

■ FS Activity Parts Movement

■ FS Activity Recommended Parts & Tools

■ FS Activity Step

■ FS Asset Measurement Characteristics

■ FS Asset Reading

■ FS Asset Warranty

■ FS Bucket Header - Part Browser
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■ FS Bucket - Part Browser

■ FS Cycle Counting Serial Parts

■ FS Expense Item

■ FS Instruction

■ FS Inventory Location

■ FS Inventory Transaction

■ FS InvLoc Product

■ FS Inventory Options

■ FS Invoice

■ FS Invoice Line Items

■ FS Invoice Line Item Details

■ FS Invoice Note

■ FS Invoice Payments

■ FS Repair

■ FS Substitute Part Bucket - Part Browser

■ FS Substitute Products

■ FS Transaction Assets

■ Internal Product

■ List Of Values

■ Mapsearch

■ Opportunity

■ Order Entry - Orders

■ Order Entry - Line Items

■ Order Entry - Line Item Actions
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■ Order Entry - Line Item Available Products

■ Personal Payment Profile

■ Price List

■ PS Rate List

■ PS Position Type

■ Pricing Model

■ Pricer Factors

■ PS Project Team

■ Response

■ Salutation (eApps)

■ Service Agreement

■ Service Agreement Metric

■ Service Request

■ Service Request Attachment

■ Session Action

■ Session Detail

■ Session Log

■ SI Account External

■ SI Broadcast Message

■ SI Employee External

■ Shift Hour

■ Solution SR/PD

■ SRF Screen

■ SRF Screen View
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■ Time Sheet

■ Time Sheet Daily Line

■ Time Sheet Unassoc Daily Hours

■ Time Sheet Approver

■ Time Sheet Daily Hours

■ User Preferences

■ Work Type

■ Contact (All)

■ Action Attachment

■ Messaging

■ Decision Issue

■ Related Service Request

■ Account Attachment

■ Quote

■ Project

■ Position

■ FS Order Entry - Line Item Warranty

■ Order Item XA

■ Activity Plan

■ Activity Plan Action

■ Order Entry Attachment

■ Asset Mgmt - Asset Relationship

■ Asset Mgmt - Asset Transaction

■ Asset Shared Note
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■ Asset Private Note

■ Asset Mgmt - Asset (sub-components)

■ Product Defect

■ Asset Mgmt - Asset Attachment

■ FS PM Action (w/ PM Plan Item Info)

■ FS PM Applicable Plan Item

■ FS Invoice Attachments

■ Contact Attachment

■ Contact Relationship

■ Messaging Activity

■ Messaging Attachment

■ Solution

■ SR Resolution Item

■ Related Solution

■ Sales Tool

■ Key Feature

■ Sales Tool by Product

■ Product Comparison

■ Component Product

■ FS Order Item Action Assets Rcv

■ FS Receiving Internal

■ FS Pending RMA PO RO

■ FS Shipping Action

■ FS Receiving Action
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■ FS Warranty

■ Quote Item

■ Service Region

■ Zip Code

Field Engineer
Users assigned the Field Engineer data routing model receive a database extract and 
follow-on transactions dealing with information relevant to a Field Engineer. This 
model provides the Field Engineer with all the data required to perform and debrief 
a complex job requiring an acceptable level of historical data regarding customer 
and asset history. With this data the Field Engineer can order parts, generate service 
invoices, debrief time and expense on site, and perform cycle counts. Debriefing is 
the reporting of material usage, time, and expenses to service managers after 
completing an activity. 

The views associated with this model include:

■ Account

■ Account External Product

■ Account Note

■ Account Private Note

■ Business Address

■ Action

■ Activities

■ Asset Mgmt - Asset

■ Calendar Access

■ Contact

■ Contact Note

■ Contact Private Note
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■ Cycle Counting

■ Cycle Counting Execution

■ Employee

■ Employee Skill

■ Employee Skill Item

■ Entitlement Account

■ Expense

■ Expense Item

■ Expense Approver list

■ Expense Unassoc Item

■ FS Activity Parts Movement

■ FS Activity Recommended Parts & Tools

■ FS Activity Step

■ FS Asset Measurement Characteristics

■ FS Asset Reading

■ FS Asset Warranty

■ FS Bucket Header - Part Browser

■ FS Bucket - Part Browser

■ FS Cycle Counting Serial Parts

■ FS Expense Item

■ FS Instruction

■ FS Inventory Location

■ FS Inventory Transaction

■ FS InvLoc Product
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■ FS Inventory Options

■ FS Invoice

■ FS Invoice Line Items

■ FS Invoice Line Item Details

■ FS Invoice Note

■ FS Invoice Payments

■ FS Repair

■ FS Substitute Part Bucket - Part Browser

■ FS Substitute Products

■ FS Transaction Assets

■ Internal Product

■ List Of Values

■ Mapsearch

■ Order Entry - Orders

■ Order Entry - Line Items

■ Order Entry - Line Item Actions

■ Personal Payment Profile

■ Price List

■ PS Rate List

■ PS Position Type

■ Pricing Model

■ Pricer Factors

■ PS Project Team

■ Response
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■ Salutation (eApps)

■ Service Agreement

■ Service Agreement Metric

■ Service Request

■ Session Action

■ Session Detail

■ Session Log

■ SI Account External

■ SI Broadcast Message

■ SI Employee External

■ Shift Hour

■ Solution SR/PD

■ SRF Screen

■ SRF Screen View

■ Time Sheet

■ Time Sheet Daily Line

■ Time Sheet Unassoc Daily Hours

■ Time Sheet Approver

■ Time Sheet Daily Hours

■ User Preferences

■ Work Type
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Consultant
Users assigned the Consultant routing model receive a database extract and follow-
on transactions dealing with information relevant to a consultant. The option is a 
limited use license of the professional services functionality. Using this routing 
model, the data will be limited to time sheets, expense reports, limited project 
information, calendar and employee skills.The views associated with this model 
include the following:

■ Action

■ Action (Busy Free Time)

■ Calendar Access

■ Change Position

■ Employee

■ Employee Skill

■ Employee Skill Item

■ Expense

■ Expense Approver

■ Expense Hotel Item

■ Expense Item

■ Expense Mileage Item

■ Expense Unassoc Item

■ Incentive Compensation Home Page Payout

■ Marketing Analysis Predefined Category (Sales)

■ Opportunity

■ Project

■ Project Status

■ Project Status Item
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■ PS Project Risk

■ Quote

■ Salutation (eApps)

■ SI Account External

■ SI Broadcast Message

■ Time Sheet

■ Time Sheet Approver

■ Time Sheet Daily Hours

■ Time Sheet Daily Line

■ Time Sheet Unassoc Daily Hours

Analyst
Users assigned the Analyst routing model work at research firms. The information 
that is routed to users assigned to the Analyst model includes Contacts, Accounts, 
Assets, Service Requests, and Quotes. The analysts also receive Activities, but only 
those activities that are related to Quotes, Opportunities, or Service Requests. An 
analyst also is routed Project Items such as the Team Workbook, Time and Expense, 
and Time sheets. The views associated with this model include the following:

■ Contacts

■ Contact entitlements

■ Agreements for Accounts

■ Agreements for Contacts

■ Orders for an account

■ Assets

■ Quotes for an account

■ Activities for orders
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■ Activities for quotes

■ Activities for assets

■ Activities for opportunities

■ Payments

■ Service Requests

■ Customer Surveys

■ My Opportunities

■ Price Lists

■ Expense Reports

■ Expenses

If on the Project Team:

■ ProjectItems

■ TeamWorkbook

■ Time & Expenses

■ TimeSheets

■ Expenses

Minimal Data
Users assigned the Minimal Data routing model receive a database extract and 
follow-on transactions dealing only with Calendar Items, My Contacts, My 
Accounts, and My Opportunities.

The views associated with this model include the following:

■ My Contacts More Info View

■ My Contacts Addresses View

■ My Daily Calendar
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■ My Monthly Calendar

■ My Weekly Calendar

■ My Accounts More Info View

■ My Opportunities More Info View

■ All Employees View

Mobile Partner User 
Mobile Partner User is a routing model that is used by Partner Sales and Service 
Representatives that have implemented a mobile version of the Siebel PRM Partner 
Portal. Users assigned the Mobile Partner User routing model receive a database 
extract and follow-on transactions dealing only with Accounts, Activities, Assets, 
Contacts, Correspondence, Inventory Locations, Opportunities, Orders, Price Lists, 
Products, Proposals, Quotes, Revenues, Service Requests, and Sources.

Mobile Client – Standard
Unlike the routing models above, this model allows a full set of data related to the 
user being routed based on visibility rule configuration in the Siebel Repository. 
There are some exceptions to this. The Subordinate Activities are not routed to 
Supervisors. Also, a few other visibility rules do not apply. 

Mobile Client – Extract Only
The difference between this and the Mobile Client – Standard model is that this 
model will not allow synchronization. Hence, a local database with this model 
reflects the snapshot of application data with respect to a user.

Executive Management
This is an extract-only routing model designed for executive managers so they can 
use the mobile Web client to perform their everyday tasks. The model excludes all 
manager rules so that only data visible to them will be routed to their mobile Web 
clients.
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Every mobile user is assigned a routing model to help optimize the size of that 
user’s mobile database. To match the data routed to mobile users assigned to some 
of these routing models, administrators can limit the views for these users. 
Administrators can limit views for mobile users with the following out-of-the box 
routing models: Sales Representative, Analyst, Minimal Data, and Sales Manager.

Determining what views a mobile user sees depends upon the responsibilities 
assigned to that user and the views attached to these responsibilities. The list of 
views attached to a specific responsibility are listed and administered in the 
Responsibilities View within Siebel’s Applications Administration screen. For more 
information about this topic, see “Using the Responsibilities View” on page 119.

Each view attached to a responsibility includes a Local Access flag. Limiting views 
is accomplished by turning off the Local Access flag for views that a particular 
mobile user does not need.

Responsibilities with the Routing Model suffix include all the views that are not 
available to the user assigned to the corresponding routing model. This prevents the 
application from displaying views for a mobile user where there is no data. 

Another mobile user, with or without the same responsibilities, may have a different 
set of views turned off. Therefore, administrators can turn off one set of views for 
one mobile user and a different set for another mobile user. By limiting the views 
on a user-by-user basis, administrators can further optimize the size of local 
databases.

NOTE: A particular user may have two or more responsibilities that include the same 
view. If Local Access=False (unchecked) for this view in any of the user’s 
responsibilities, then the view is not available on the mobile Web client. This view 
will not appear in any Navigation element, including the Site Map.

The corresponding Responsibilities with the Routing Model suffix include: Sales 
Representative Routing Model, Sales Manager Routing Model, Minimal Data 
Routing Model, and Analyst Routing Model.
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A mobile user will have access to that user’s normal views when operating either 
as a dedicated Web client or a Web client. The limitation on the visibility of views 
only applies while operating as a mobile Web client. 

Using the Responsibilities View
The Responsibilities view within the Applications Administration screen includes a 
Responsibilities list and two subordinate lists: 

■ Views list of the associated views added to individual responsibilities.

■ Users list of the users assigned to individual responsibilities. 

It also displays a Routing Model field that is read-only.

In this view you can do the following:

■ Adjust the Local Access flag—turn it off or turn it on.

■ Add views to a responsibility.

■ Read the Routing Model assigned to a user.

NOTE: Assign users to routing models in the Remote Administration > Mobile 
Clients view.

■ Add users to a responsibility.

The procedure below describes how to limit the visibility of views for mobile users 
assigned to the routing models listed at the beginning of this section. 

To limit the visibility of views for mobile Web clients

1 Determine the views a mobile user does not need.

2 Navigate to Applications Administration > Responsibilities > Responsibilities 
list, and select the responsibility with a view this mobile user does not need.

3 In the Views list, select the view this mobile user does not need.

4 Clear the Local Access check box to remove the check mark.
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5 Repeat Steps 3 and 4 for all the views the mobile user does not need that are 
associated with this responsibility.

Using the Views View
The Views view within the Applications Administration screen includes a Views list 
and a subordinate Responsibilities list. This allows an administrator to determine 
which responsibilities are associated with a particular view. An administrator can 
also determine whether those responsibilities allow a view to be displayed on the 
mobile Web client.

The Views list includes the entire list of views in the application. The Local Access 
flag is a default setting for administering these views, for example adding views to 
responsibilities in the Responsibilities view discussed above. 

The Responsibilities list includes the associated responsibilities added to the 
individual views in the Views list. The Local Access flag determines whether a view 
is available for mobile users with that responsibility.
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If you want to authenticate mobile Web clients when they synchronize, you need to 
create accounts for each client depending on the authentication method you choose. 
This section describes the requirements for the three authentication methods 
available for synchronization. 

■ If you use AppServer authentication, you must create a user account on the 
server for each mobile Web client. Examples include:

■ If the Remote server is running in the NT environment, create an NT user 
and password for each mobile Web client you defined. 

■ If the Remote server is running in a UNIX environment, create the user on 
the application server that will host Siebel Remote. For more information on 
how to create users in this environment, see Siebel Server Installation Guide 
for UNIX.

NOTE: The user name and password must both be in uppercase letters and be 
eight characters or less. They may contain only single-byte, alphanumeric, 
and the _ or - characters. They may not include spaces, periods, or other 
characters that are invalid in a DOS file naming scheme, such as ( / \ : * ? “ 
< > |) . 

■ If you use the mobile Web client’s change password functionality while 
connected to the server, the server password changes and is stored in a 
database-specific table, not a Siebel table. Therefore it is not synchronized to 
the local database. The mobile user would still use that user’s old password 
to access the user’s local database until the node is reextracted.

■ If you use database authentication, you must create a database logon and 
password for each mobile Web client. After the local database password is set 
up at the time of initialization, users cannot change it. 

CAUTION: If the user changes the password on the server (in the connected 
mode), that user will have two different passwords: one for the server and one 
for the local database. This will cause database password authentication to fail.
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 121



Setting Up Mobile Web Clients

Creating Mobile Web Client User Accounts and Privileges
■ If you use the Siebel authentication method, you must set the password for each 
mobile Web client on the Mobile Clients view, and you must provide the 
password to mobile users so they can use it to synchronize with the Siebel 
Server.

If you do not use authentication, then you do not need to create any of these 
accounts or passwords.

To create an NT user and password for a mobile Web client

■ See “To enable the Windows NT user rights on the Siebel Remote server” on 
page 76 and follow the instructions.
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This chapter describes database extraction. Extracting databases for mobile Web 
clients involves tasks for both the Siebel Remote server and the mobile Web clients. 
Table 11 shows these tasks. You must repeat each of these steps, for every mobile 
Web client.

Table 11. Tasks for Enabling Mobile Web Clients

Task Where Performed

Database Extraction for a Mobile Web Client on page 124 Server

Initializing a Mobile Web Client Database on page 134 Mobile Web client

Enabling the Stand-Alone Synchronizer on page 136 Mobile Web client

Viewing Session Details on Mobile Web Clients on page 138 Mobile Web client
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The database extract process retrieves data visible to a specific mobile user from the 
server database. It retrieves data according to routing rules that define the level of 
access to information for each mobile Web client. It creates compressed files that 
contain data to be loaded into a local database when a mobile Web client initializes 
the database. 

The database extraction process uses the new database template created by running 
the Generate New Database Template component. This template lets the database 
extraction process provide up-to-date database schemas to either new or existing 
mobile clients. It is strongly recommended that you distribute all database schema 
changes to all mobile clients, even if the changes are of types that are not visible to 
the mobile clients, such as changes to private dock objects. This is important 
because individual tables that are currently in a private dock object may become 
visible to mobile clients at a later time, and problems can occur if server and local 
database structures do not match.

The Siebel 7.5 Database Extraction component includes an enhancement when 
dealing with a list of mobile users to extract. It will identify visible instances for all 
members of a list of nodes. Then it identifies the commonly visible instances and 
extracts the records only once for all these nodes. Then it extracts instances outside 
the common set for each node. This will help reduce the time for extracting large 
numbers of mobile users. The parameter that enables this is Optimal Mode.

NOTE: Multiple instances of the database extract components can be run 
simultaneously. In order to reduce contention, each task should be assigned to use 
a different temporary table called S_DOCK_INITM_n, where n is 1 to 48. Siebel 
Remote supports up to 100 such tasks. The Siebel Schema includes 48 
S_DOCK_INITM tables. You can create additional tables based on your loads and 
needs by using the ddlexp and ddlimp utilities.
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Before running a database extract for a client, you must make sure that your 
organization’s reporting hierarchies are updated. Use the Position Administration 
view from the Application Administration screen to verify that the user you are 
about to extract has a valid position in your organization’s hierarchy. The resulting 
information is used by the system’s routing rules, and may affect the outcome of 
the database extract. For more information on positions, see Applications 
Administration Guide.

CAUTION:  If a mobile user’s position or routing model changes, reextract the mobile 
Web client’s database to delete records that should no longer be visible to the user 
based on the user’s new position. 

Additionally, this improves performance because the reorganization process will 
generate many transactions on the server, which will create a backlog.

Administrators can start several instances of dbxtract and reduce the contention by 
using more than one table. The parameter is TS Table Number with a default of 1.

During the cleanup of dobjinst.dbf database tables, administrators can choose 
truncation or deletion of the tables. The parameter is Truncate TS Table with a 
default of FALSE.

CAUTION: If two instances of dbxtract use the same table, do not set TruncateTSTable 
to TRUE—one instance can truncate the records entered from another instance.

The Save Client Transactions feature prevents the loss of local transactions a mobile 
user may have entered into the local database that were not included in the server 
db extract. This feature is valid for normal re-extract of a mobile user's local 
database and will not work during a major upgrade process.

The default setting for the server parameter Save Client Transactions is TRUE. If the 
db extract for a mobile Web client occurs when this parameter is set to TRUE, Siebel 
Remote will invoke an action before applying the new db extract. Remote will 
extract transactions from the current local database that are not yet synchronized 
with the server and store them in the mobile user's inbox as DX files. 
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After the current local database is replaced with the new extract, Remote applies the 
DX files from the mobile user’s inbox to the new local database. These include the 
saved transactions that were not synchronized with the server. These transactions 
are then sent to the server during the next synchronization session.

To run a database extract for a mobile Web client 

1 From the application-level menu, choose View > Site Map > Server 
Administration > Enterprise Operations.

2 Click the Component Requests tab.

3 In the Component Request form, click New.

4 In the Component/Job field, select Database Extract from the picklist.

5 In the Component Request Parameters list, click New and add the necessary 
parameters.

The required parameter for Database Extract is Client Name. 

The value for the Client Name parameter is the name of the mobile Web client.

6 In the Component Requests form, click the menu button and then click Submit 
request. 

The mobile Web client database is extracted. This may take a few minutes. 

NOTE: For limited-visibility objects, attaching many children to the same parent 
record can degrade the router performance and the database extract performance. 
The reason this may happen is that for each child the visibility for all other children 
must be checked. Whenever there are more than 10,000 child records attached to a 
parent (such as contacts attached to an account), the database extract performance 
and router performance need to be tested thoroughly. In case performance 
degradation is observed, it is necessary to limit the number of children per parent.

Database Extraction for Multiple Users
There are times when you need to extract a list of users or hundreds of users. The 
procedures in this section show how to do this.
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To extract a list of users

1 Create a list (or two) containing the mobile users in a text file.

2 Put one user name on each line.

3 Start dbxtract server task.

Use @filename (including the path) as the value for the Client Name parameter.

4 If you have more than one list, start another dbxtract instance.

Be sure to specify a different value for the TS Table Number parameter.

To extract hundreds of users

1 Separate users into multiple lists (about 50 to 100 per list).

2 Start a dbxtract task for each list.

3 Note that mobile users should be extracted on the Applications server against 
which the users will be synchronized. 

Example of Extracting Databases for Multiple Users
This section describes the steps in the overall process of creating database extracts 
for multiple mobile Web clients. The purpose is to provide a broad perspective on 
the tasks involved. 

It begins after installation of the Siebel application, to include registration of every 
user. The administrator receives the following business requirement: create 
database extracts for new mobile users AMARTIN, CCHENG, PSINGH and 
RMARLOW. 

The requirement implies that to create a database extract you also need a database 
template. A database template is created only once. Additionally, in order to create 
database extracts for multiple users at the same time, you need to create a text file 
containing the user IDs of these mobile users. Finally, you submit the component 
request for creating the database extract. 

The steps below outline the process for the example business requirement:

1 Log in to your Siebel eBusiness Application as System Administrator.
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2 Create the database template by navigating to Site Map > Server Administration 
> Enterprise Operations > Component Requests tab.

3 Create a new component request for Generate New Database. 

4 Submit the component request.

The task of creating a database template takes a while. To check the progress of 
this task, go to the Components View and check the information about the status 
of this task.

Upon successful creation of a database template, you will see the Components 
View.

5 In order to extract databases for multiple users, create a text file called 
ExtractUserList.txt containing the user IDs of the new mobile users.

6 Navigate to Enterprise Operations > Component Requests tab and define a 
component request for Database Extract.

7 Enter the Component Request Parameters and submit the component request.

Once the task of creating database extract is completed, go to the directory 
d:\sea14010\siebsrvr\docking to see folders for AMARTIN, CCHENG, PSINGH and 
RMARLOW.

Performing a Database Extract to a CD Directory
By default, a database extract stores the compressed file on the Siebel Remote 
server. Users log on to the Siebel Remote server to download data to initialize their 
local databases. However, a database extract can also store the compressed file in a 
directory that you specify in the database extract parameters. This allows you to 
copy the compressed database file from the specified directory and then make an 
image of the files on a CD-ROM or other media device, which you can then 
distribute to users. Mobile users can initialize their local databases directly from the 
CD-ROM rather than having to download to the Siebel Remote server.

NOTE: The user still needs a network connection for this method. Remote clients still 
need to synchronize before retrieving a database extract from the CD-ROM.
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When mobile Web clients initialize from a CD-ROM, a parameter in the mobile Web 
client’s configuration file instructs the database initialization process to check the 
CD-ROM directory rather than the Siebel Remote server for files to download. This 
parameter is FileSystem and is located in the Local section of the client 
configuration file. See “Setting Siebel Remote System Preferences” on page 58 for 
more information.

NOTE: It is possible to extract groups of users simultaneously. Therefore, it is 
possible to use one CD for more than one user. The names of the files contain the 
client_names.

Before mobile Web clients can initialize from a CD-ROM or other media device, you 
need to add the FileSystem parameter to client CFG files. The FileSystem 
parameter directs the mobile Web client to the CD-ROM or other media device 
directory during the initialization process. For information on setting the 
FileSystem configuration parameter, see “Setting Synchronization Preferences” on 
page 87.

To perform a database extract to a CD directory

1 Complete Step 1 through Step 4 of “To run a database extract for a mobile Web 
client” on page 126.

2 In the Component Request Parameters list, click New and add the necessary 
parameters.

a The required parameter for Database Extract is Client Name. 

The value for the Client Name parameter is the name of the mobile Web 
client.

b The parameter for extracting to a CD is CD Directory. Specify the name of the 
directory to which you want to extract files

For example, type D:\temp-extract\username.

c Modify the values of other parameters as necessary.

Table 12 on page 130 lists the parameters and default values for the database 
extract component.
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3 In the Component Requests form, click the menu button and then click Submit 
request.

The mobile Web client database is extracted to the directory specified in the CD 
directory parameter. You can make an image of these files on a CD-ROM or other 
media device.

Parameters of the Database Extract Component
Table 12 lists the parameters and default values for the database extract component.

Table 12. Database Extract Parameters

Name Alias Required/Optional Default Value and Usage Notes

CD directory CDDir Optional Name of a directory to which 
snapshot files are copied for use by 
the CD-ROM initialization method.

Client Name Client Required Name of the mobile Web client for 
which you are performing a database 
extract. This corresponds to the 
Mobile Client Name field in the 
Mobile Clients view.1

Database Init Method InitMethod Optional Method for creating the Siebel Remote 
database. Default is SQL Anywhere.

Database template file name DbTmplFile Optional Name of the SQL Anywhere Database 
Template file. Default is sse_utf8.dbf. 

Extract all Repository Tables ExtractRepos Optional Specifies that the repository tables 
will be included in a db extract. 
Values are TRUE and FALSE.

Last Extract Date ExtractSince Optional When specified, Database Extract 
extracts mobile Web clients only if 
they have not been extracted since 
this date-time value. The value must 
use the format YYYY-MM-DD 
HH:MM:SS.
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Last Sync Date SyncSince Optional When specified, Database Extract 
extracts mobile Web clients only if 
they have not been synchronized 
since this data-time value. The value 
must use the format YYYY-MM-DD 
HH:MM:SS.

Maximum data file size DatFileSize Optional Sets the maximum size of a data file in 
megabytes. Minimum size is 1. 
Maximum size is 1000. Default is 500.

Message Language Code Language Optional Extract messages for this language. 
Default is ENU.

Move Siebel Remote client Move Optional Specifies if Database Extract should 
set the mobile Web client’s Siebel 
Server name to the local Siebel 
Remote server if the mobile Web 
client is currently registered on 
another Siebel Remote server. The 
default is FALSE.2

Nodes Per Group: NodesPerGroup Optional Number of users in one group to be 
extracted together when OptMode is 
TRUE. Default is 35.

Optimal Mode OptMode Optional Specifies whether to use the optimal 
mode to extract a group of users. 
Default is FALSE.

Save Client Transactions SaveTxns Optional Save pending client transactions 
during database initialization. Default 
is TRUE. This feature will not work 
during the upgrade process.

Save Client Transactions is valid only 
for mobile Web clients.

Specify the mobile client vers ClientVersion Optional Specifies the client software version. 
This is important during upgrades. 
Default is 2000 for v7.x.

Table 12. Database Extract Parameters

Name Alias Required/Optional Default Value and Usage Notes
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 131



Extracting Databases for Mobile Web Clients

Database Extraction for a Mobile Web Client
Truncate TS Table TruncateTSTable Specifies whether the 
S_DOCK_INITM_n table should be 
truncated instead of deleted after the 
database extract task completes. Used 
in the cleanup phase. Default is 
FALSE.

When running the database extract 
(dbxtract) component with the 
Truncate TS Table parameter set to 
TRUE, the user ID used for running 
the server component must have 
administrative privileges in the 
database server. 

TS Block Size TSBlockSize Optional Block size for dobjinst.dbf database in 
bytes. The default is 0. The block size 
is automatically calculated depending 
on the total number of rows visible to 
the mobile Web client.

TS Cache Size TSCacheSize Optional Cache size for dobjinst.dbf database 
in kilobytes. The default is 2048 
kilobytes.

TS Table Number TSTableNum Number of dobjinst.dbf database 
tables available for dbxtract: 1 to 48. 
Default is 1. The ending number of 
the S_DOCK_INITIM_n table.

1. You can specify a list of node names delimited by commas. If the first character is @, this parameter specifies 
the name of a file that contains a list of nodes. Client names in the file must be separated by one of the 
following delimiters: new line, comma, space, tab, period, or semicolon. You can specify wildcards, using * 
to match zero or more characters and ? to match a single character.

2. This option applies to the Siebel Remote clients, including mobile Web clients and regional nodes. Database 
Extract returns an error if you try to extract a mobile Web client that was previously extracted on a different 
server. You can move the client to the current Siebel Server by setting the Move parameter to TRUE. You can 
also move a regional node to the current Siebel Server by using the Move parameter. The Transaction Router, 
Transaction Merger, and DB Extract processes on the old server stop servicing the mobile Web client or 
regional node in the next iteration.

Table 12. Database Extract Parameters

Name Alias Required/Optional Default Value and Usage Notes
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You may get an error message if the target node is used by another Siebel Remote 
server process. For example, if another Siebel Remote server process were accessing 
the inbox or outbox directory for sjones, you would receive the following error 
message:

Target node “sjones” is currently in use by another server 
process. Try again later.

In this case, you should try to rerun a database extract in a few minutes when the 
file may be available and unlocked.

NOTE: After you have performed a database extract for a mobile Web client, the 
client database must be initialized before any data exchange between the client and 
the server can occur. This includes the uploading of any client database changes.
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Initializing a Mobile Web Client Database
The volume of information that must be downloaded from the Siebel Remote server 
to initialize a mobile Web client’s database is usually substantial. You should 
establish a LAN (rather than a modem or WAN) connection between the server and 
the mobile Web client for this process. 

Alternatively, the local database can be initialized from a CD-ROM or other media 
if compressed files have been copied into the folder specified as FileSystem 
parameter. For more information, see “Performing a Database Extract to a CD 
Directory” on page 128.

NOTE: To initialize a mobile Web client database, the TableOwner parameter in the 
CFG file must be set to Siebel (the default). 

To initialize the mobile Web client database using the GUI

1 Establish a connection between the Siebel Remote server and the mobile Web 
client.

2 In the mobile Web client’s Siebel program group, click the Siebel Remote icon.

NOTE: Verify that the icon is pointing to the appropriate CFG file. The default is 
siebel.cfg.

3 In the Siebel Remote Parameters dialog box, enter the appropriate information.

In the Client Name field, enter the registered Siebel client name.

In the User Name field, enter the login name of the mobile user.

4 Enter the password. 

The password must match the authenticator password.

5 Click Continue.

6 Monitor the process for errors by clicking the opposing arrows in the lower right 
corner of the screen.
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To initialize the mobile Web client database from the command line

■ The mobile Web client database can also be initialized from the command line 
using the stand-alone synchronizer (siebsync.exe). For information on how to 
use the stand-alone synchronizer, see “Enabling the Stand-Alone Synchronizer” 
on page 136.

To initialize the mobile Web client database during login

■ Another way to initialize the mobile Web client is to log in to the local database 
when starting the application. When your Siebel application cannot find a local 
database, it will attempt to initialize the local database following the procedures 
described above.
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Enabling the Stand-Alone Synchronizer
A mobile user can control the synchronization start-up process by running the 
Siebel Remote client in a third-party scheduling program. Table 13 shows the 
command-line options for the Siebel Remote client. 

NOTE: If a local connection to the client is open and the user uses the Siebel Remote 
icon to synchronize, synchronization works successfully. However, if a new 
database extract exists for that user, the synchronization fails, because it is trying 
to overwrite the sse_data.dbf file, which is already in use. Therefore, the stand-
alone Siebel Remote client should only be used when the mobile Web client is not 
in use.

Table 13. Stand-Alone Synchronizer Command-Line Options

Option Definition Required/Optional Default Value and Usage Notes

/n Client name Required Name of mobile Web client. The 
value must be entered using 
uppercase letters.

/u User name Required Database connection user name. 
The value must be entered using 
uppercase letters.

/p User password Required Database connection password. The 
value must be entered using 
uppercase letters.

/p2 Confirmation password Required Required when initializing.

/c Configuration file Required The default is siebel.cfg.

/d Data source Optional The default is local.

/a Autostart mode Optional Available modes are Y or N.

/v Verbose mode Optional Available modes are Y or N.1

/i Iterations Optional Sets the number of iterations.
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/l Language Optional Language to use for the docking 
session.

/sleep Sleep time Optional Number of seconds to sleep 
between iterations.

/comm Communication parameters Optional Used for modem connections.

/RecvFiles Receive files Optional Determines whether mobile Web 
client will download files from 
server. Available modes are Y or N.

/RecvTxns Receive transactions Optional Determines whether mobile Web 
client will download transactions 
from server. Available modes are Y 
or N.

/SendTxns Send transactions Optional Determines whether mobile Web 
client will send transactions to 
server. Available modes are Y or N.

/RecvPubFiles Receive published files Optional Determines whether mobile Web 
client will download published files. 
Available modes are Y or N.

/RecvAutoUpdFiles Receive auto updates to files Optional Determines whether mobile Web 
client will download updates to 
requested files. Available modes are 
Y or N.

/?
/help

Help Optional Provides online help for usage.

1. You may want to run the Stand-Alone Synchronizer unattended by setting the verbose mode to N. After 
synchronization, the Stand-Alone Synchronizer returns 0 if the process succeeded, or a nonzero Siebel error 
code if it failed.

Table 13. Stand-Alone Synchronizer Command-Line Options

Option Definition Required/Optional Default Value and Usage Notes
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Viewing Session Details on Mobile Web Clients
The Remote Status view displays information about database updates based upon 
the value of the system preference MRG:User Friendly Notification. For more details 
about system preferences that affect the way Remote manages database changes, 
see “Setting Siebel Remote System Preferences” on page 58. There are three applets 
in this view: Session Summary, Session Actions and Session Actions Details. The 
first two applets typically appear, while display of the Session Actions Details applet 
depends upon the activities of the synchronization session.

The previous synchronization details are archived on the local database and not 
stored on the server database. On [Local], the previous synchronization details 
could be found in the Site Map > User Preferences > Remote Status view. On 
[Server], only the latest synchronization details are stored. These can be referenced 
from views in the Siebel Remote Administration screen. 

The lists below describe the fields in the three applets in the Remote Status View.

■ Session Summary. Lists every synchronization session that occurred since the 
last local database initialization. There are three fields: 

■ Session Date. Timestamp of the beginning of the synchronization session.

■ Session Status. Result of the synchronization session.

■ Session Result Summary. Key summary information of the synchronization 
session.

■ Session Actions. Provides detailed information of the major action of the 
synchronization session. Usually, there are five major actions. There are two 
fields in this applet.

■ Item Name. Name of major action.

■ Results Summary. Summary result of the particular action.

■ Session Actions Details. Provides more detail depending upon the activities of 
the synchronization session.

■ Item Type. Type of object, such as Account or Opportunity.

■ Item Name. The actual field.
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■ Action. The kind of conflict or action.

■ Updated By. Self-explanatory.

■ Date Updated. Self-explanatory.

■ Item Details. Detailed information as to what was done.
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This chapter describes administrative tasks for operations and maintenance of 
mobile Web Clients. It also addresses routing rules, dock objects, and dealing with 
failures and recovery. Table 14 addresses these tasks.

Table 14. Tasks for Administering Siebel Remote

Task Where Performed When Performed

Starting and Stopping Siebel Remote 
Server Components on page 142

Siebel Server Manager Database start-up, 
Siebel Server start-up

Monitoring Siebel Remote Operations on 
page 146

Siebel Server Manager Daily

Data Synchronization on page 159 Client Machine Daily or more often

Sending Messages to Mobile Users on 
page 161

Siebel Remote server As needed

Refreshing a Client Database on 
page 162

Siebel Server Manager As needed

Deactivating and Reactivating a Mobile 
Web Client on page 164

Siebel Server Manager As needed

Deleting a Mobile Web Client on 
page 166

Siebel Server Manager As needed

Changing Routing Models on page 168 Siebel Server Manager As needed

Adding New Mobile Users on page 169 Siebel Server Manager As needed

How to Set Client-Side Logging on 
page 170

Siebel Server Manager As needed

Event Tracing for Locking on page 174 Siebel Server Manager As needed

Handling Failure and Recovery on 
page 176

Various As needed
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Starting and Stopping Siebel Remote Server Components
Use the Siebel Server Manager to start and stop any Siebel Remote server 
components.

NOTE: Event logs provide helpful information for diagnosing problems that may 
arise. To enable event logging for Remote components, see Siebel Server 
Administration Guide. For example, to receive useful information for the dbxtract 
component, enter the following in the command-line interface for srvrmgr:

change evtloglvl GenericLog=5, Trace=5, SQL=5, 
EVENT_GENERIC_PROFILE=5 for comp Dbxtract 

start task for comp Dbxtract with Client=<ClientName>, SQLFlags=2, 
TraceFlags=7

To enable the Remote component group

1 In the command-line interface, change to the Siebel Server bin subdirectory.

2 Enter the following command to invoke the Line Mode Server Manager:

srvrmgr /e <enterprise server> /g <gatewayserver>  /u <username> 
/p <password>

3 From the Server Manager command line, enter:

enable compgrp remote

This will enable all Siebel Remote components: Synchronization Manager, 
Transaction Processor, Transaction Router, Transaction Merger, Replication 
Agent, Database Extract, Parallel Database Extract, and Generate New Database.

4 From the GUI, synchronize the components by navigating to View > Site Map 
> Server Administration > Enterprise Configuration > Batch Component 
Admin.

5 Click Synchronize.

To disable the Remote component group

■ From the Server Manager command line, enter:
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disable compgrp remote 

To enable Remote component group for a specific server 

■ From the Server Manager command line, enter:

enable compgrp remote for server <server_name>

This will enable Remote only on certain Application servers in the enterprise, 
rather than on all of them.

To disable individual components of the Remote component group

■ From the Server Manager command line, enter:

disable compdef <component definition> 

Component definition will be synchmgr, txnproc, txnroute, txnmerge, 
repagent, dbxtract, pdbxtract, or gennewdb, depending upon the situation.

For additional information on starting and stopping server components using the 
Server Manager, see Siebel Server Administration Guide.

Transaction Processor
■ You can run only one transaction processor on each Siebel Remote server. 

■ At startup, the transaction processor verifies that another transaction processor 
is not running on the same Siebel Remote server.

NOTE: The optimal number of Remote Servers, and therefore the number of 
Transaction Processors, will depend upon the number of mobile users, volume 
of transactions generated by the system, and other aspects of the system. For 
assistance with hardware planning and sizing, contact Siebel Expert Services.

Transaction Router
The Transaction Router takes transactions from DOCKING\TXNPROC and 
constructs DX files. It then sends these DX files to the outbox corresponding to the 
appropriate mobile user.
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Multiple Transaction Router Processes
You can start multiple Transaction Router processes on the Siebel Remote server to 
increase the throughput of transactions to mobile user outboxes. 

■ Each Transaction Router process can simultaneously route transactions from the 
database server to a different mobile Web client. For example, if you start four 
Transaction Router processes, the four Transaction Router processes can route 
transactions to four different mobile Web clients simultaneously.

■ Using multiple Transaction Router processes reduces the total time needed to 
route transactions to mobile Web clients.

NOTE: The optimal number of Transaction Routers will depend upon the number of 
mobile users, volume of transactions generated by the system, hardware 
configuration and other components of the system.

You can start as many parallel Transaction Router processes as the database server 
and Siebel Remote server can support:

■ You should monitor the database server and Siebel Remote server to make sure 
the parallel Transaction Router processes do not overload the systems.

■ Plan to start with two Transaction Router processes and increase the number as 
needed.

■ You will typically run multiple Transaction Router processes per server.

CAUTION: Do not run a Transaction Router and Ddlsync at the same time. It can 
cause Transaction Router to shut down.

Also, do not run the visutl utility on a mobile Web client when Transaction Router 
is processing that node.

Routing Transactions from the Database Server
Only one Transaction Router process can route transactions from the database 
server to a mobile Web client at any one time:
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■ The Transaction Router locks the mobile Web client’s outbox directory to 
prevent other Transaction Router processes from routing transactions to the 
same mobile Web client.

■ Other Transaction Router processes skip the mobile Web client if another 
Transaction Router process is already processing this client.

■ After the Transaction Router finishes routing transactions to the mobile Web 
client, the Transaction Router releases the lock and searches for another 
unlocked mobile Web client to process.

Transaction Merger
Transaction Merger pulls DX files from the inbox in the server Docking Directory 
and applies these to the server. It also resolves conflicts.

■ You must run at least one transaction merger on each Siebel Remote server.

■ You can run multiple transaction mergers on the same Siebel Remote server. 

NOTE: The optimal number of Transaction Mergers will depend upon the number of 
mobile users, volume of transactions generated by the mobile users, hardware 
configuration, and other components of the system.
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Monitoring Siebel Remote Operations
This section describes how to monitor the status of mobile Web clients and Siebel 
Remote operations on the server. The information is divided into three main 
sections:

■ “Monitoring Mobile Web Client Status” on page 146

■ “Monitoring Transaction Logs” on page 154

■ “Monitoring Siebel Remote Server Operation Status” on page 157

Monitoring Mobile Web Client Status
You can use views in the Siebel Remote Administration screen to monitor the status 
and progress of mobile Web clients.

Using the Client Status View
The Client Status view displays the current status of mobile Web clients, including:

■ The last time each mobile Web client synchronized

■ The product versions on each mobile Web client

■ The last time each mobile Web client was extracted and initialized

■ Free Disk (Bytes)  

Siebel Remote updates the data in this screen at the start and end of each 
synchronization session. However, the data in this screen is not updated in the 
following two cases:

■ During an initialization

The Free Disk (Bytes) field will also be reset to zero during dbxtract. 

■ After applying changes to the client database

In both cases, the actions occur after the mobile Web client disconnects from the 
server. Therefore, the data in the status screen is not updated until the next 
synchronization session. At that time, users can check this information to help 
avoid running out of disk space on their laptops.
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When using Siebel Anywhere, the following occurs: the Product Versions field is not 
populated until the mobile Web client upgrades to another version. Once the 
upgrade is complete, the Product Versions field is updated with the version 
information after the next synchronization session.

To use the Client Status view

1 From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

2 From the Show drop-down list, select Client Status.

3 In the Mobile Clients/Replication Servers list, select the mobile Web client that 
you want to monitor.

The fields in the Siebel Remote Client Status form provide details about the 
status. 

Field Description

Extracted on Server

Last Sessions Time when the extract for this client was done

Seconds Time it takes to extract the client

File name First file name for the extracted records

Rows extracted Row count of extracted records

Snapshot (bytes) Total size in bytes for extracted records

# of files in File System Number of files in file system for this client

File System (bytes) Size of files in file system, in bytes

Max transaction Maximum transaction ID when this client was extracted

Initialized on Client

Last Session Time when the local database initialization was done

Seconds Time it takes to initialize the local database

Free disk (bytes) Free disk space available on the mobile client's laptop 
drive
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Using the Client Diagnostics View
The Client Status Diagnostics view provides data routing information about the 
processors, mobile clients, and regional nodes. Table 15 lists and describes the 
fields on the Siebel Remote Client Diagnostics form. 

Database (bytes) The size in bytes of the local database

# of files in File System Number of files in local file system

File System (bytes) Total size in bytes of files in local file system

Product version System information for the machine where local 
database resides

Current status

Last session Time of the last synchronization session

Seconds Duration of the last synchronization session

Free disk (bytes) Free disk space available on the mobile Web client's 
laptop drive

Database (bytes) Current size of the local database

# of files in File System Number of files in the local file system

File system (bytes) Current size in bytes of files in the local file system

Total session How many times this client has synchronized so far

Product version Current system information for the client machine

Table 15. Fields on Siebel Remote Client Diagnostics Form

Field Description

Name Node name

Type INIT, ROUTE, RECEIVE, MERGE, CLEAN, SESSION

Local Flag to show whether it is for current or remote databases

Created Creation time for the record

Field Description
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Using the Synchronization Sessions View
The Synchronization Sessions view displays information about every mobile user 
and each user's synchronization session for a given period of time. This can be 
accessed only by the Systems Administrator.

Last updated Last update time for the record

Last file Last file number processed for the node

Last transaction id Last transaction number processed for the node

Last trxn duration 
(sec)

Time it took to process transaction in the latest session

Total duration (sec) Total Time it took to process transaction for the node

Last trxn size 
(bytes)

Size of transactions processed for the node during last session

Total (bytes) Total size of transactions processed for the node

Last trxn operations Number of operations processed for the node during last session

Total operations Total number of operations processed for the node

Last transactions Number of transactions processed for the node during last session

Total transactions Total number of transactions processed for the node

Total attachment 
(bytes)

Total size of file attachments processed for the node

Total attachments Total number of file attachments

Last attachment 
(bytes)

Size of file attachments for the node during last session

Last attachments Number of file attachments for the node during last session

Additional 
information

More detailed information for the node

Table 15. Fields on Siebel Remote Client Diagnostics Form

Field Description
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To use the Synchronization Sessions view

1 From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

2 From the Show drop-down list, select Synchronization Sessions.

3 In the Synchronization Period form, select the time frame for the period of time 
you are investigating.

4 In the Mobile Users list, select the mobile Web client that you want to examine.

5 In the Synchronization Sessions list, run a query using the appropriate values 
for the fields. 

See Table 16 for descriptions of the fields in this list.

Information displayed on the form and two list applets includes:

■ Synchronization period with From and To fields. Required.

■ Mobile users and the Application server for each.

■ Synchronization session details.

Table 16. Fields in Synchronization Sessions List

Field Description

Synchronization Starts Date and time when the synchronization session started.

Synchronization Ends Date and time when the synchronization session ended. This 
will be empty if the synchronization session did not complete 
successfully.

Transactions The number of transactions replicated to the mobile user 
during the session.

Transaction Size (MB) The total size in MB of the transactions replicated to the 
mobile user during the session.

Client Merge Duration 
(Min)

Time (minutes) taken to merge transactions on client.
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Using the Upload Statistics View
The Upload Statistics view displays information about transactions and attachment 
files that are:

■ Created on each mobile Web client

■ Received on the server

■ Applied to the server

To check that transactions are made to the server after the client synchronizes, use 
this screen to verify the last set of transactions sent from the client to the server, and 
the last transaction applied to the server.

To use the Upload Statistics view

1 From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

2 From the Show drop-down list, select Upload Statistics.

3 In the Mobile Clients/Replication Servers list, select the mobile Web client that 
you want to monitor.

Table 17 gives descriptions of the fields on the Siebel Remote Upload Statistics form.

Table 17. Fields on Siebel Remote Upload Statistics Form

Field Description

Last Session Duration of the last synchronization session.

Last File Last transaction file created on the client, received on the 
server, and applied on the server.

Last Transaction Last transaction created on the client, received on the 
server, and applied on the server.

Last Session Transaction 
Count

Number of transactions created on the client, received on 
the server, and applied on the server during the last 
synchronization session.

Total Transactions Total transactions created on the client, received on the 
server, and applied on the server since the last database 
extract.
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Using the Download Statistics View
The Download Statistics view displays information about transactions and 
attachment files that are:

■ Created on the server

Last Session Operation 
Count

Number of operations created on the client, received on the 
server, and applied on the server during the last 
synchronization session.

Total Operations Total number of operations created on the client, received 
on the server, and applied on the server since the last 
database extract.

Last Session (Bytes) Size of transactions created on the client, received on the 
server, and applied on the server during the last 
synchronization session.

Total Transferred (Bytes) Size of transactions created on the client, received on the 
server, and applied on the server since the last database 
extract.

Last Session Duration (Sec) Duration of last synchronization session created on the 
client, received on the server, and applied on the server.

Total Seconds Total duration of all synchronization sessions since the last 
database extract.

Last Session Attachment 
File Count

Number of attachment files created on the client, received 
on the server, and applied on the server during the last 
synchronization.

Total Attachment Files Number of attachment files created on the client, received 
on the server, and applied on the server since the last 
database extract.

Last Session Att File Size 
(Bytes)

Size of attachment files created on the client, received on 
the server, and applied on the server during the last 
synchronization session.

Total Attachment (Bytes) Size of files created on the client, received on the server, and 
applied on the server since the last database extract.

Table 17. Fields on Siebel Remote Upload Statistics Form

Field Description
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■ Received on the client

■ Applied to the client

To use the Download Statistics view

1 Navigate to the Siebel Remote Administration screen.

2 From the Show drop-down list, select Download Statistics.

3 In the Mobile Clients/Replication Servers list, select the mobile Web client that 
you want to monitor.

Table 18 describes the fields on the Siebel Remote Download Statistics form.

Table 18. Fields on Siebel Remote Download Statistics Form

Field Description

Last Session Date and time of last session created on the server, received on 
the client, and applied on the client.

Last File Last transaction file created on the server, received on the 
client, and applied on the client.

Last Transaction Last transaction created on the server, received on the client, 
and applied on the client.

Last Session Transaction 
Count

Number of transactions created on the server, received on the 
client, and applied on the client during the last 
synchronization session.

Total Transactions Total transactions created on the server, received on the client, 
and applied on the client since the last database extract.

Last Session Operation 
Count

Number of operations created on the server, received on the 
client, and applied on the client during the last 
synchronization session.

Total Operations Total number of operations created on the server, received on 
the client, and applied on the client since the last database 
extract.

Last Session (Bytes) Size of transactions created on the server, received on the 
client, and applied on the client during the last 
synchronization session.
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Monitoring Transaction Logs
Use the Siebel Remote Administration views to monitor transaction logs.

To monitor transaction logs

1 From the application-level menu, select View > Site Map >Siebel Remote 
Administration.

Total Transferred (Bytes) Size of transactions created on the server, received on the 
client, and applied on the client since the last database extract.

Last Session Duration 
(Sec)

Duration of last synchronization session.

Total Seconds Total duration of all synchronization sessions since the last 
database extract of the node.

Last Session Attachment 
File Count

Number of attachment files created on the server, received on 
the client, and applied on the client during the last 
synchronization.

Total Attachment Files Size of files created on the server, received on the client, and 
applied on the client.

Last Session Att File Size 
(Bytes)

Size of the file attachments created on the server, received on 
the client, and applied on the client during the last 
synchronization session.

Total Attachment (Bytes) Size of all file attachments created on the server, received on 
the client, and applied on the client since the last database 
extract of this node.

Table 18. Fields on Siebel Remote Download Statistics Form

Field Description
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2 From the Show drop-down list, select Transaction Log.

The Transaction Log list displays information about each transaction. The 
Operation Types for Siebel Remote transactions are as follows:

The fields in the Transaction Log list are described below.

Operation Type Description

D Delete single row

E Delete multiple rows

F Delete cascading rows

I Insert single row

U Update single row

V Update multiple rows

X Insert set-based rows

Y Update set-based rows

Z Delete set-based rows

G Merge multiple rows

Field Description

Node number ID of the node that generated the transaction

Operation Insert (I), update (U), delete (D), …

Item Table name of the transaction

File flag Flag to indicate whether the transaction is on a file attachment-
related table

Transaction id Sequence number of the transaction

Transaction row ROW_ID of the transaction

Transaction updated Timestamp showing when the transaction was last updated
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The fields in the detail form are described below.

3 To monitor transaction logs by operation, select Transaction Log By Operation 
from the Show drop-down list.

The fields in the Transaction Log By Operation view provide information about 
the number of transactions for each operation using the following fields:

Field Description

Transaction updated by ROW_ID of the user who last updated the transaction

Transaction conflict id ID of the conflict for the base table record

Transaction Mod Id Version number of the base table record

Visibility level Visibility event level for the transaction: Enterprise(E), 
Limited(L) 

Visibility event Whether the transaction is a visibility event

Related visibility event Whether the transaction is a related visibility event

Dock object code Dock object code of the transaction instance

Primary table row id ROW_ID of Primary table for the dock object instance

Length (Long Log data) Real length of the long column of the transaction data

Log Data 1, 2, 3, 4, long These columns hold transaction data

Field Description

Operation Type of the operation

Number of transactions Total number of transaction for the operation type
156 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Administering Siebel Remote

Monitoring Siebel Remote Operations
4 To monitor transaction logs by node, select Transaction Log By Node from the 
Show drop-down list.

The Transaction Log By Node view displays the number of transactions for each 
node. A node is a mobile Web client or Regional server. The following fields 
appear in the view:

NOTE: This view only shows transactions from mobile users and regional nodes. 
It does not include transactions created by nonmobile users who connect 
directly to the server.

5 To monitor transaction logs by table, select Transaction Log By Table from the 
Show drop-down list.

The Transaction Log By Table view displays the number of transactions for each 
table in the Siebel database. The following fields appear in the view:

Monitoring Siebel Remote Server Operation Status
Use the Server Manager to monitor Siebel Remote server tasks that are running or 
have completed by viewing their state values and statistics.

State values contain information about the current operation of a server task or the 
server component for which the task is running. Statistics are recorded at the task 
level for server tasks. When the task completes its operation, task-level statistics roll 
up to the component and server levels.

Field Description

Node Name Mobile client node name

Number of transactions Total number of transactions for the operation type

Field Description

Item Table name

Number of transactions Total number of transactions for the operation type
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You can use the Server Manager to view the state values and statistics for Siebel 
Remote server components and tasks. For more information on state values, 
statistics, and the Server Manager, see Siebel Server Administration Guide.
158 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Administering Siebel Remote

Data Synchronization
Data Synchronization
This section discusses the implications of data synchronization for the 
administrator. These explanations will help you respond to and coordinate 
synchronization issues for mobile Web clients. For details regarding the 
synchronization process, refer to “Siebel Remote Flow Diagram” on page 20 and 
“Synchronizing a Mobile Web Client” on page 40.

NOTE: A client that is extracted gets the latest transactions. The routers no longer 
need to route transactions that were generated before the extract started. Extracting 
all mobile Web clients again allows the Transaction Processor to delete all 
transactions that were created before the extraction from the transaction log.

Managing Synchronization Frequency
You are responsible for developing guidelines for synchronization frequency, the 
frequency at which your mobile users synchronize. You should recommend an 
appropriate interval between synchronization sessions, taking into consideration 
your organization and its activities. The frequency and schedule you define for the 
Transaction Router should also be considered.

Initially, you may recommend that mobile users synchronize once a day. You can 
then use the following factors to evaluate your synchronization traffic and 
determine if your synchronization schedule needs refinement.

Connection time. Frequent synchronization reduces the volume of transactions to be 
transmitted during a synchronization session, thereby reducing connection time for 
that session. You should evaluate the difference in connection time and cost 
between less frequent but longer synchronization sessions, and more frequent but 
shorter sessions.

Disk space requirements. Frequent synchronization reduces the number of 
transactions accumulated between sessions, thereby reducing the demand for disk 
space on both the Siebel Remote server and the client. You should evaluate the 
availability of disk space and determine the trade-off between increasing disk space 
and increasing synchronization frequency.
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Database volatility. Your synchronization schedule determines when changes to the 
server database are reflected in client databases. In industries with high sales 
volatility, frequent synchronization can be a significant advantage. You should 
investigate the value of frequent synchronization to your organization in such a 
case.

Remember that the Transaction Router detects and routes database changes to client 
outboxes for subsequent transmission during synchronization. Therefore, the 
operating status of the Transaction Router on each application server will affect data 
availability for mobile users. In a highly volatile environment, you may want to run 
multiple Transaction Routers for each application server. Additionally, close 
monitoring of this component is highly recommended.

Mobile users’ productivity. Frequent synchronization affects your mobile users’ time, 
and potentially affects their productivity. You should consider your users’ 
environments and their convenience in completing a synchronization session.

Server modem connections. The ratio of mobile Web clients to server modem 
connections influences your synchronization schedule. If your ratio is high, you 
may need to assign specific synchronization times to your users.

Auto Synchronization
Auto-Synchronization functionality performs database synchronization 
automatically. Once enabled and configured by the mobile user, the Auto-
Synchronization Agent runs in the background at scheduled times. It will perform 
automatic synchronization when connected to the network. This can improve the 
overall usability of the system by increasing the frequency of synchronization 
sessions.

This is invoked on the mobile Web client. One of the options is a synchronization 
reminder that prompts the user to synchronize if a specified period passes without 
a synchronization session. For more information about autosynchronization, see 
“Using Autosynchronization” on page 89.
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Sending Messages to Mobile Users
The message-of-the-day feature enables you to send messages to mobile users. 
When a mobile user synchronizes with the server, the synchronizing client displays 
the message of the day to the mobile user each time docking occurs.

To enable the message of the day

■ Place the motd.txt file in the admin subdirectory within each Siebel Remote 
server root directory.

For example, if Siebel is installed on D:\sea700, then place the modt.txt file in:

D:\sea700\siebsrvr\admin

Mobile users will see the message when they synchronize again.
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Refreshing a Client Database
Occasionally, you may need to refresh the local database for a mobile Web client. 
For example, whenever there is a change to the system preference parameters, a 
refresh or reextract is necessary for the new settings to take effect. See “Setting 
Siebel Remote System Preferences” on page 58 for more details.

To refresh a client database

1 If the mobile Web client has transactions ready for uploading, the user should 
synchronize and send changes to the server. 

2 Make sure that the Transaction Merger successfully applied transactions to the 
server database.

There are three ways to determine when transactions from a particular client 
have been processed:

■ Use the Siebel Server Manager to check whether the Transaction Merger 
successfully applied transactions for the mobile Web client. 

■ Inspect the client’s inbox directory on the Siebel Remote server. There should 
not be any files with the .dx extension in the inbox directory. 

■ Use the Siebel Client Status screen to check whether Transaction Merger 
successfully applied transactions for the mobile Web client. 

3 Run Database Extract for the mobile Web client.

Make sure that the parameter Save Transactions is TRUE.

For information on running a database extract, see “Creating Mobile Web Client 
User Accounts and Privileges” on page 121.
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4 When you have completed a database extract, notify the user to reinitialize the 
mobile Web client’s local database.

For information on initializing a mobile Web client database, see “Initializing a 
Mobile Web Client Database” on page 134.

NOTE: After you have performed a database extract for a mobile Web client, the 
client database must be initialized before any data exchange between the client 
and the server can occur. This includes the uploading of any client database 
changes.
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Deactivating and Reactivating a Mobile Web Client
To deactivate and reactivate mobile Web clients, use the following procedure:

To deactivate or reactivate a mobile Web client

1 From the application-level menu, select View > Site Map >Siebel Remote 
Administration.

2 From the Show drop-down list, select Mobile Clients.

3 In the Parent Server form, use the record navigation buttons to select the 
appropriate server.

4 In the Mobile Clients list, select the mobile Web client.

5 To deactivate the mobile Web client, do the following:

a In the End Date field, enter a new effective end date that is the current or 
future date.

This will cause the Transaction Router, Transaction Merger, and 
Synchronization Manager to stop processing requests for the client. 

b Click Save.

c Delete the docking folder for the mobile Web client from the Siebel Remote 
directory on the Siebel Remote server.

This will prevent the mobile user from establishing a synchronization session 
with the server. 

d Stop the Transaction Processor and any Router tasks to clear out any cached 
user information. 

6 To reactivate a mobile Web client, do the following:

a Clear the End Date field so that it does not contain a date.

NOTE: Even if the date is in the future when you are clearing End Date, it is 
still necessary to reextract and reinitialize.
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b Click Save.

c Reextract and reinitialize the mobile Web client.
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Deleting a Mobile Web Client
When you delete a mobile Web client, exercise care to keep the user status in sync 
across the Enterprise Server components. Before deleting a mobile user, be sure to 
set the end date to the current date or an earlier date. Ideally, shut down the Siebel 
Remote Enterprise Server components before actually deleting the user record. If 
the Enterprise Server components must be kept running, wait at least several hours 
to make sure they have been updated with the new status before actually deleting 
the user records. 

To delete a mobile Web client

1 From the application-level menu, select View > Site Map >Siebel Remote 
Administration. 

2 From the Show drop-down list, select Mobile Clients.

3 In the Parent Server form, use the record navigation buttons to select the 
appropriate server.

4 In the Mobile Clients list, select the mobile client you want to delete.

5 In the End Date field, set a new effective end date that is the current date or an 
earlier date.

This will cause the Transaction Router, Transaction Merger, and Synchronization 
Manager to stop processing requests for the mobile Web client.

6 Click Save.

7 Select the mobile client record for which you set an end date, click the menu 
button, and click Delete Record.

Repeat Step 4 through Step 7 for each mobile Web client you wish to delete.
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8 Delete the docking folder for the mobile Web client from the Siebel Remote 
directory on the Siebel Remote server.

This will prevent the mobile user from establishing a synchronization session 
with the server.

The docking folder is located in the Docking subdirectory within the Siebel 
Server root directory. See “Creating Siebel Server Directories for Mobile Web 
Clients” on page 31 for more details about these folders.
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Changing Routing Models 
There are times when an administrator may need to change the Routing Model for 
a particular mobile user. 

NOTE: Routing models are not related to responsibilities. If a routing model is 
changed, make sure the user has corresponding responsibilities so that the user 
does not have access to views for which data is not routed by the new Routing 
Model.

To change the routing model for a mobile user

1 Before changing a mobile user's routing model, instruct that user to synchronize 
with the server and not to invoke any local database changes until after the next 
synchronization.

2 Change the user’s routing model.

a From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

b From the Show drop-down list, select Mobile Clients.

c Select the mobile client record and make your changes.

d Save your changes.

3 Perform a database extract.

See “Creating Mobile Web Client User Accounts and Privileges” on page 121.

4 Prompt the mobile user to synchronize. 

The mobile user can download the new extract at the beginning of the 
synchronization session. 

It will reinitialize the mobile Web client database again. See “Initializing a 
Mobile Web Client Database” on page 134.

5 After downloading the new extract, the mobile user can resume normal 
operation.
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Adding New Mobile Users
To add new mobile users, do the following:

1 Register or create the mobile Web client. For details, see “Registering a Mobile 
Web Client” on page 94.

2 Perform a database extract for the new mobile Web client. For details, see 
“Creating Mobile Web Client User Accounts and Privileges” on page 121.

3 Perform client initialization. For details, see “Database Extraction for a Mobile 
Web Client” on page 124.
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How to Set Client-Side Logging 
This section describes how mobile Web clients can set the parameters to control 
client-side logging. Each heading that follows addresses a different aspect of the 
process. 

Event Levels
Users set the type of information to be collected by temporarily changing the 
environment variable SIEBEL_LOG_EVENTS. 

To temporarily change the environment variable SIEBEL_LOG_EVENTS 

1 Open a DOS Window and change the current directory to the 
<ClientRootDir>\bin directory. 

2 Enter the following command: 

set SIEBEL_LOG_EVENTS=<event level> 

NOTE: <event level> can be between 0 and 5. Higher levels collect more 
detailed information and use more disk space. With the default value of 1, 
minimal information is collected in the trace file. Set event level to 3 or higher 
to troubleshoot a problem, or if assistance is required from Siebel Technical 
Support. 

When setting to the higher levels, check that sufficient disk space to is available. 

3 Launch the Siebel client application with the appropriate parameter from the 
same DOS Window. 

For example, to launch the Siebel application with user=USERNAME, 
password=PASSWORD, and CFG (name and path of the CFG file), and then to 
log in to local database, enter:

siebel /u USERNAME /p PASSWORD /c CFG/ d local 

This environment variable can also be changed permanently. To do this, follow the 
procedures below. 
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To permanently change environment variable SIEBEL_LOG_EVENTS in Win2000

1 In the Windows Start menu, choose Settings > Control Panel > System > 
Advanced Environment Variables. 

2 Click New and enter the following fields: 

Variable Name = SIEBEL_LOG_EVENTS 

Variable Value = <event level> 

3 Click OK.

The newly added environment variable will be seen in your User Variables list. 

The new setting becomes effective the next time you launch the Siebel Client 
application. 

To permanently change environment variable SIEBEL_LOG_EVENTS in Win NT 

1 In the Windows Start menu, choose Settings > Control Panel > System > 
Environment Tab. 

2 Click the Variable box and set to SIEBEL_LOG_EVENTS. 

3 Click the Value box and set to <event level>. 

4 Click Set; then the newly added environment variable will be seen in User 
Variables list. 

The new setting becomes effective the next time you launch the Siebel Client 
application. 

To permanently change environment variable SIEBEL_LOG_EVENTS in Win 95 or 98 

1 Using Notepad, or another text editor, open the autoexec.bat file in the C:\ 
directory. 

2 Add the following line and save the file. 

set SIEBEL_LOG_EVENTS=<event level>

3 Reboot and launch the Siebel Client application.
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Log File Naming 
 There are two types of log file naming conventions: 

■ By default, the program log file names are <program>.log. (Siebel.log or 
UpgWiz.log.) 

■ The Process/Task Id log file name is Syncthrd_nnn_yyy.log. 

Where nnn specifies the process-id and yyy specifies the task-id. 

Archiving 
The Archive_number is a positive integer that determines how many log files will 
be archived. By default, only 10 archived log files are retained and the oldest log file 
is deleted. 

To change the archive_number 

1 Open a DOS Window and change the current directory to the 
<ClientRootDir>\bin directory. 

2 Enter the following command: 

set SIEBEL_LOG_ARCHIVES=<archive_number> 

NOTE: For log files that belong to 1, each execution of the program creates a new 
log, <program>.log, while archiving the previous versions as 
<program>_1.log, <program>_2.log, and so on, pushing down the numbers 
in an increasing order chronologically. 
Log files that belong to 2 will not be deleted regardless of the value of the 
SIEBEL_LOG_ARCHIVES variable. 

Log File Location
The location of the log file of a client program is determined by the following set of 
variables. 
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If SIEBEL_LOG_DIR is set as SIEBEL_LOG_DIR=<dir>, the log file will be created 
in that directory. Make sure this directory exists and there is access permission to 
write a file in that location. 

If no SIEBEL_LOG_DIR is specified, the log file will be created in the 
<ClientRootDir>\log directory. 
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Event Tracing for Locking 
Siebel 7.5 includes enhanced tracing capability for Remote and Replication Manager 
components. This will improve system diagnostics. Trace files track SQL statements 
the components issue and include some information about the task or function in 
progress at the time.

The addition of the locks to the tracing mechanism will display the reason locks 
were acquired, or released, for the designated components. A lock is a handle used 
by server components to determine which component has access to a specific object 
such as a DX file in the Transaction Processor directory. The inclusion of locks in 
the trace files provides additional information for troubleshooting problems. This 
will help administrators who are working with Siebel support staff to lessen the 
contention between critical server components for Remote and Replication 
Manager.

For example, assume there is a problem with the Transaction Processor 
(TXNPROC). It may be locking certain objects such as DX files in the docking 
directory and not releasing these. If you set the Log Level to 4 or 5, information 
about the locks will be captured in the log file for TNXPROC. 

This functionality is for the Remote and Replication Manager server components on 
the HQ or regional nodes, and is not available to the mobile user. These components 
include:

Tracing and logging of locks for the components includes the following objects on 
the application server: 

Use the standard Siebel event tracing mechanisms to enable the tracing for these 
locks. Logging is controlled by the trace level (level 4 or higher) of the component. 
The procedures that follow describe how to do this. This does not require restarting 
of the application server. 

■ Database Extract ■ Transaction Router ■ Transaction Merger

■ Transaction Processor ■ Replication Agent ■ Synchronization Manager

■ Parallel Database Extract

■ Inbox ■ Outbox ■ Dobjinst.dbf

■ Visdata.dbf ■ DX files
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To set tracing for locks using the GUI 

1 Navigate to Server Administration > Components, and select the component 
you need to trace. 

Choices include the components listed above. 

2 Click the Component Event Configuration tab, and select the Event Type you 
want to trace. 

Use the Event Description field to help determine which Event Type to choose.

3 In the Component Event Configuration list, set Log Level = 4. 

The log file for the component selected above will contain the tracing 
information. 

Repeat this procedure for additional traces of locks you want to trace. 

To set tracing for locks using the command line

■ From the Srvrmgr command line, enter: 

srvrmgr: change evtloglvl <event type> = 4 for componentname 
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Handling Failure and Recovery
Siebel Remote is designed to minimize the impact of a software, communications, 
or hardware failure. This section describes the most likely failures and how to 
recover from them.

Siebel Remote Transmission Failure
Mobile Web clients may experience occasional transmission failures. These failures 
may be caused by noise on the telephone line. The Siebel Remote Synchronization 
Client and Synchronization Manager inspect and verify the integrity of every Siebel 
Remote transmission. If an error is detected, Siebel Remote automatically 
retransmits the files until the synchronization is successful.

Siebel Remote Server Failure
All Siebel server programs are designed to recover automatically from a failure on 
a Siebel Remote server. After returning the system to an operational state, use the 
Server Manager to restart the Siebel Server components. For information on using 
the Server Manager, see Siebel Server Administration Guide.

Siebel Remote Server Media Failure
Media failures on Siebel Remote servers can cause serious disruptions of data 
synchronization with mobile users. After the Transaction Router routes transactions 
to files on the Siebel Remote server, the Transaction Processor deletes those 
transactions from the server database master Txn table.

You should run your Siebel Remote server with a redundant disk configuration. This 
minimizes the risk of data loss if a device fails that contains inbox/outbox 
directories for mobile Web clients. If a media failure does occur that results in file 
corruption or loss on a Siebel Remote server, you need to perform the following 
procedure.

To recover from a media failure on the Siebel Remote server

1 Fix the directories on the disk.

2 Instruct the user to send changes to the Siebel Remote server.
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3 Make sure Transaction Merger applied the transactions to the server database.

4 Run Database Extract and reinitialize the mobile Web client’s local database.

File Server Media Failure
The Siebel file server stores attachment files such as literature files and submitted 
correspondence files. Literature files are more or less static and can be recovered 
from the most recent backup. Any attachment files created after your last backup 
may be lost. You should configure the file server with a redundant disk 
configuration to minimize the risk of data loss.

Database Server Failure
If your RDBMS fails, the database administrator must diagnose and rectify the 
problem. When the system returns to an operational state, use the Siebel Server 
Manager to restart the Siebel Remote components. Siebel Remote components 
automatically recovers their process state from the last committed transaction. A 
reextraction of the mobile Web clients may be necessary. 

If the database is recovered up to the point of failure, no action is required because 
there is no loss of data. However, if the database is recovered up to a point of time 
prior to the point of failure, then you must reextract and reinitialize all mobile Web 
clients. In this case, follow the steps below after restoring the database backup:

1 Disable the Synchronization Manager component.

2 Stop the Transaction Router, Transaction Merger and Transaction Processor tasks 
if they are running.

3 Reextract all mobile Web clients.

4 Start the Transaction Processor task with the TS DB Recreate parameter set to 
TRUE.

5 Start the Transaction Router and Transaction Merger tasks.

6 Enable the Synchronization Manager component.

After you complete the steps above, the next action depends on when the last 
backup was completed, when the failure occurred, and when the user 
synchronized.
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■ If the user synchronized at a time between the time the backup was completed 
and the time the failure occurred, you must:

a Rename the locale database <SiebelClientRoot>\local\sse_data.dbf 
and dicdata.dat.

b Reinitialize the mobile Web client.

Any changes in the mobile Web client database that were not sent to the server 
will be lost.

■ If the user synchronized before the backup was completed, mobile Web clients 
can download a new database. 

If the database extract was executed with the Save Client Transaction 
parameter set to TRUE, none of the mobile Web client changes will be lost.

Server Database Records Truncated or Changed
If records are truncated or deleted on the Server database and these transactions are 
sent to the mobile Web clients, this cannot be changed or reversed. Even if the 
database is restored, this will cause data mismatch and corruption. After restoring 
the database to the time it failed, you must reextract all the mobile users.

Database Server Media Failure
A head crash or other media failure on the Siebel database server may render the 
database unusable. Therefore, your database administrator should take preventive 
measures to protect against such occurrences, such as disk mirroring or online 
backups and RAID (redundant array of independent disks). 

If restoring the database results in a permanent loss of transactions from the server, 
the Transaction Router may have routed some of those lost transactions to mobile 
Web clients prior to the crash. Full recovery may then require a second step: 
resynchronizing the server and client databases.

To diagnose and restore database synchronization

1 Stop the Transaction Router, Transaction Merger, and Transaction Processor on 
the Siebel Remote server, and use Siebel Server Manager to disable the 
Synchronization Manager.
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2 After the database administrator has returned the database server to an 
operational state, use the Siebel Server to determine if Transaction Router sent 
data to any clients after the last backup of the database server. 

These are the clients whose databases require reinitialization. To do this:

a Look at the route log file txnroute_<taskid>.log to see if there is anything 
about not processing a client because of a corrupted file.

b If the log indicates that dobjinst.dbf (visibility database) is bad, you must 
reextract the database for the mobile user identified in the log. 

For dbxtract, see “Creating Mobile Web Client User Accounts and Privileges” 
on page 121.

NOTE: A database extract may not be enough to restore a database. For 
example: On Monday a backup is invoked for two mobile users (A and B). 
On Tuesday user A synchronizes, yet that database is lost on Wednesday. 
User A’s database is restored from Monday’s backup.

Then a dbxtract is invoked for Users A and B. User B synchronizes without 
any errors. However, user A receives a mismatch error because the routed 
values are different between the client and the server. User A must delete the 
local DB before acquiring a new database. 

3 Notify these users that their databases must be reinitialized.

4 Run Database Extract for the affected clients.

For information on running Database Extract, see “Creating Mobile Web Client 
User Accounts and Privileges” on page 121.

5 Notify the affected users that their client databases will be reinitialized the next 
time they synchronize.

For information on initializing a mobile Web client database, see “Initializing a 
Mobile Web Client Database” on page 134. Since this is a potentially lengthy 
process, users may want to finish this process at different times. For example, 
users located close to a field office may want to take advantage of a LAN 
connection to reduce download time. Others may want to reinitialize during the 
evening or night, when telephone rates are lower.
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Siebel Client Database Failure
It is not necessary to perform laptop backups, because the information contained 
on the local database is a subset of the information stored on the server database. 
Therefore, in the case of a laptop or local database failure, the procedure is to 
reextract and reinitialize the local database for this mobile Web client. Any change 
made on the local database since the last docking will be lost. It is strongly 
recommended that the synchronization with the server be executed regularly. 

If the client machine loses power during a merger process, then the Local database 
may be corrupted. To avoid this, make sure the client machine has sufficient power 
before synchronization.

If a client database becomes unusable because of a media failure or other event, you 
must refresh the client database. This requires that you run Database Extract for the 
client. Siebel Systems does not support restoration of local databases because it may 
result in inconsistency between the local and server databases. For information on 
running Database Extract, see “Creating Mobile Web Client User Accounts and 
Privileges” on page 121.

NOTE: Depending on the kind of failure, database changes and file attachments that 
were awaiting upload during the next synchronization session may also be lost. In 
this case, the user must reenter them.

Recovery from Client Initialization Failure
There may be times when initialization of the mobile Web client fails and you 
cannot continue the process. The procedure that follows describes how to recover 
from this.

To recover from client initialization failure that cannot continue

1 On the client machine, go to the $Siebel-Root\bin directory.

2 Find the file upgwiz.ucf and delete it.

3 Go to the $Siebel-Root\upgrade directory and delete all files.

4 Go to $Siebel-Root\local directory and delete all the content.
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5 Rerun the initialization process.

Restoring the File System After Recovery from a Previous Image
If the docking directory and file system were recovered from a previous image, then 
the docking directories may contain data that has already been sent to the mobile 
Web client or to the server. In this case, follow the steps below after restoring the 
file system:

1 Stop the Transaction Router, Transaction Merger, and Transaction Processor 
tasks if they are running.

2 Remove all the subdirectories under the <Siebel Server>\Docking directory, 
except the <Siebel Server>\Docking\Txnproc subdirectory.

3 Reextract all mobile Web clients.

4 Start the Transaction Processor task with the parameter TS DB Recreate set to 
TRUE.

5 Start the Transaction Router and Transaction Merger tasks.

6 Reinitialize all mobile Web clients.
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This chapter describes standardized status reports, how mobile Web clients can set 
the parameters to control client-side logging, and enhanced tracing capability for 
Remote and Replication Manager components. 

Siebel provides a number of online reports that show critical information about 
Siebel Remote and Replication Manager components and system status. These 
allow the administrator to obtain additional information about the Remote 
components and mobile users. This information will enhance the Siebel 
administrator's ability to monitor and manage a Siebel Remote and Replication 
Manager deployment.

This information will also enhance the support, and it can reduce administrative 
overhead.
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Status Reports
There are ten standardized reports available, with the following types of 
information:

■ Synchronization frequency 

■ Transaction backlog 

■ Transaction Processor 

■ Mobile Users Usage 

■ Outbox Analysis 

There are nine on-line reports available from the related views within the Siebel 
Remote Administration screen. To access these from the application-level menu, 
choose View > Reports. 

The Outbox Analysis report is not an on-line report because it is generated by a 
workflow. Access for this report is covered later in this chapter. 
184 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Siebel Remote Reports

Status Reports
Table 19 lists the nine on-line reports accessed from the appropriate view within the 
Remote Administration screen.

Table 19. Standardized Status Reports - Remote and Replication Manager

Name of Report Description View 

Mobile User 
Status Report 

This report is available on all server nodes that contain mobile users. 
Below is a list of information available in the report: 

■ Date and time of last extraction 

■ DB Extract Size (MB)

■ DB Extract Rows

■ Local DB Size (MB)

■ Date and time of last initialization 

■ Date and time of last synchronization 

■ Number of transactions

■ Size of transactions in MB

■ Duration of session 

■ Duration of last merge on client

■ DX files last routed from the Server

■ DX files last routed to the Server

■ DX files received and merged into the Server by this user 

■ DX files received and merged on to the Local database of this user 

This report also indicates whether the user is active. Otherwise, it 
displays last accessed date, and the name of the Routing Model 
associated with the mobile user. 

Client Status

Transaction 
Processor Status 
Report

This report shows the status of all active and inactive transaction 
processor entries in the current Enterprise server. It also includes 
details such as: 

■ Date and time of last run

■ Duration of last run

■ Number of transactions and operations copied

■ Last DX file created and removed from the docking\txnproc folder 
on the corresponding application server

Processor Status
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Transaction 
Backlog Status 
Report 

This report provides information concerning pending transactions in 
the queue from active mobile users and regional nodes with respect 
to the most recent transaction created on the HQ at the time the report 
was run. Fields in this report include the mobile Web client name and 
the number of pending transactions.

Transaction Log

Synchronization 
Frequency 
Report 

This report displays the frequency of synchronization by every mobile 
user for a given period of time. Each line of the report includes Mobile 
User ID, App Server Name, and the number of times the user has 
synchronized in a given period.

Synchronization 
Sessions

Synchronization 
Session Report 

This report provides information about synchronization sessions of 
every mobile user for a given period of time. The report provides 
mobile user information and details of their synchronization sessions.

Synchronization 
Sessions

Regional Node 
Status Report 

This report is available on all server nodes that have subordinate 
regional nodes.  This report should contains the following 
information about the regional node: 

■ Date and time of last extraction

■ Date and time of last initialization 

■ Date and time of last synchronization 

■ DX files last routed to the node from the parent server

■ DX files last routed by the regional node to the parent server 

■ DX files received and merged into the parent server

■ DX files received and merged into the regional database 

The report should also indicate whether the regional node is currently 
active or end dated and its routing group.

Client Status

Active Mobile 
Users Usage 
Graph

This report is available on all server nodes that have mobile users. 
The report takes start date as a parameter from the user and it 
generates the following details for each day between the start date 
and the current date, in the form of a graph: 

■ X-axis includes all the days in the specified range of dates

■ Bar graph displays the number of cumulative inits per day 

■ Line graph displays the number of unique syncs per day. Number 
of unique syncs means number of mobile users that synchronized 
per day.

Synchronization 
Sessions

Table 19. Standardized Status Reports - Remote and Replication Manager

Name of Report Description View 
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The procedure that follows describes how to access these reports. 

To access on-line Remote reports 

1 Navigate to the appropriate view within the Remote Administration Screen that 
has status reports available. 

For example, you may want reports from the Synchronization Sessions view.

2 From the application-level menu, navigate to View > Reports. 

3 From the selection dialog box, choose the report and language options. 

4 Click OK and view the report. 

Active Mobile 
Users Usage 
Table

This report is available on all server nodes that have mobile users. 
The report takes start date as a parameter from the user and it 
generates the following details for each day between the start date 
and current date in the form of a table:

■ Date column displaying all the days in the specified range of dates

■ Daily inits column displaying the number of initializations per 
day 

■ Cumulative initializations column displaying the number of 
cumulative inits per day 

■ Daily unique syncs column displaying the number of mobile users 
that synchronized per day

Synchronization 
Sessions

Transaction 
Router Backlog 
Report 

This report provides information about:

■ The number of transactions that could potentially be routed to the 
active mobile users or regional nodes. This is calculated with 
respect to the most recent transaction created on the HQ at the 
time the report was run.

■ The latency of the active mobile users and regional nodes with 
respect to the time the report was run. The report displays the 
total, average, maximum, and minimum backlog and latency. 

Latency is the time difference between the last transaction routed to 
the mobile user or regional node and the time the report was run.

Transaction Log

Table 19. Standardized Status Reports - Remote and Replication Manager

Name of Report Description View 
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These reports are accessible only to the Administrator except for the Client Status 
report. The Client Status report is available to mobile Web clients as long as their 
responsibilities include this view. For additional information about responsibilities, 
see Applications Administration Guide. 
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Using the Outbox Analysis Report
The Outbox Analysis report is not an on-line report. It is created by a workflow 
process called Outbox Analysis Report Generator. It is available on all server nodes 
that have mobile users. This report is used to analyze the potential problems of data 
models, visibility rules, and router performance. 

In this report, transactions in a mobile user's outbox are stored based on the target 
table name and the type of the operation. The tables that have the largest numbers 
of transactions are especially important to the outbox transaction analysis. This 
report provides information about the following for each pre-selected mobile user: 

■ Remote User Name 

■ Start time and end time of the transaction 

■ Top 20 transactions including target table names, database operation type, and 
the number of transactions 

The 12 database operation types reported are: 

■ Insert: Insert a new record added to a table. This is different from Download, 
described below.

■ Delete: Delete a record from a table 

■ Update: Update values of a record 

■ Cascade: Bundled operation: Delete a record and multiple cascade operations 
because of the delete operation

■ MRUpdate: Multi-row update

■ MRDelete: Multi-row delete

■ Download: Record that becomes visible because of a visibility event. 
Previously the record was in the database, but not visible to the mobile Web 
client.

■ DORemove: Delete a dock object (records from all tables that made up an 
instance of a dock object) instance. 

■ Sinset: Set-based insert (many rows at once)
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■ Supdate: Set-based update

■ Sdelete: Set-based delete

■ Others: All other operations except the 11 operations listed above

To run the Outbox Analysis report

1 Modify the Outbox Analysis report configuration file based on the system setup 
and outbox analysis requirements. 

The location of the Outbox Analysis report configuration file (outboxreport.cfg) 
is siebsrvr\bin\$LANG\ where $LANG is the language setting of the Siebel 
server. For example, an English-language setting is $LANG=enu. Therefore 
outboxreport.cfg is in siebsrvr\bin\enu\.

The report configuration file input parameters are:

a DataSource (Required field). The ODBC data source name.

b TableOwner (Required field). The table owner of the database.

c DockingDirectory (Required field). The location of the Siebel Remote docking 
directory. For example: siebsrvr\docking.

d NodeName (Required field).

If there is only one mobile user's outbox to be analyzed, put that mobile 
user's login name here. For example: NodeName = BCOOK.

If there are multiple users, a text file that contains the remote users’ login 
names is required. For example, nodelist.txt with a list such as:

BCOOK

APARKER

Use the @ and full path to designate the node list file. For example, 
NodeName=@d:\siebsrvr\docking\nodelist.txt.

e Repository (Required field). SIEBEL_REPOSITORY name.
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f StartTime (Optional field). A time stamp indicates that only those 
transactions created at and after this time will be processed. If StartTime is 
not given, it will be set to 24 hours before the current time. The time is in 
format YYYY-MM-DD HH:MM:SS. For example, StartTime= 2002-6-10 
14:20:00.

g EndTime (Optional field). A time stamp indicates that only transactions 
created at and before this time will be processed. If EndTime is not given, it 
will be set to the current time. The time is in format YYYY-MM-DD 
HH:MM:SS.

h Repeat (Optional field). Indicates whether the outbox transaction processing 
will stop at the current time or continue to EndTime— if EndTime is set to 
some time after current time. Can be Y or N, default is N. 

If Repeat is set to Y, and the EndTime is set to some time after current time, 
an outbox report will be generated every 24 hours until the EndTime is 
reached.

The following is an example of an outboxreport.cfg file, which is used to analyze 
outbox transactions in the past 24 hours.

DataSource = siebsrvr_datasource

TableOwner = Siebel

DockingDir = D:\siebsrvr\docking

SiebelRepository = Siebel Repository

ClientName = @D:\siebsrvr\docking\report\nodelist.txt

2 Navigate to Server Administration > Enterprise Operation > Component 
Requests, and click New. 

In the Component Job field, select Workflow Processor Manager. 

Complete the remaining fields as necessary for the particular request. 

3 In the Component Request Parameters list, click New. 
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4 In the Component Request record, add the Workflow Process Name parameter 
as shown below.

In the Name field, select Workflow Processor Name. 

In the Value field, select Outbox Analysis Report Generator. 

5 In the Component Requests form menu, choose Submit request. 

6 Navigate to siebsrvr > DOCKING > Report to read the generated report. 

The name of this report is report_<starttimemonth>_<starttimedate>.txt. 

For example, if the StartTime in outboxreport.cfg is set to April 9, the path to the 
report is siebsrvr\DOCKING\Report\report_4_9.txt. 

NOTE: There are two ways to view the report from Siebel Remote Administration 
> Mobile Client Status:

1. When using the Web client, report files must be manually copied to the report 
server machine to a folder <homedir>\docking\report. SIEBEL_ROOT 
environment variable should be set as <homedir>. If the Siebel_Root 
parameter is set to an absolute folder instead of the SIEBEL_ROOT environment 
variable in Actuate6\Server\rptsrvr.cfg, then report files should be copied to the 
docking\Report subdirectory in that folder.

2. When using the dedicated Web client, siebel.exe must be started on the same 
machine where the Siebel Remote Server and the report files reside.
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This chapter compares Siebel Replication Manager with Siebel Remote and 
discusses the benefits. Also included are the architecture, routing groups, routing 
rules, and components of Replication Manager. The final section covers items 
supported on regional servers.
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Siebel Replication Manager
Siebel Replication Manager replicates structured and unstructured data between 
parent enterprise servers and subordinate enterprise servers called Regional Nodes. 
Each regional node is a separate Enterprise Server with a Siebel Database, Siebel 
Servers, and Siebel File System for a set of connected and mobile users. The set of 
users is based on the set of registered users at the regional node.

Each regional node is created as a child of a parent node. A parent node is another 
enterprise server that is either the Headquarters Node (the master node) or another 
regional node. A regional node contains either a full replica or a subset of the parent 
data, consisting of both database records and file attachments. Siebel Replication 
Agent periodically synchronizes each regional node with its parent node to keep the 
data current at both locations.

Typically, a regional node is geographically separated from the Headquarters Node, 
but this is not a necessary condition.

This chapter discusses how Siebel Replication Manager works. The next three 
chapters explain how to install, configure, and administer Siebel Replication 
Manager and describe how to upgrade Regional Databases.

Comparison with Siebel Remote
Siebel Replication Manager is based on the same architecture as Siebel Remote. It 
is very similar to Remote but is different in the following ways:

■ Siebel Remote supports data synchronization with mobile Web clients. Remote 
provides each mobile user with a laptop-based extension of the Siebel database 
and File System. Mobile users can access local data while they are disconnected 
from the parent Siebel database and File System, and must periodically 
synchronize their local data with the parent database.

■ Siebel Replication Manager supports server-based data replication within a 
hierarchical set of enterprise servers. Each replicated node in a Siebel Replication 
Manager deployment supports multiple users. Replication Manager 
synchronizes data between the parent node and its subordinated nodes. Each 
subordinate node is an enterprise server containing a subset of users from its 
parent enterprise server.
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Benefits of Siebel Replication Manager
Replication Manager solves the performance issue caused by the network 
bandwidth limitations and latency. Placing data closer to a cluster of connected 
users than the Headquarters Node can improve response time. This also allows 
users continuous access to Siebel applications even if the network link to the 
Headquarters Node is unreliable or only intermittently available.

Similarly, the ability of Siebel Remote mobile users to synchronize against a local 
Regional Node can decrease network costs and improve the performance and 
reliability of the synchronization process.

Siebel Replication Manager Architecture
Replication Manager is a data replication technology that replicates data throughout 
a network of Siebel enterprise nodes. Replication Manager uses a hierarchical model 
to replicate data, starting with the master parent node, known as the Headquarters 
(HQ) node. The HQ node can replicate data to multiple subordinate nodes, known 
as Regional nodes. These nodes, in turn, can have subordinate nodes as well.

A Replication Manager implementation has a single master parent node, known as 
the Headquarters Node, and one or more Regional Nodes. The Headquarters Node 
contains the master set of data used by the Regional Nodes. A Regional Node can 
be:

■ Subordinate to the Headquarters Node, and synchronize directly against it.

■ Subordinate to another Regional Node, and synchronize directly against this 
regional node. When some Regional Nodes are created as children of other 
Regional Nodes, this is called a hierarchy of Regional Nodes.
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Figure 9 shows a sample Siebel Replication Manager configuration, with two 
Regional Nodes that are children of the parent Headquarters Node.

The Headquarters Node comprises the master Siebel Database Server, Siebel File 
System, and one or more Siebel Servers. The master Database Server and File 
System contain the entire set of database records and file attachments used by the 
nodes. Siebel Servers at the Headquarters Node manage replication to:

■ Regional Nodes that are children of the Headquarters Node

Figure 9. Example of a Siebel Replication Manager Configuration
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■ Siebel Remote mobile Web clients whose users synchronize against the 
Headquarters Node

A Regional Node can support both connected users and Siebel Remote mobile Web 
clients whose users synchronize against the Regional Server.

Routing Groups and Routing Rules
Each Regional Node contains either a full replica of the parent node’s Database 
Server and File System or a subset of that data. You choose which of these to use 
by associating a routing group with the regional database. Do this when you register 
the Regional Node in the Siebel Remote Administration view. This will determine 
how much of the data from the parent node will be replicated to the Regional 
Database. See “Registering a Regional Node” on page 216 for more detail about 
registering a regional node. 

Routing group options include:

■ Regional Server – Full Copy. When the regional database is assigned this routing 
group, all user data is replicated. The regional database is considered a full copy, 
or full replica, of the parent database. However, the full replica should not be 
used as a backup system for the headquarters node for the following reasons: 

■ Some system-related data may not be replicated.

■ A regional node may require re-extraction if the parent node cannot be 
restored properly.

■ Not every user is replicated.

■ A regional node cannot be converted to an HQ node.

CAUTION: If the Headquarters Node crashes, the full replica cannot be used as a 
new Headquarters Node for the reasons described above.

■ Regional Server – Standard. When the regional database is assigned this routing 
group, the data replicated to the regional database is the union of data visible to 
connected users assigned to the Regional Node. Siebel Replication Manager 
applies standard routing rules to determine what data at the parent node is 
replicated to the Regional Node. 
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There are trade-offs between these two routing groups. Table 20 describes the 
pluses and minuses of each group. 

Also, consider the following guideline when using the Standard Regional Routing 
Group: if you will route more than half of the data on the parent node to the regional 
node, it may be more beneficial to use the Full Copy Routing Group rather than the 
Standard Regional Routing Group for optimal performance. 

Routing rules determine the subset of Dock Object instances that Siebel Remote 
replicates to each mobile Web client. Dock objects are groupings of tables in the 
database that logically form Siebel business components. Dock objects are similar 
to business components. 

Table 20. Trade-Offs Between Regional dB Routing Groups

Routing Group Regional dB Pluses Minuses

Regional Server – Full Copy Fast data routing - no routing 
rule is used.

More data stored at Regional 
node.

Full access to every user’s 
data.

More network traffic.

Requires more powerful 
hardware.

Regional Server – Standard Only necessary data is 
routed.

Txn Routers have to 
determine what should be 
routed, therefore more 
processing time.

Less data stored at Regional 
node, therefore requires less 
resources.

Less network traffic.
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Siebel applications provide pre-configured user routing rules. See “Dock Objects 
and Routing” on page 34 for more information.

Routing groups cannot be modified.

NOTE: If a dedicated user is assigned to multiple databases (one Regional or 
Headquarters database, and one Siebel Remote database), the data visible to that 
user is synchronized to each of those databases. However, a mobile user is assigned 
to only one database—HQ or Regional.

Components of Siebel Replication Manager
This section lists the various pieces of software involved in setting up Regional 
Databases and in the normal operations of a Siebel Replication Manager 
implementation. For details on the listed components or utilities, see “Starting and 
Stopping Siebel Remote Server Components” on page 142.

Applicable components and utilities for the relevant Headquarters Node, Regional 
Node, and mobile Web client are listed below for each of two cases:

■ Regional Node without mobile Web clients or child Regional Nodes

■ Regional Node with mobile Web clients or child Regional Nodes

Without Mobile Web Clients or Child Regional Nodes
For a Regional Node that has no mobile Web clients or child Regional Nodes, the 
following components and utilities are involved:

■ On the Headquarters Server’s Siebel Server, with references for descriptions:

■ Transaction Processor. See “Transaction Processor” on page 68.

■ Transaction Router. See “Transaction Router” on page 71.

■ Transaction Merger. See “Transaction Merger” on page 73.

■ Synchronization Manager. See “Synchronization Manager” on page 74.

■ Database Extract (dbxtract). See “Database Extract” on page 33.
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■ Generate New Database (gennewdb). See “Running the Generate New Database 
Component” on page 80.

■ Parallel Database extract (pdbxtract). A version of the database extract 
component that invokes extractions in parallel. It is designed as an 
interactive component, using server infrastructure features to perform the 
tasks of data extractions in parallel for a large regional node. For more 
information, see “Extracting the Regional Database” on page 219. 

■ On the Regional Server’s Siebel Server:

■ Regional Database Initialization (srvrinit). Utility that loads dbxtract onto the 
Regional server.

■ Replication Agent (repagent). Server component that replicates the database to 
a Regional Node, according to the assigned Routing Group.

With Mobile Web Clients or Child Regional Nodes
For a Regional Node that has either mobile Web clients or child Regional Nodes, or 
both, the following components and utilities are involved:

■ On the Headquarters Server’s Siebel Server:

■ Transaction Processor

■ Transaction Router

■ Transaction Merger

■ Synchronization Manager

■ Database Extract (dbxtract)

■ Parallel Database Extract (pdbxtract)

■ Generate New Database (gennewdb)

■ On the Regional Server’s Siebel Server:

■ Regional Database Initialization (srvrinit)

■ Replication Agent (repagent)

■ Transaction Processor
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■ Transaction Router

■ Transaction Merger

■ Synchronization Manager

■ Database Extract (dbxtract)

■ Parallel Database Extract (pdbxtract)

■ Generate New Database (gennewdb) 
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 201



Siebel Replication Manager Concepts

Components Supported on a Regional Node
Components Supported on a Regional Node
Most Siebel Server processes should be run only on the Headquarters Server. 
Although it is possible to perform certain tasks from any Regional Server, doing so 
causes a delay before the data is replicated to the Headquarters Database and down 
to other Regional Databases. Thus data conflicts can occur. 

You should only perform administration tasks (such as setting up and deactivating 
mobile Web clients using the Replication Server Administration view) when you are 
connected to the Headquarters Server. When using the Replication Server 
Administration view, be careful not to delete the Headquarters Server. Doing so will 
cause the processes to abort. You will then need to restore a backup or run SQL to 
rebuild the Headquarters Server record and the mobile Web clients.

CAUTION: Do not delete the Headquarters Server under any circumstances.

Although most Siebel Server processes should be run only on the Headquarters 
Server, certain features and server components can be used on Regional Nodes. 
Table 21 lists the features and server components that are supported on Regional 
Nodes, along with information about certain specific exceptions.

Table 21. Features and Server Components Supported on Regional Nodes

Item Type Member of Notes

Advanced Search feature

Basic Siebel Call 
Center functionality

feature Associated with Call 
Center Object 
Manager server 
component.

Includes Quotes, 
Opportunities, 
Forecasting, Service 
Requests, 
Households, 
Campaigns, and 
SmartScripts.
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Business Integration 
Batch Manager 

server component Enterprise 
Application 
Integration (EAI) 
component group

The only component 
in the EAI group 
that is not supported 
on Regional Nodes 
is Enterprise 
Integration 
Manager.

Business Integration 
Manager 

server component Enterprise 
Application 
Integration (EAI) 
component group

Call Center Object 
Manager 

server component Siebel Call Center 
component group

Charting feature

Communications 
Configuration 
Manager 

server component Communications 
Management 
component group

Used by Computer 
Telephony 
Integration (CTI) 
feature.

Communications 
Outbound Manager 

server component Communications 
Management 
component group

Communications 
Session Manager 

server component Communications 
Management 
component group

Used by Computer 
Telephony 
Integration (CTI) 
feature.

Table 21. Features and Server Components Supported on Regional Nodes

Item Type Member of Notes
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CTI (Computer 
Telephony 
Integration)

feature Associated with 
Communications 
Configuration 
Manager and 
Communications 
Session Manager 
server components.

Live call transfer 
from a user on one 
Regional Node to a 
user on another 
Regional Node is not 
supported.

Database Extract server component Siebel Remote 
component group

All components in 
the Siebel Remote 
component group 
are supported.

Document Server server component Siebel eDocuments 
component group

For Correspondence, 
Proposals and 
Presentations 
features.

EAI Object Manager server component Enterprise 
Application 
Integration (EAI) 
component group

eService Object 
Manager 

server component Siebel Call Center 
component group

Generate New 
Database 

server component Siebel Remote 
component group

MQSeries AMI 
Receiver 

server component Enterprise 
Application 
Integration (EAI) 
component group

Table 21. Features and Server Components Supported on Regional Nodes

Item Type Member of Notes
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MQSeries Server 
Receiver 

server component Enterprise 
Application 
Integration (EAI) 
component group

MSMQ Receiver server component Enterprise 
Application 
Integration (EAI) 
component group

Outbound 
Communications

feature Associated with 
Communications 
Outbound Manager 
server component.

Parallel Database 
Extract 

server component Siebel Remote 
component group

Replication Agent server component Siebel Remote 
component group

Report Server feature Can be used to 
generate reports on 
the Regional Node.

Runtime Events feature Runtime Events that 
contain wait states 
are not supported on 
Regional Nodes.

Basic Siebel Sales 
functionality

feature Associated with 
Sales Object 
Manager server 
component.

Includes Quotes, 
Opportunities, 
Forecasting, Service 
Requests, 
Households, 
Campaigns, and 
SmartScripts

Sales Object 
Manager 

server component Siebel Sales

Table 21. Features and Server Components Supported on Regional Nodes

Item Type Member of Notes
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Field Service Object 
Manager 

server component Field Service 
component group

State Model feature

Synchronization 
Manager 

server component Siebel Remote 
component group

Transaction Merger server component Siebel Remote 
component group

Transaction 
Processor 

server component Siebel Remote 
component group

Transaction Router server component Siebel Remote 
component group

Workflow Process 
Batch Manager 

server component Workflow 
Management 
component group

Table 21. Features and Server Components Supported on Regional Nodes

Item Type Member of Notes
206 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Siebel Replication Manager Concepts

Components Supported on a Regional Node
Workflow Processes feature Associated with 
Workflow Process 
Batch Manager and 
Workflow Process 
Manager 
components.

The following kinds 
of Workflow 
Processes are not 
supported on 
Regional Nodes:

■ Processes that 
are defined as 
persistent by an 
administrator.

■ Processes that 
contain wait 
states with 
durations 
expressed in 
minutes, hours, 
or days.

■ Processes that 
are triggered by 
Workflow 
Policies.

Workflow Policies 
and persistent 
workflows are not 
supported in a 
replicated 
environment.

Workflow Process 
Manager 

server component Workflow 
Management 
component group

Table 21. Features and Server Components Supported on Regional Nodes

Item Type Member of Notes
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Implementing Siebel Replication Manager 8
This chapter describes the instructions and procedures for implementing Siebel 
Replication Manager. Before you proceed with the implementation, you must 
completely install and test the Siebel Database Server, Siebel Server or Servers, and 
Siebel File System in the Headquarters Node. 

For instructions on completing these tasks, see the Siebel Server installation guide 
for the operating system you are using. 

As an overview, to implement each Regional Node you must implement four main 
phases: 

■ Install a new Enterprise Server

■ Define the Regional Node

■ Extract the Regional Database

■ Initialize the Regional Database

Table 22 shows the tasks for Implementing Replication Manager.

Table 22. Tasks for Implementing Siebel Replication Manager

Task Where Performed

Installing a New Enterprise Server on page 211 New Server

Installing the Siebel Name Server on page 212 New Server

Installing the Siebel Server on page 212 New Server

Installing the Siebel Database Server on page 213 New Server

Installing the Siebel File System on page 214 New Regional File Server

Defining the Regional Node on page 215 Parent Node
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Registering a Regional Node on page 216 Parent Node

Adding Mobile Users to the Regional Database on page 218 Parent Node

Extracting the Regional Database on page 219 Parent Server

Initializing the Regional Database on page 224 New Server

Configuring Regional Node for Mobile Web Clients on 
page 231

New Server

Starting Replication Agent on page 232 Regional Node

Setting Up Additional Application Servers on Regional 
Nodes on page 234

New Server

Table 22. Tasks for Implementing Siebel Replication Manager

Task Where Performed
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Installing a New Enterprise Server
Installation of the Regional Node essentially requires setting up a new Enterprise 
Server with a different name from that of the HQ Enterprise. This includes the 
following Siebel components:

■ Siebel Name Server

■ Siebel Database Server

■ Siebel Server

■ Siebel File System

For more information on installing these components, see the Siebel Server 
installation guide for your operating system. 

NOTE: Setting up the Siebel Database Server on the Regional Node is very different 
from setting it up on the HQ Server.
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 211



Implementing Siebel Replication Manager

Installing a New Enterprise Server
Installing the Siebel Name Server
The Siebel Name Server includes a persistent store for configuration parameters and 
run-time information. The Name Server is part of the logical entity called Siebel 
Gateway. Each Siebel Server accesses the Name Server at start-up and periodically 
throughout its operation. Consequently, there must be a reliable network 
connection to the Name Server. For this reason, it is strongly recommended that you 
install a Name Server local to your Regional Node. For more information about 
installing the Siebel Name Server, see the Siebel Server installation guide for the 
operating system you are using. 

This server must be installed and running before you can proceed with the 
remainder of the Regional Node installation. For more information on the Siebel 
Name Server and Siebel Server, see Siebel Server Administration Guide.

Installing the Siebel Server
Each Regional Node must have at least one Siebel server, which is used to 
synchronize the Regional Node with its parent. This Siebel Server may also support 
Siebel Remote mobile users. Depending on the number of users and applications to 
be supported, additional Siebel Servers may be required.

Before you install the Regional Siebel Server, you may first need to install the correct 
ODBC driver for the RDBMS vendor. For an Oracle RDBMS, you do not need to 
install an ODBC driver. For other supported RDBMS vendors, you must install an 
ODBC driver. For the name of the required ODBC driver and version information, 
see the system requirements and supported platforms documentation for your 
Siebel application. System requirements and supported platforms documentation 
for all Siebel applications can be found on Siebel SupportWeb at http://
ebusiness.siebel.com/supportweb/.

For instructions on installing the Siebel Server, see the Siebel Server installation 
guide for the operating system you are using. When prompted by the Siebel Server 
installation program, be certain to specify the correct connectivity information for 
the Siebel Name Server, Siebel File System, and Siebel Database Server on the 
Regional Node. Each Regional Node should have a unique Enterprise Server name 
associated with it.
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Installing the Siebel Database Server
For Regional Nodes that support smaller numbers of mobile or connected users, the 
Regional Database Server may be installed on the same physical server that will 
support the Regional Siebel Server.

NOTE: The Regional database server must be the same version as its parent database 
server. 

Before you initialize the Regional Database, you must install the RDBMS software 
on the Regional Database Server to create an empty database with adequate space 
for data and index storage areas. Do this in accordance with the RDBMS vendor’s 
documentation and the guidelines for configuration and space allocation. For more 
information, see the Siebel Server installation guide for the operating system you 
are using.

You must also create the database accounts for the Siebel Tableowner and Siebel 
Administrator and grant them the necessary privileges. Use the Application RDBMS 
Tool to create these users and to grant their privileges. For example, for an Oracle 
RDBMS, grant these accounts connect, resource, and DBA privileges. For MS SQL, 
the Tableowner needs to have Security Administrator privileges on regional nodes. 
For DB2, the Tableowner needs to have DBA privileges. For more information, see 
the Siebel Server installation guide for the operating system you are using.

NOTE: In order to successfully implement a srvrinit on an Oracle Regional Node, the 
table owner has to have certain privileges. This can be done without granting DBA 
privileges to the table owner. The procedure that follows describes how to enable 
srvrinit to work in Oracle without granting DBA privileges to the table owner. 

To enable srvrinit in Oracle without granting DBA privileges to the table owner

■ Start SQL*Plus and log in as the user system or sys or a DBA user and then 
execute the following command:

grant sse_role, connect, alter user, create user, create 
table,create session to
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<table owner> with admin option

If only sse_role is granted, an error message will be displayed.

After the RDBMS has been installed and configured and you have created the 
accounts for the Siebel tableowner and Siebel administrator, installation of the 
Regional Database Server is complete. The database objects, such as tables and 
indexes, are automatically created when you extract and initialize the database. 
These procedures are described in “Extracting the Regional Database” on page 219 
and “Initializing the Regional Database” on page 224.

NOTE: The Regional Database Initialization utility uses the default storage 
parameters for the data and index tablespaces. Oracle database administrators 
should set storage parameters appropriately before installing the Regional Database. 
For information on setting storage parameters, see the Siebel Server installation 
guide for the operating system you are using. For larger tables, you can modify the 
storage parameters after the tables are created.

Installing the Siebel File System
Each Regional Node requires a local Siebel File System. Attachment files in Siebel 
File Systems are replicated whenever the data rows with which they are associated 
are replicated. For information on creating the Siebel File System, see the Siebel 
Server Installation Guide for the operating system you are using.

The File System Manager (FSM) server component manages the File System and 
handles interplatform security. FSM interacts directly with the Siebel File System to 
invoke requests for access to files. Most server components use FSM to access files 
by submitting requests to Server Request Manager. However, Siebel Remote 
components do not use FSM to access the File System. 
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Defining the Regional Node
Each Regional Node must be defined by registering the Regional Database and 
adding any mobile users for the database. After the Regional Node has been 
defined, you can extract the Regional Database on its parent node and initialize it.

NOTE: After the Regional Node is extracted, you can still continue to add mobile 
Web clients to it.

■ If you are implementing a single tier of Regional Nodes, the Headquarters Node 
is always the parent node.

■ If you are implementing two or more tiers of Regional Nodes (called a hierarchy 
of Regional Nodes), the lower tiers will have Regional Nodes as their parent 
nodes.

NOTE: Setup of parent nodes must be completed before you can define children for 
them.

Before you continue with the process of defining a Regional Node, you must finish 
the setup of your organization and territory structures and run the Assignment 
Manager on the Headquarters Node. If you make changes to the organization and 
territory structures after extracting and initializing the Regional Database, you may 
have to reextract the Regional Database on its parent node and reinitialize it. 
Otherwise, the transaction routers may be overloaded.

If you are implementing a Regional Node whose parent node is another Regional 
Node, you should synchronize the parent node with the Headquarters Node so that 
the parent node has up-to-date data. This reduces the amount of data to replicate 
after you initialize the Regional Node.
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Registering a Regional Node
To register a regional node, use the procedure that follows.

To register a new Regional Node

1 From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

2 From the Show drop-down list, select Replication Servers.

3 In the Parent Server form, select the appropriate node as the parent.

Usually, this is HQ.

The Parent Server form shows the registered databases, whether they are 
Headquarters or Regional.

The Regional Databases list shows regional nodes that are children of a parent 
database currently selected in the Databases list applet. Only the Headquarters 
Database or a Regional Database can be the parent of another database; a Siebel 
Remote mobile database cannot be a parent.

4 In the Regional Databases list, click the menu button and select New Record.

5 In the Database Name field, enter a name for the Regional Database, such as 
SIEBEL_EUROPE.

NOTE: The database name you specify can contain any alphanumeric characters 
(letters must be uppercase only), dashes (-), or underscores ( _ ). The name 
cannot include spaces, a period (.), or any special characters( / \ : * ? “ < > |). 
The name cannot exceed 30 bytes (30 characters in a single-byte character set, 
or 15 characters in a double-byte character set). Three names are reserved and 
unavailable for use: TXNPROC, OUTBOX, and INBOX. The database name must 
be unique within the Headquarters Node and the Regional Nodes and need not 
match an existing database name.

6 In the Description field, type a description of the Regional Database, such as 
“European Regional Database.”

7 Specify the Routing Group to which the Regional Database will belong.
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a In the Routing Group field, click the select button.

b In the Pick Routing Group selection dialog box, select one of the following:

❏ Regional Server – Full Copy

❏ Regional Server – Standard

The Full Copy option replicates all nonsystem data from the parent database 
to the Regional Database. Full Copy disregards routing rules. The Standard 
option uses routing rules to determine what data to replicate to the Regional 
Database. For more information about routing groups and routing rules, see 
“Routing Groups and Routing Rules” on page 197.

8 In the Database Users field, select the Siebel users who will work as connected 
users against the Regional Database.

a In the Users field, click the select button.

b In the Users selection dialog box, click New.

c In the Add Users list, select the appropriate user.

d Click Add.

e Repeat the above steps to add all users to the regional node.

f Click Close.

If the Regional Database will support mobile users, implement the steps in “Adding 
Mobile Users to the Regional Database” on page 218 If the Regional Database will 
support only connected users, skip to “Extracting the Regional Database” on 
page 219.
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Adding Mobile Users to the Regional Database
If this regional database will support Siebel Remote mobile users, continue with the 
following procedure to add the mobile databases for those users. If this regional 
database will support only connected users, skip this section and proceed to 
“Extracting the Regional Database” on page 219.

NOTE: Every mobile user on the regional node must also be a connected user.

To add mobile databases to a Regional Database

1 From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

2 From the Show drop-down list, select Mobile Clients.

3 In the Parent Server list applet, select the Server Name representing the regional 
database where the mobile users will work. 

If this were a follow-on from the example on the previous page, this would be 
the newly created regional database.

4 Follow Step 3 through Step 8 of the procedure, “To register a new mobile Web 
client on a node” on page 94.

5 Repeat Step 4, immediately above, for each mobile user assigned to the Regional 
Database.

NOTE: A mobile user can be assigned to only one Headquarters or Regional 
database. Every mobile user must also be set up as a connected user in the Regional 
Node. Mobile Web clients must be synchronized and then reextracted if they are to 
be reassigned to a different parent database.
218 Siebel Remote and Replication Manager Administration Guide Version 7.5, Rev. A



Implementing Siebel Replication Manager

Extracting the Regional Database
Extracting the Regional Database
Each Regional Database must be extracted on a Siebel Server of its parent node. The 
Regional Database synchronizes against the Siebel Server on which it is extracted. 
Database parallel extracts use multithreaded components to make these tasks faster 
than single-thread operations. Parallel dbxtract requires additional hardware, but 
can reduce the time to do this significantly.

This section describes the two types of dbxtract: single-thread and parallel. Before 
beginning either type of database extraction, you must synchronize the server 
components that are enabled. See Siebel Server Administration Guide for details.

To extract database for Regional server with single thread – GUI

1 From the application-level menu, select View > Site Map > Server 
Administration > Enterprise Operations.

2 Select the Component Requests tab.

3 In the Component Request form, click New. 

4 In the Component/Job field, click the select button.

5 In the Component/Jobs dialog box, select the Database Extract component and 
click OK.

Complete the rest of the fields as appropriate.

6 In the Component Request Parameters list, click New and then in the Name field 
click the select button.

7 In the Job Parameters Selection dialog box, select the following parameters for 
the Name field and enter the corresponding value:

Client Name and enter the name of the regional node in the Value field.

Database Init Method and enter DDL in the Value field.

8 Add any other component parameters for the component request as appropriate.

For a list of parameters you can specify, see Table 23 on page 222.
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9 In the Component Requests form, click the menu button and then Submit 
request.

The Status field changes from Creating to Queued.

To extract database for Regional server with single thread - Srvrmgr command line

■ From the Srvrmgr command line, enter: 

start task for comp dbxtract with client=<regional node name>, 
initmethod=ddl

The parallel dbxtract utility (pdbxtract) is designed to improve performance when 
extracting large databases for one or more Regional Nodes. It is also possible to use 
pdbxtract when extracting Mobile Web Client databases, but pdbxtract may not 
improve performance significantly during Mobile Web Client extractions, so the 
practice is not recommended. You can run pdbxtract as a component request, from 
within a Siebel application, or you can run it as a task from a srvrmgr command 
line. The following two procedures describe these two methods of using pdbxtract. 

NOTE: If you plan to use pdbxtract for concurrent extraction of two or more Regional 
Node databases, be sure to specify all of the applicable Regional Nodes as clients in 
a single pdbxtract component request or srvrmgr command. Due to the design of 
the pdbxtract utility, this produces better performance than starting multiple 
pdbxtract component requests or tasks that attempt to run concurrently. 

To parallel extract database for Regional server – GUI

1 From the application-level menu, select View > Site Map > Server 
Administration > Enterprise Operations.

NOTE: Check the value of the parameter Maximum Number of WorkQ Threads 
from the Server Administration > Components view. The Current Value field is 
the maximum number of worker threads per work queue. This parameter 
determines the parallelism of the process.

2 Select the Component Requests tab.

3 In the Component Requests form, click New.
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4 In the Component/Job field, click the select button.

5 In the Component/Jobs Selection dialog box, select the Parallel Database Extract 
component and click OK.

Complete the rest of the fields as appropriate.

6 In the Component Request Parameters list, click New and then in the Name field 
click the select button.

7 In the Job Parameters Selection dialog box, select the following parameters for 
the Name field and enter the corresponding value:

a Select Client Name for the Name field and enter the name of the regional 
node in the Value field. To specify more than one regional node, create a text 
file and place the name of each regional node on its own line of the file. Enter 
the path and file name in the Value field, preceded by the @ symbol. For 
example, a Windows client might specify @D:\workdir\regnodes.txt. 

b Select Database Init Method for the Name field and enter DDL in the Value 
field.

8 Add any other component parameters for the component request as appropriate.

For a list of parameters you can specify, see Table 23 on page 222.

9 In the Component Requests form, click the menu button and then Submit 
request.

The Status field changes from Creating to Queued.

To parallel extract database for Regional server – Srvrmgr command line

■ From the Srvrmgr command line, enter: 

start task for comp pdbxtract with client=<regional node name>, 
initmethod=ddl

To specify more than one regional node, separate the regional node names with 
commas. For example, if RN1, RN2, and RN3 are the names of three regional 
nodes, the client portion of the command would be entered as follows: 
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client=RN1,RN2,RN3

For information on running a Database Extract, see “Creating Mobile Web Client 
User Accounts and Privileges” on page 121.

Table 23 lists component parameters you can specify for the Database Extract task.

The following example shows a sample portion of the parent node’s server directory 
tree after you run Database Extract tasks for Regional Nodes named 
SIEBEL_EUROPE and SIEBEL_PACIFIC:

SIEBEL
DOCKING

SIEBEL_EUROPE

Table 23. Parameters for Database Extract

Parameter Name Required/Optional Description

CD Directory CDDir Optional The directory on the machine of the 
parent node to which you write the 
extract files.

Client Name Client Required The name of the Regional Database as 
entered when you registered the Regional 
Node. See “Registering a Regional Node” 
on page 216.

Database Init Method InitMethod Required Specify DDL. You must set the Database 
Init Method parameter to DDL. 
Otherwise, the database initialization 
will fail.

Maximum data file size DatFileSize Optional Sets the maximum size of a data file in 
megabytes. Minimum size is 1. 
Maximum size is 1,000. Default is 500.

For Parallel Dbextract recommend 
Minimum size 100 MB.

 Language Code Language Optional Extract messages for the specified 
language. The default is ENU, for U.S. 
English.

Specify the mobile client 
version of Siebel

ClientVersion Optional Specifies the client software version. 
Default is 2000 for v7.x.
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INBOX
OUTBOX

SIEBEL_PACIFIC
INBOX
OUTBOX

After you initialize a Regional Database, the Regional Node’s directory structure will 
include similar folders for any additional Regional Nodes (given a hierarchy of 
Regional Nodes) and for any mobile users.
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Initializing the Regional Database
The Regional Database initialization process retrieves the database extract created 
in the previous step, and loads it into the Regional Database. Database objects are 
created and populated with data.

If you will be reinitializing a regional node with mobile Web clients, it is important 
to conduct the following test. Verify the mobile Web clients that synchronized with 
this node can reinitialize without deleting their local databases.

The Regional Database is initialized from the Siebel Server using the Regional 
Database Initialization utility. This must be done on the Regional Server: 

■ In Windows, the Regional Database Initialization utility is called srvrinit.exe. 
You can run srvrinit.exe in the GUI or the command-line interface.

NOTE: You must set the appropriate environment variables before running 
srvrinit.exe. Set environment variables by running the batch file siebenv.bat, 
located in the siebel_server directory. Run this batch file in the same command 
shell in which you will be running srvrinit.

■ In UNIX, the Regional Database Initialization utility is called srvrinit. You can 
run srvrinit from the command-line interface only.

In both operating systems, the Regional Database Initialization utility is located in 
the bin subdirectory under the Siebel Server root directory. 

In order for srvrinit to finish successfully, you need to make sure that sufficient 
transaction space (Rollback Segment) is available on the Regional Server Database. 
You may want to verify with your DBA and to increase or alter existing rollback 
segments if necessary. 

You must also make sure that the combination of database user ID and password 
that you will use to run srvrinit exists on both the HQ Server and the Regional Node. 
Srvrinit only allows you to specify one set of credentials, but srvrinit is required to 
use those credentials for both machines. If credentials on the two machines are 
different, the process may not start, or may fail before completion. 

If the Applications Server has multiple CPUs and disk arrays, running srvrinit in 
parallel can dramatically improve performance.
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It is possible to reduce the size of the rollback segment required for srvrinit by 
reducing the dbxtract parameter Maximum data file size (DatFileSize). This is 
because the srvrinit task commits per file. Therefore the smaller the file, the smaller 
the rollback segment. See “Database Extract Parameters” on page 130 for details 
about DatFileSize. 

To initialize the Regional Database in the GUI

1 In the same window where you ran siebenv.bat, navigate to <server install on 
the regional node>\bin and enter srvrinit.exe. 

The Regional Database Initialization dialog box appears.

2 In the Siebel Remote Parameters fields, specify the correct values for each of the 
parameters used by the Regional Siebel Server to connect to the parent node. For 
a description of these parameters, see Table 24 on page 227.

3 In the Regional Database Parameters fields, specify the correct values for each 
of the parameters used by the Regional Siebel Server to connect to the Regional 
Database. For a description of these parameters, see Table 24 on page 227.

4 To start the initialization process, click Start Initialization.

The database extract will be downloaded from the server. The Siebel Upgrade 
Wizard launches automatically and completes the steps required to initialize the 
Regional Database. If you do not see a dialog box on the screen as the process 
executes, usually this indicates something is wrong. If this happens, check the 
log file in the log directory.

There will be two log files. The first one is srvrinit.log. The second one is either 
upgwiz.log on Windows or srvrupgwiz1.log on UNIX.

After the initialization utility completes successfully, setup of the Regional Database 
is complete. For instructions on administering the Regional Database, see Chapter 9, 
“Administering Siebel Replication Manager.”

The Regional Database Initialization utility (srvrinit) has two functions:

■ It connects to the parent remote server and downloads the database extract for 
the regional node. 

■ It starts the Siebel Upgrade Wizard to carry out the actual database initialization. 
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To initialize the Regional Database from the command line interface

■ Change to the bin subdirectory under the Siebel server root directory and enter:

srvrinit flags

For a list of flags, see Table 24 on page 227.

NOTE: If the Regional Database initialization fails (for example, due to insufficient 
storage space on the database), you must recover from the failure before restarting 
Replication Manager. To do this, restart the Regional Database Initialization utility.

The built-in state logging ability of the Siebel Upgrade Wizard provides the ability 
to restart the Siebel Upgrade Wizard. If you encounter an error during the second 
phase (Siebel Upgrade Wizard) of the regional database initialization process, 
examine the log file (UpgWiz.log on NT and srvrupgwiz.log on Unix) and take 
appropriate corrective actions. 

NOTE: The following error messages can be ignored: ORA-01921: role name 
'SSE_ROLE' conflicts with another user or role name, ORA-01017: invalid username/
password; logon denied, and ORA-00942:table or view does not exist.

After applying the proper fix, simply restart the regional initialization process by 
running Siebel Upgrade Wizard again. The Siebel Upgrade Wizard remembers the 
progress of the initialization process and begins from where it left off. The 
executable name is siebupg1.exe on NT and srvrupgwiz1 on UNIX.

However, there may be occasions when you simply want to restart the Regional 
Database Initialization process from scratch. To do so, follow the procedure below.

To restart Regional database initialization process from scratch – NT

1 On the Regional Node, navigate to $SiebelRoot/bin.

2 Run the Siebel Upgrade Wizard (type the command or double-click 
siebupg1.exe).

3 Click Cancel when you are prompted to choose Yes to retry, No to abort, or 
Cancel to abort and clean up.
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4 Rerun the initialization process.

To restart Regional database initialization process from scratch – UNIX

1 On the Regional Node, navigate to $SiebelRoot/bin.

2 Find the file upgwiz.ucf and delete it.

3 Navigate to $SiebelRoot/upgrade and delete all files with the name state.log 
under it.

4 Rerun the initialization process.

Table 24 on page 227 lists selected parameters and corresponding flags for the 
srvrinit command-line utility.

Table 24. Parameters and Command-Line Flags for srvrinit Utility

Parameter Command Line Flag Description Required?

16K Table Space /ks For DB2/UDB installations only, the 
name of the appropriate 16K Table 
space should be provided. For more 
information, see the Siebel Server 
installation guide for the operating 
system you are using.

No

32 K Table Space /ls For DB2 installations only, the name 
of the appropriate 32K Table space 
should be provided. For more 
information, see the Siebel Server 
installation guide for the operating 
system you are using.

No 

N/A /comm Communication parameters for 
modem connection.

No

Parent AppServer Name /dockconnstring Name of the Siebel server at the 
parent node where the database 
extract was performed.

Yes

Regional Server Name /n Name of the Regional Node. Yes

File System /filesystem File system directory on the regional 
node.

Yes
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Help /?
/help

Help on usage. No

Index Space /is For DB2/UDB installations only. 
Space on the Regional Database 
where indexes should be created.

No

Initialize on new database  /init Indicates whether the regional 
database is empty or not. Use Y if this 
is the initialization of the regional 
server on new database, N if it is an 
upgrade of the existing regional 
database with new dbxtract. Default 
value is N.

Parameter should be set to Y during a 
major upgrade—old transactions can 
be invalid for the new schema and 
cause failure.

No

N/A /l Language code, default is enu. No

ODBC Data Source /d Name of ODBC data source to 
connect to the Regional Node.

Yes

User Password /p Password to authenticate the 
Regional Database against the 
Headquarters Server. The password 
you specify will be used when the 
users are set up on the Regional 
Database.

Yes

Repository Name /reposname Name of repository, usually “Siebel 
Repository.”

Yes

Run in Parallel/Number of Threads /para Indicates srvrinit will run in parallel 
and the number of threads.

No

Schema Qualifier /sq For DB2/390 and AS/400 
environments only, the name used to 
qualify all database objects created 
that are required by Siebel. 

Yes

Table 24. Parameters and Command-Line Flags for srvrinit Utility

Parameter Command Line Flag Description Required?
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Server Root Directory /homedir Server root directory, on the Regional 
node where SIEBEL_SERVER_ROOT is 
the root directory of the regional Siebel 
Server installation.

Yes

Table Grouping File /tg For DB2/390 installations only. Full 
path to the storage control file, which 
is a file that contains database object 
declarations.

Yes

Table Owner Password/Privileged 
User Password

/tp Tableowner’s password on the 
Regional Database.

For DB2/390 and AS/400 
environments, this is the same as the 
Privileged User Password. This is the 
password for Privileged User ID.

Yes

Table Owner/Privileged User ID /t Tableowner’s logon on the Regional 
Database. Must have privileges to 
create database objects.

For DB2/390 and AS/400 
environments, this is the same as the 
Privileged User ID. This is a user 
account that has the necessary 
database authority and privileges to 
create, access, and modify Siebel 
database objects as well as native 
database objects and operations 
required to implement the Siebel 
application. These environments 
have rigid controls on user 
identification—accounts must 
correspond to a real person.

Yes

Table Space /ts For DB2/UDB installations only. 
Space on the Regional Database 
where tables should be created.

No

Table 24. Parameters and Command-Line Flags for srvrinit Utility

Parameter Command Line Flag Description Required?
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After completion of initialization, enable the required server components such as 
Siebel Remote and the appropriate object managers. For information regarding how 
to do this for Remote Server components, see “Starting and Stopping Siebel Remote 
Server Components” on page 142. For information regarding how to do this for 
object managers and other components, see Siebel Server Administration Guide.

Also, administrators need to install the Siebel Web Server Extension (SWSE). For 
information regarding how to do this, see the Siebel Server installation guide for the 
operating system you are using. This is essential for administrators to use the Web 
client to support users on Regional Nodes. 

The SWSE is not required if administrators use the dedicated Web client connected 
to support users on Regional Nodes.

NOTE: Administrators must create users (database accounts or others) for all users 
who will be accessing the Regional Node because srvrinit will no longer create user 
accounts.

User Name /u User name to authenticate the 
Regional Database against the 
Headquarters Server. You can use any 
database user associated with the 
Regional Database during the setup, 
but the user must have security 
admin privileges in order to create 
logins within the master database 
(such as sadmin).

Yes

N/A /v Verbose mode, may be set to Y or N. 
Default is N.

No

Table 24. Parameters and Command-Line Flags for srvrinit Utility

Parameter Command Line Flag Description Required?
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Configuring Regional Node for Mobile Web Clients
If your Regional Server has mobile Web clients, you must start and configure Siebel 
Remote Server components on the Regional Server. Perform these steps in the Siebel 
Server Manager.

To configure Regional Node to support mobile Web clients

1 Use the Generate New Database component to generate database templates on 
the Regional Server.

For information on generating a new database template, see “Generating a New 
Database Template” on page 79.

2 Run Database Extract to extract mobile Web clients.

For information on running a Database Extract, see “Creating Mobile Web Client 
User Accounts and Privileges” on page 121.

3 Start the Transaction Processor, Transaction Merger, and Transaction Router 
components.

For more information, see “Starting and Stopping Siebel Remote Server 
Components” on page 142.
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Starting Replication Agent
In Siebel 7.5, Replication Agent starts 0 tasks (default setting) when Siebel Server 
starts. If you want to start Replication Agent tasks automatically when Siebel Server 
starts, see Siebel Server Administration Guide for information on how to change the 
Default Processes parameter to 1.

The procedures below describe how to start Replication Agent while Siebel Server 
is running.

To start Replication Agent – GUI

1 If the default task is 0, reconfigure the Replication Agent component using the 
Component Reconfiguration steps.

a Before reconfiguring server components, verify that any external resources 
remain available that will be accessed by current tasks running on the 
existing component configuration. Also verify that any external resources are 
available that will be defined in the new component configuration.

Examples of external resources include the SRF and CFG files that are 
defined in the component configuration.

b Navigate to the Enterprise Configuration screen.

c Click the Component Definitions view tab.

d In the upper Component Definitions list, select the component definition you 
want to reconfigure.

e Click the menu button and then click Start Reconfiguration.

The Definition State field changes to Reconfiguring.

f In the lower Component Definitions list, change the Value field of parameters 
that you want to reconfigure for the component—in this case, change the 
value of the Default Task to 1.

You can also change the values of fixed parameters, but you cannot change 
whether parameters are fixed.
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g After parameter values have been reconfigured, commit the new 
configuration by clicking the menu button and clicking Commit 
Reconfiguration.

The new parameter values will be merged at the enterprise level. To cancel 
the reconfiguration before it has been committed, click the menu button and 
then Cancel Reconfiguration.

2 If the default task is 1, then navigate to Site Map > Server Administration > 
Servers > Server Components.

3 Start Replication Agent.

For more information about this topic, see Siebel Server Administration Guide. 

To start Replication Agent – srvrmgr command line

■ From the srvrmgr command line, enter: 

start task for comp repagent with HQ=<DockConnString>, 
sleeptime=<#sec>, 

Sleeptime is set to 60 sec by default, so it is not necessary to use.
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Setting Up Additional Application Servers on Regional 
Nodes

This section describes the procedures to add Application Servers on the Regional 
node. The first procedure will add an additional Applications Server. Srvrinit can 
only be invoked once and only one App Server receives the dictionary files. These 
files are placed in the App Server bin directory. The second App Server is not 
functional because it does not have a dictionary datafile. The regional server does 
not have repository rows, so the dictionary information is retrieved from this data 
file. 

To install additional Application Servers on the Regional node

■ For the necessary steps to do this, see the Siebel Server installation guide for the 
operating system you are using. 

As stated above, the additional server requires a copy of the dictionary file to 
become operational. There are several options to copy a dictionary file from one 
App Server another on a Regional node.

To copy the data file to a new Applications Server bin directory from another

■ Copy the necessary dicdata.dat from the initial Application server where srvrinit 
was run.

NOTE: The dictionary data files are character-set-specific, so you need codepage 
dictionary caches. 
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This chapter describes registering users on the regional node in addition to 
managing synchronization and server processes. It also includes a discussion about 
backup and recovery of data.

To administer Siebel Replication Manager you must implement four main phases: 

■ Registering Users on a Regional Node

■ Managing synchronization

■ Managing server processes

■ Performing backup and recovery of data

Administering the four phases of Siebel Replication Manager consists of the 
following tasks, shown in Table 25.

Table 25. Tasks for Administering Siebel Replication Manager

Task Where Performed

Managing Mobile Databases on a Regional Node on page 236 HQ Node

Adding Connected Users to a Regional Node on page 237 HQ Node

Managing Synchronization on page 238 Regional Node

Changing the Routing Group for a Regional Server on page 242 HQ Node

Monitoring Regional Application Servers on page 244 Regional Node

Managing Security and Authentication on page 244 Regional Node

Performing Backup and Recovery of Data on page 245 Regional Node

Managing Backlog in the Transaction Log Table on page 246 HQ Node

Deactivating and Reactivating a Regional Node on page 247 Parent Node
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Managing Mobile Databases on a Regional Node
If you need to add mobile Web clients on the regional database where they work, 
use the following procedure. 

To add mobile databases to a Regional Database

■ See “Adding Mobile Users to the Regional Database” on page 218.

If you need to delete mobile Web clients on the regional database where they work, 
use the following procedure. 

NOTE: Mobile users should be deactivated before deleting them. For more 
information about ending mobile users, see “Deactivating and Reactivating a 
Mobile Web Client” on page 164.

To delete mobile databases from a Regional Database

1 From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

2 From the Show drop-down list, select Mobile Clients.

3 In the Parent Server list, select the Server Name representing the regional 
database where the mobile Web client works. 

4 In the Mobile Clients list, select the record representing the database used by a 
mobile Web client that you want to delete from the Regional Database.

5 Click the menu button and then Delete Record.

6 In the dialog box, confirm that you want to, or do not want to, delete this record.

Repeat Step 4 through Step 6 for each mobile Web client you want to delete from 
the Regional Database.
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Adding Connected Users to a Regional Node
This section describes how to add users to the Regional Node. Before adding users 
to a Regional Node they must be added to the Parent Node. See Applications 
Administration Guide for adding users to the system. 

To add connected users to a Regional node

1 Make sure the user is a connected user at the HQ node.

2 From the application-level menu, select View > Site Map > Siebel Remote 
Administration.

3 From the Show drop-down list, select Replication Servers.

4 On the Parent Server form, select the parent server of the appropriate regional 
node.

This may be HQ or a regional node that is also a parent node.

5 In the Regional Databases list, select the Regional Database you desire. 

6 On the Users field, click the select button.

7 In the Database Users Selection Dialog box, click New and select the user you 
want, and then click Add.

8 Repeat Step 7 until you have added all necessary users, then click OK.

9 Create user access accounts on the regional node (db accounts or other external 
Directory Services such as LDAP). For more information about this topic, see 
Security Guide for Siebel eBusiness Applications.

Wait for a few hours (depending on your network and hardware configurations) 
to make sure that all new user data is replicated to the regional node.
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Managing Synchronization
The Siebel Server component Replication Agent, which operates on the Regional 
Siebel Server, synchronizes the Regional Database with its parent database.

Replication Agent must be started in order to synchronize the Regional Database. 
You can control Replication Agent with either the GUI or the command-line version 
of the Siebel Server Manager. 

To start Replication Agent – srvrmgr command line

■ From the srvrmgr command line, enter: 

start task for comp repagent with <parameter1>= <value1>, 
<parameter2=<value2>,...

Values are from “Parameters for Replication Agent” on page 239.

To stop Replication Agent - srvrmgr command line

■ From the srvrmgr command line, enter: 

stop task for comp repagent

To start Replication Agent – GUI

■ In Siebel 7.5, the Replication Agent cannot be started manually through the GUI 
Server Manager unless the Siebel Server is up and running. The component has 
been defined to start one task when the Siebel Server is started if the component 
is enabled. If the component is not started, navigate to Site Map > Server 
Administration > Servers> Server Components tab, and start the component. 
A new task should start.

Resolving Synchronization Conflicts 
There are times when Replication Manager will encounter data conflicts or 
corrupted transactions. Resolution rules may help to resolve these.

For further information on conflict resolution rules, refer to “Conflict Detection and 
Resolution” on page 52. There is currently no log file available.
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Replication Agent Parameters
Table 26 lists the parameters for Replication Agent. Replication Agent can also use 
generic parameters described in Siebel Server Administration Guide. Also, refer to 
the same guide for more information about managing server components with 
Siebel Server Manager

Table 26. Parameters for Replication Agent

Parameter Meaning
Required/
Optional Default Value and Usage Notes

HQ The Dock Connect String of the parent 
Siebel Server.

Required The format is the Dock Connect 
String.

The format is network_protocol:
sync_port:service:encryption

Available choices are:

Protocol: TCPIP
Sync Port: 40400, Any
Service: SMI
Encryption: None, MSCRYPTO, 
RSA

Default for Sync Port: 40400

Default for Encryption: None

An example may be: 
SIEBAPP1:TCPIP:40400

Comm Param The colon-separated list of 
communications parameters used to 
connect to the parent Siebel Server.

Optional This parameter is not used.

SleepTime The period (in seconds) for which 
Replication Agent should sleep between 
synchronization sessions.

Optional Default: 60
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MaxWrite Used to limit the size of a DX file—that 
is, to break DX files to be sent to the 
parent Siebel Server into smaller, more 
manageable pieces. 

Replication Manager closes the existing 
DX file and starts writing to a new DX 
file when the current DX file reaches the 
maximum number of operations 
specified with this parameter.

Optional Default: 10000

SendTxns Sends DX files from the Regional Server 
to the parent Siebel Server.

If this parameter is set to FALSE, 
Replication Manager does not send DX 
files from the Regional Server to the 
parent Siebel Server.

Optional Default: TRUE

RecvTxns Receives DX files sent by the parent 
Siebel Server to the Regional Server.

If this parameter is set to FALSE, 
Replication Manager does not receive 
DX files sent by the parent Siebel Server 
to the Regional Server.

Optional Default: TRUE

RecvFiles Receives file attachments sent by the 
parent Siebel Server to the Regional 
Server.

If this parameter is set to FALSE, 
Replication Manager does not receive 
file attachments sent by the parent 
Siebel Server to the Regional Server.

Optional Default: TRUE

Table 26. Parameters for Replication Agent

Parameter Meaning
Required/
Optional Default Value and Usage Notes
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The Replication Agent runs as a service-mode task, which means that after it is 
started, it runs continuously.

Iterations Specifies the number of times that 
Replication Agent will connect to the 
parent node.

Typically, this parameter is set to zero 
(0), and the Replication Agent loops 
forever (or until stopped by the server 
administrator).

If you set this parameter to 1 and start 
Replication Agent, this causes a single 
synchronization to occur.

Optional Default: 0

MaxCommitTxns Specifies how many transactions will be 
applied before they are committed to 
the database.

Optional Default: 100

Table 26. Parameters for Replication Agent

Parameter Meaning
Required/
Optional Default Value and Usage Notes
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Changing the Routing Group for a Regional Server
Each regional server has a routing group associated with it. The group determines 
the data that will be extracted to and transactions that will be synchronized with 
the regional server.

There may be times when you need to change the routing group for a regional 
server. The procedure below describes how to do this.

CAUTION: Changing the routing group from “Standard” to “Full Copy” requires a 
reextract of the regional database. Also any mobile Web clients associated with the 
Regional Node require a reextract as well. 

To change the routing group for a regional server 

1 If the Regional Node has mobile Web clients, synchronize these with the 
Regional Node.

2 Send updates in the regional node to the HQ or parent node.

3 Stop the activities on the regional node.

This means no more updating.

4 From the application-level menu, select View > Site Map > Siebel Remote 
Administration screen > Replication Servers.

5 In the Parent Server form, select the appropriate node as the parent.

Usually, this is HQ.

6 In the Regional Databases list, select the appropriate Server Name.

7 Click the select button in the Routing Group field.

8 In the Routing Model Selection dialog box, select the new Routing Group you 
want and click OK.

Fill in any of the other fields on the form as appropriate.
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9 Perform a database extract of the regional database, then initialize the regional 
database.

For extracting the regional database, see “Extracting the Regional Database” on 
page 219.

For initializing the regional database, see “Initializing the Regional Database” on 
page 224.

10 Perform database extract of mobile Web clients on the new regional node, and 
resume normal operations on the regional node.

For extacting mobile databases, see “Creating Mobile Web Client User Accounts 
and Privileges” on page 121.

NOTE: All views are supported only on Regional Nodes that have a Routing Group 
of type REGIONAL SERVER - FULL COPY. 
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Monitoring Regional Application Servers
Administrators should use the Remote Administration and Server Administration 
views to monitor server components and data movement from regional nodes to the 
parent node.

Administrators should also monitor disk space availability.

Managing Security and Authentication
Replication Manager uses the administrator’s user name and password to log on to 
the Parent node. During this process, it authenticates against its parent node, 
usually the HQ node. It does this according to the Authentication Method set in the 
Synchronization Manager Component of the parent node. For more information 
about the Authentication Method parameter, see Table 8 on page 74.

It is recommended that the administrator user name and password be the same on 
the HQ database and the regional databases. The Regional Application Servers and 
srvrinit use the administrator database login.

To change the administrator password

1 Change the password according to the Authentication Method. 

For example, if the Authentication Method is set to Database, changing the 
password in the database on the Parent node requires changing the same 
password on the Regional Node. For information about this topic, see Security 
Guide for Siebel eBusiness Applications.

2 Change the password by using the Siebel Application Server on the Regional 
node.

a From the application-level menu, select View > Site Map >Server 
Administration> Enterprise Configuration.

b From the Show drop-down list, select Enterprise Parameters.
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c In the Enterprise Parameters list, enter an appropriate value for the Password 
parameter.

d Stop the Siebel application services.

For more information on how to stop and start Siebel services, see Siebel 
Server Administration Guide.

e Restart the Siebel application services for the changes to take effect.

Performing Backup and Recovery of Data
Database administrators should perform regular backups and maintenance tasks on 
the Headquarters Database and on the Regional Databases. If a failure occurs on a 
Regional Database and it cannot be recovered to the exact point of failure, you must 
reextract the Regional Database on the Database Server at its parent node. 

If the Regional node can be recovered to the exact point of failure, the 
S_DOCK_STATUS values of the HQ and regional nodes will be in sync. After 
recovery to the point of failure, the following transactions will be synchronized: (1) 
those that were not synchronized at the time of failure and (2) those created on the 
HQ and Regional nodes after the time of failure. 

If transactions are lost on the HQ node, the child nodes and subsequent child nodes 
must be reextracted. You must also reextract the mobile users who synchronize with 
the Regional Siebel Server whose Regional Database failed.
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Managing Backlog in the Transaction Log Table
It is best practice to make sure the transaction processors that are not required are 
end dated. 

It is very important to make sure old transaction processors have end dates. For 
example, this may happen when a transaction processor is started and then not 
used on a server, postupgrade. Or, this may happen when a transaction processor is 
started and then the server is uninstalled. 

To end date an old transaction processor

1 From the application-level menu, select View > Site Map > Siebel Remote 
Administration screen > Processor Status. 

2 In the Transaction Processors list, select the old transaction processor.

3 In the End Date field, enter an end date. 

For more information about on this topic, see “How to Handle a Large 
Transaction Backlog” on page 270.
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Deactivating and Reactivating a Regional Node

CAUTION: This section describes the procedure to deactivate and reactivate a 
Regional Node. Make sure to do a full backup of the HQ Node and the Regional 
Nodes before deactivating a regional node.

To deactivate a regional node

1 Synchronize all remaining transactions of remote users assigned to the Regional 
Node (if any).

2 Make sure all transactions have been applied to the Regional Node (for example, 
make sure that Txn Merger on the Regional Node has processed the .dx files).

3 Check that the transactions have been synchronized with the HQ node.

4 Move every Remote user attached to your Regional Node to either the HQ Node 
or another Regional Node (if any).

5 Shut down the Transaction Processor, Router, Merger and RepAgent on the 
Regional Node.

6 Shut down the Transaction Processor and Router on the HQ Node.

7 On the HQ Node, set the Effective End Date for the Regional Node in View > 
Site Map > Siebel Remote Administration > Replication Servers.

8 Restart the Transaction Processor and Router on the HQ Node.

9 Point the Regional Node connected users to HQ by modifying ODBC sources and 
the CFG file.

10 Delete the docking folder for the Regional Node from the Siebel 
Server\DOCKING directory on the HQ Node as it is no longer needed.
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To reactivate a Regional node

1 Shut down the Transaction Processor and Router on the HQ Node.

2 On the HQ Node, set the Effective End Date to NULL in Remote 
Administration > Replication Servers for this Regional Node, on HQ.

3 Reextract and reinitialize the regional database.
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This chapter describes upgrading regional nodes with and without the use of Siebel 
Anywhere. It also discusses schema upgrades in the DB2 regional environment.
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Upgrading the Repository for a Regional Node
A Siebel repository contains the object definitions of the Siebel application and 
database schema. Within any one hierarchy, every instance of Siebel Replication 
Manager and Siebel Remote must have the same database schema and SRF file. 

NOTE: Although the Language can vary for each instance within any one hierarchy, 
the SRF file must be compiled from the same repository. For example, the SRF file 
used in a Replication environment can be a different language from the SRF file 
used in the HQ environment if both are compiled from the same repository. 
Similarly, the Language used by one Remote client can be different from another 
Remote client within the same hierarchy if each is compiled from the same 
repository.

When object definitions are changed—for example, to change application behavior 
or to add extension columns—it is necessary to distribute the changes to the 
Headquarters, Regional and local databases (this is known as a minor upgrade).

The application definition is compiled into an SRF file using Siebel Tools. Schema 
object changes are represented by a set of DDL (Data Definition Language) 
operations.

There are two ways to roll out repository changes to a regional environment:

■ If you have Siebel Anywhere, you can use it to apply schema changes to regional 
and mobile users. For detailed steps, see “Repository Upgrade with Siebel 
Anywhere” on page 251.

■ If you do not have Siebel Anywhere, you must reextract and reinitialize the 
regional and mobile nodes after applying the repository changes and 
synchronizing with the physical schema. For detailed steps, see “Repository 
Upgrade Without Siebel Anywhere” on page 252.

NOTE: It is recommended that you thoroughly test the repository changes and 
upgrade steps in a separate test environment before migrating them to production. 
The following steps assume that an SRF file has been compiled and is available for 
distribution.
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Repository Upgrade with Siebel Anywhere
This section describes upgrading a repository by using Siebel Anywhere.

To prepare to upgrade a repository

1 Have the mobile users synchronize with the Regional Database.

NOTE: After synchronizing, mobile users should not make any changes to their 
local database until after the upgrade. Changes made after this point will be 
made with the old repository, schema, and SRF file, and so may cause problems 
when they are applied to the upgraded regional server.

2 Wait until every transaction is applied to the Regional Node. 

3 Run Replication Agent to synchronize the Regional Node with the Parent Node.

This is usually the Headquarters Node.

NOTE: No more changes should be made to the Regional Node until after the 
upgrade. Changes made after this point will be made with the old repository, 
schema, and SRF file, and so may cause problems when they are applied to the 
Parent Node.

4 Wait until the transactions are applied to the Parent Database.

5 Disconnect the users and stop the server components as appropriate. Note that 
not all upgrades will require this step.

6 Upgrade the HQ Node. See Siebel Tools Reference for more information on 
installing a new repository.

7 Restart server components and make the system available to users.

To build the upgrade kit for the database schema

■ Refer to Siebel Anywhere Administration Guide for the necessary procedures.

To distribute the upgrade kits and finish the upgrade

■ Refer to Siebel Anywhere Administration Guide for the necessary procedures.
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 251



Upgrading Regional Nodes

Repository Upgrade Without Siebel Anywhere
Repository Upgrade Without Siebel Anywhere
This section describes upgrading a repository without the Siebel Anywhere option. 

To upgrade a repository without Siebel Anywhere

1 If the Regional Node has mobile users, instruct the mobile users to synchronize 
with the Regional Node and to stop working on their local databases until 
further notice.

NOTE: After synchronizing, mobile users should not make any changes to their 
local databases until after their databases have been reinitialized. Changes made 
after this point will be lost.

2 Wait until the transactions have been applied to the Regional Node. 

3 Run Replication Agent to synchronize the Regional Node with the Parent Node. 
This is usually the Headquarters Node. 

NOTE: No more changes should be made to the Regional Node until after it has 
been reinitialized. Changes made after this point will be lost.

4 Wait until the transactions are applied to the Parent Node.

5 If appropriate, disconnect the connected users on the Parent Node.

6 Stop the server components as appropriate. 

7 Apply the upgraded repository to the Headquarters Node and synchronize the 
repository with the physical schema.

For more information, see Siebel Tools Reference. 

8 Allow connected users at the Headquarters Node to reconnect and continue 
working using the new SRF file.

9 Use Generate New Database to generate a new database template on the Parent 
Node.

10 On the Parent Node, perform a database extract of the Regional Node.
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11 Initialize the Regional Node.

12 Allow connected users at the Regional Node to reconnect and to resume work 
using the new SRF file.

13 Generate a new database template on the Regional Node.

14 Extract each mobile Web client on the Regional Node.

15 Allow mobile users to reinitialize their local databases and to resume work using 
the new SRF file. 
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Manager 11
This chapter includes reference information, FAQs, and scenarios for Remote and 
Replication Manager to help resolve problems. The material discusses components, 
administrative tasks, and specific situations.
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Setting Up Remote Server and Remote Clients
This quick reference sequence provides an overview of the steps to set up Siebel 
Remote on both the server and the mobile Web client. The purpose is to provide a 
“quick look” so you can review or learn the material.

The following sequence of steps outlines the general flow to set up Siebel Remote 
Server and Remote Clients for an out-of-the-box installation of your Siebel 
application.

1 Make sure employees are set up; navigate to Application Administration > 
Employees > Employees.

The employee must have at least one position and responsibility. The fields 
cannot be blank.

2 If your deployment includes regional nodes, define the appropriate employees 
as users on their corresponding regional nodes. 

For details on how to do this, see “Registering a Regional Node” on page 216.

3 Set up users as mobile Web clients: navigate to Remote Administration > 
Mobile Clients.

a Add mobile Web clients here.

b At a minimum, fill in the fields Mobile Client, User Login Name and Routing 
Model.

For example: HALACON, HALACON, MOBILE CLIENT - STANDARD

4 Start a “Generate New Database” process. Wait for it to finish successfully.

5 If the Siebel Server has not had Mobile users set up on it before, start a 
“Database Extract Process” for the mobile Web clients. 

a Enter * in the Client Name field in the Parameter Overrides view. 

b Wait for this task to finish successfully.
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6 If the transaction process is not currently running, start a transaction processor     
process. 

For details to start a transaction processor component, see “Starting Siebel 
Remote Server Components” on page 67.

7 If the transaction router process is not currently running, start a transaction 
router process.

For details to start a transaction router component, see “Starting Siebel Remote 
Server Components” on page 67.

8 If the transaction merger process is not currently running, start a transaction 
merger process.

For details to start a transaction merger component, see “Starting Siebel Remote 
Server Components” on page 67.

9 Make sure that you set up the mobile Web client hardware and software.

10 Make sure the appropriate CFG files for your mobile Web clients are correctly set 
up. 

Especially verify the contents of the section titled [Local]. Values of 
CHANGE_ME are indicators that these values probably require changing.

11 Run a mobile Web client session on a mobile user's PC and attempt to connect 
to the local database.

It will not exist yet and will require initialization of the local database. 

If this step is successful, it means the mobile user is set up and initialized 
correctly.
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Replication Agent is a component of Replication Manager that resides on the 
Regional Siebel Server. It synchronizes the Regional Database with its parent 
database.

Replication Agent Failure Due to Special Characters During an Update
You may encounter situations where special characters cause Replication Agent to 
fail during an update. Use the following procedure to find the transaction IDs 
involved with this failure. 

To find the transaction (TXN_ID) causing this problem 

1 Run the following query on the Server database: 

SELECT MIN(TXN_ID), MAX(TXN_ID) FROM S_DOCK_TXN_LOG 

2 From the Siebel Server machine, go to a DOS prompt and type the following: 

cd server_root_dir\bin

siebenv

txnutl /u SADMIN /p SADMIN /s MIN(TXN_ID) /e MAX(TXN_ID) /d dbo /
c <SiebelServerDataSource> /w dx-file > output_file 

where: 

■ /u is the user name of the Admin account 

■ /p is the password of the Admin account 

■ /s is the output of MIN(TXN_ID) of the previous query 

■ /e is the output of MAX(TXN_ID) of the previous query 

■ /w is dx-file name the transactions of S_DOCK_TXN_LOG are written to in 
the format of a dx-file

■ /d is the schema owner (dbo) 

■ /c is the Siebel Server ODBC Data Source used to connect to the database 
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■ dx-file is the file you have to check to find the transaction that caused the 
problem.

3 Open the output file with any editor and go to the end of the file. You will see 
something like the following: 

Txn Type:  S 

Txn Id:  49051 

Src Node:  16 

Created By:  1-2G-162 

DLog Row Id:  16-RHP 

The TXN_ID in this case is 49051. 
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This section describes how to analyze selected problems that can be encountered 
with Synchronization Manager, plus possible causes and workarounds.

SynchMgr Situation
The following error was encountered in SynchMgr_xxx.trc/log files:

■ DCK-00123: Error opening file (null) for read

[ERR33] (drl.cpp 5(206) err=1700123 sys=1400022) DCK-00123: Error 
opening file d:\siebfile\S_DOC_PPSL_0-CQNE_0-S9.saf for read

Possible Causes:

■ Unable to access the File System directory.

■ File Attachments do not exist in the File System. 

If this occurs with only one particular mobile Web client, make sure the System 
DSN is set up correctly.

Verify that the attachments are available in the file system. Siebel eBusiness 
Applications come with a set of default templates. Make sure you have copied 
the files from the <dbsrvr>\files to the Siebel File System.

■ DCK-00164: Error connecting to datasource (null) ((null))

Possible Causes:

■ Siebel Gateway and Services were started while database server was shut 
down.

Workaround:
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■ Navigate to Server Administration and shut down the Synchronization 
Manager and then restart it again. Refresh the applet to make sure that 
Synchronization Manager has a state of running. 

For more details about Synchronization Manager, see Siebel Server 
Administration Guide and “Starting Siebel Remote Server Components” on 
page 67. SynchMgr_xxx contains the following error message: (syncsrvr.cpp 
22(692) err=1700213 sys=0) DCK-00213: Another Synch Server is already 
servicing this node.

Possible Causes:

■ Interrupted synchronization sessions. If a client synchronization session 
stops or disconnects abnormally, the Siebel Synch. Manager may still remain 
running. 

■ If a user connects through a dial-up line via TCP/IP and the line is 
disconnected, then the TCP/IP session stays active for a certain time. The 
Synchronization Manager task cannot close until the TCP/IP session is finally 
released. 

Workaround:

■ Configure the TCP/IP timeout on the Applications Server. Contact your 
System Administrator for information about the TCP/IP keep-alive 
functionality.

■ SyncMgr_xxx contains the following error message: “DCK-00214: Directory 
(null) does not exist”

Possible Causes: 

■ Docking directories of mobile Web clients have been deleted. 

Solution:

Reextracting the mobile users will re-create these docking directories and client 
should be able to download the latest snapshot files and then synchronize with 
the server again.
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FAQ: What to Do with an Initialization or Synchronization Problem

1 Look in the <SiebelClientInstall>\log directory for files:

■ upgwiz*.log and syncthrd*.log (in case of an initialization problem)

■ syncthrd*.log (in case of a synchronization problem)

2 Find the error message in the LOG file.

3 With error messages, search this troubleshooting chapter and SupportWeb.

4 If this does not help resolve the problem, follow “How to Set Client-Side 
Logging” on page 170 to obtain additional information in the LOG file.

Does the additional information help to resolve the problem (troubleshooting 
chapter and SuppportWeb)?

5 If not, log a Service Request and send the *.log information with the additional 
trace information (Step 4) to support@siebel.com.

FAQ: Long Initialization/Synchronization Times
When you receive the CSSSISDockFgetACKMsg msg error during initialization or 
synchronization there are basically two cases to differentiate:

1 You are working in a network environment.

In this case the error might have occurred due to very heavy network traffic.    

2 You are working over a phone line.

In this case one possible reason could be an unstable telephone line.    

■ If possible, you should try different telephone lines.    

■ Another reason could also be a bad modem, either on the client side or the 
server side.    

■ In either case, work with your IT department to troubleshoot the problem.
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FAQ: Cannot Connect to Server During Synchronization
As the text of the error message indicates, there is a problem with the connection 
between the Siebel Remote client and the Siebel server.

If this error occurs, do the following:

■ Ping the Siebel server from the client by running the following command from 
the DOS window on the client machine:

ping <server machine name> 

If the server cannot be reached by name, try the IP address. The expected result 
is that the ping is able to resolve the host name to an IP address and connect to 
the machine. 

■ Before synchronizing again, refer to “How to Set Client-Side Logging” on 
page 170 to increase the level of client-side tracing. It is located in the \“log” 
directory of the client. It is named SyncThrd*.log. Send this file to Siebel 
Technical Support for review.

If the connection is established on the server then there will also be a sync 
manager trace file. It is named SyncMgr*.log located in the Siebel server log 
directory.

Check the DockConnString in the [Local] section of the client’s CFG file and 
confirm that it is set to the host name of the Siebel server with which this client 
will synchronize. Send the client’s CFG file to Siebel Technical Support for 
review as well. 

It is recommended that you specify the DockConnString in the following format:

■ Siebel server machine name: network protocol: sync port #: server: 
encryption.

■ Siebel server machine name, assuming the default synchronization port 
number is 40400.

Remote users use the DockConnString parameter in the CFG file to synchronize 
to the server. For details regarding the syntax of the DockConnString parameter, 
see “Synchronization Parameters” on page 87.

■ If the Synchronization Manager component is not running, check the following: 
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■ %Siebel_server%\log\SynchMgr* log file.

■ If the failure message is Login Failed, then verify that Synchronization 
Manager uses the correct user name and password when connecting to the 
database. 

This should be the system administrator user (SADMIN) and not the 
database tableowner (SIEBEL or dbo). The system administrator's password 
in the database must match the password registered in the Gateway Server. 
If the SADMIN password changed in the database but not in the Gateway 
Server, users will not be able to log in to Server Manager views. To register a 
new password with the gateway, verify that the Gateway Server service is 
running and complete one of the options below from the 
%Siebel_Server%\bin command prompt.

Using Server Manager, enter:

srvrmgr /g <GatewayName> /e <EnterpriseName> /u <username> /p 
<password>

/g: specifies the host name of the machine running the gateway

/e: enterprise server name

/u: Siebel Administration username

/p: Siebel Administration password

When the Server Manager prompt appears, type:

srvrmgr> change ent param Password=NewSADMINPassword

Type exit. 

For more information about Server Manager, see Siebel Server Administration 
Guide.

Using srvrcfg, enter:
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srvrcfg /g <GatewayName> /e <EnterpriseName> /m enterprise /w 
Password=NewSADMINPassword

Stop and restart the Siebel server service to invoke the change.

NOTE: Use caution when changing the password—an incorrect entry will 
cause errors throughout your system.

If the password of the database account is unchanged, the password of the 
system administrator account can be changed in the Server Manager views.

To view the current sync manager port number

1 From the application-level menu, select View > Site Map > Server 
Administration > Components.

2 From the Server Components list, click Query and run a query for the 
Synchronization Manager component.

3 From the Server Components list, select the Synchronization Manager 
component for the appropriate Siebel Server.

4 Click the Components Parameters tab, and click Query to run a query for the 
Static Port Number parameter.

The port number in use is in the column Current Value.

To change the current sync manager port number

1 Navigate to the Component Parameters tab as in the previous procedure. 

2 In the Component Parameter list, run a query for the Static Port Number 
parameter.

3 Enter the new value in the Value on Restart field.

4 Restart the server.

5 Test the connection by copying a CFG file, from a user that is able to connect or 
synchronize, onto the client machine where the behavior is occurring. 

Observe the results and compare the two CFG files for any noticeable 
differences.
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What to Do When Transaction Merger Fails
This section describes a temporary workaround to restart Transaction Merger until 
the root cause has been found.

To work around a Transaction Merger’s failure

1 Check out the log file (TxnMerge*.log) to find the mobile Web client and the 
*.dx-file this is happening for. In the example following, the mobile Web client 
is SADMIN and the *.dx is 00000009.dx.

CAUTION: Renaming or deleting the DX files in siebsrvr\Docking\Client\Inbox 
directory is not allowed. If you rename or delete DX files you will lose the 
transactions and will have to reextract the mobile Web client.

[TRC35] >>> Processing Client: SADMIN

[TRC35]   File: 
c:\Sea704\Siebsrvr\docking\SADMIN\inbox\00000009.dx

[TRC33] 2000-10-06 12:09:51 Client: SADMIN, File: 
c:\Sea704\Siebsrvr\docking\SADMIN\inbox\00000009.dx.

[DBG33] 2000-10-06 12:09:51 Message: Generated SQL statement:,

Additional Message: SQLExecute: INSERT INTO dbo.S_OPTY_PROD_X 
(ATTRIB_01, ATTRIB_02, ATTRIB_03, ATTRIB_04, ATTRIB_05, 
ATTRIB_06, ATTRIB_07, ATTRIB_08, ATTRIB_09, ATTRIB_10, ATTRIB_11, 
ATTRIB_12, CONFLICT_ID, CREATED, CREATED_BY, LAST_UPD, 
LAST_UPD_BY, MODIFICATION_NUM, PAR_ROW_ID, ROW_ID)
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VALUES (?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?, ?)

NOTE: In the log file, following the line with the series of question marks, you 
can find the actual values, which are bound to each by the question mark.

For example:

INSERT INTO dbo.S_EMPLOYEE(NAME, AGE, SEX)
VALUES(?,?,?)
NAME: Bill
AGE: 40
SEX:  M

[DBG33] 2000-10-06 12:09:51 Message: Error: An ODBC error 
occurred,

Additional Message: Function: DICInsRowExecStmt; ODBC operation: 
SQLExecute

2 If the error is specific to one mobile Web client, rename the INBOX directory for 
this mobile Web client (that is, from 
C:\Sea704\SiebSrvr\Docking\Sadmin\Inbox to 
C:\Sea704\SiebSrvr\Docking\Sadmin\Inbox_Old) and restart Transaction 
Merger.

3 If Transaction Merger runs after that, this is only affecting one mobile Web 
client. If Transaction Merger fails again, you can expect that the failure applies 
to the mobile Web clients.

4 Open a Service Request on the SupportWeb and send the related *.dx-file and 
the trace file for further analysis.

NOTE: This is a temporary workaround because the specific mobile Web client 
will not be able to synchronize.
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Users Who Cannot See Records When Connected Locally 
 There are many reasons why mobile users may not see a record through the user 
interface when connected to their local database. To troubleshoot such an issue, the 
instructions in this FAQ may help you determine the reasons for the behavior.

The following paragraphs describe several situations and tips to solve the problems.

Navigate to the Remote Administration > Mobile Clients view. Make sure the 
Mobile Client has the appropriate routing model. In addition, make sure the 
Receiving Transactions check box is checked. If the routing model is set correctly 
but Receiving Transactions is not checked, search the database extract log file for 
errors. It is an indication that database extraction is not successful.

Navigate to the Application Administration >System Preferences view; verify that 
the ‘Docking: Transaction Logging’ parameter value is set to True. If this parameter 
is set to False, you should set it to True, after which you must reextract the mobile 
Web clients. 

Make sure the transaction processor and router are running and also check the 
transaction processor(txnproc_xxx.log) and router(txnroute_xxx.log) log files for 
errors. 

For limited visibility records, make sure that the record in question is visible in one 
of the “My… “or “My Team's” views when the same user is connected directly to 
the server. For Organization, Opportunity, Contact and Service Request Dock 
Object, these records are also routed to the mobile users if the records are available 
through drilldown from a My or My Team’s view. A list of limited and Enterprise 
visible objects can be found by using Siebel Tools to query the repository.

Use the visutl.exe utility to check if the mobile user has visibility to the records. 
Review the log file generated by this utility. If visutl.exe reports that the record is 
not visible, this means that the record does not reside on the mobile user’s local 
database. You can find a logical explanation for what makes certain records visible 
to the mobile users by logging into Siebel Tools. Using the Flat tab, navigate to the 
Dock Object Table in the Object Explorer. Once you have done this, go back to the 
Types tab, and choose Dock Object >Dock Object Visibility Rule object type. In the 
Dock Object Visibility Rule object List Editor window, right scroll to the Comments 
field. You will find the explanation for each rule that is associated to that dock 
object. Refer to the FAQ question, “What is visutl and how do I run it?” 
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If the visutl.exe reports that the record is visible, log on using isql55 to verify if the 
record resides on the local database. Refer to FAQ, “How to log on a local database 
using isql55.”

Once you have logged on successfully, run the following query:

Select * from SIEBEL.<TABLENAME> where ROW_ID = ‘<Rowid of the 
non-visible record>’

If the record resides on the local database but is not visible through the user 
interface, and if you are using a custom SRF file, try to log in to the Siebel 
application using the standard SRF file. If the records are visible, something in your 
configuration is filtering out the records. Investigate your configuration.

In addition, you may also start up your Siebel Application with the /S option to 
spool out the SQL that is being run on the view that does not show the record. Look 
at the query/joins that are being run to see what may be filtering out the records 
that should be visible on the User Interface. Refer to the TechNote, “Using the /S 
Option to Examine the SQL generated by Siebel Enterprise Applications.” 

If the record does not reside on the local database, this indicates a potential problem 
with the Siebel Remote processes. Confirm that the user has synchronized 
successfully with the remote server. Check the Synthrd_xxx.log files for any errors. 
If transaction, router and synchronizing are fine, reextract the user and see if the 
record is visible after the reextraction.

If you are using a collating sequence other than 1252, read Alert, “The SQL 
Anywhere collating sequence treats characters and their accented or special 
counterparts as duplicates.” 

If you still need assistance, send TechSupport the visutl.log located in the current 
directory where you run the visutl.exe for analysis. In addition, you may perform 
the following test:

Create a couple of transactions in which you want the mobile Web client to have 
visibility, then start the transaction processor. Next, you start the transaction router 
with the following event levels set: GenericLog=4, Trace=4, 
SqlparseandExecute=4. Send the transaction processor and router trace file and the 
DX files in the <SiebelRoot>\docking\<client>\outbox folder to 
support@siebel.com for analysis.
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How to Handle a Large Transaction Backlog
This section discusses how to handle a large transaction backlog in the transaction 
log table.

With the System Preference Docking:Transaction Logging set to TRUE, your Siebel 
application will record transactions to the transaction log table 
(S_DOCK_TXN_LOG). The Transaction Processor (txnproc) is responsible for 
deleting entries from this table—after all txnprocs in the system have copied them 
to the Application server TXNPROC directory. Enterprise visible data will be routed 
to the active mobile Web clients. 

The backlog is the number of transactions in S_DOCK_TXN_LOG, or large number 
of DX files in TXNPROC directory. For example, to see the backlog in the 
S_DOCK_TXN_LOG select count (TXN_ID) from S_DOCK_TXN_LOG. Alternatively 
you may wish to know the oldest transaction, for example select min(CREATED) 
from S_DOCK_TXN_LOG. However, a backlog of 1000 transactions is not usually 
considered a problem.

If you are experiencing a large number of rows in S_DOCK_TXN_LOG, or large 
number of DX files under TXNPROC directory, follow these steps: 

1 Check that Transaction Processor and Transaction Router or Routers are running. 

In the Server Tasks screen (Siebel Administration > Servers > Server Tasks), 
check the Task State and Status. 

At least one Transaction Processor, Router, and Merger are required per Remote 
server. Multiple Routers and Mergers can be run on one Remote server. Multiple 
Routers are often recommended.

2 Check that Transaction Processor is processing Transactions. 

Check by looking at the Siebel Remote Administration > Transaction Processor 
Status view. Here you will find information about the last transaction and last 
file, created by Transaction Processor in the TXNPROC directory on your Siebel 
Server. Under normal circumstances and if there are not any problems, these 
keep increasing. 
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3 Check for old TP entries. 

There may be old transaction processor entries in the S_NODE table that are no 
longer in use; either they have been left active after an upgrade or perhaps they 
are associated to a Siebel server that is no longer in use. It is a best practice to 
make sure transaction processor entries that are not required are end dated. 

4 Check for Transaction Processors without end dates. 

It is very important to make sure old transaction processors have end dates. For 
example, this may happen when a transaction processor is started and then not 
used on a server, postupgrade, or a transaction processor is started and then the 
server is uninstalled. 

To end date an old transaction processor, see “Managing Backlog in the 
Transaction Log Table.”

5 Changes in positional Hierarchy, Territory realignments, or large EIM loads can 
also create a large number of Transactions. 

The higher in the hierarchy you change, add, or delete one or more positions, 
the more transactions will be created. 

When using EIM, the parameter LOG TRANSACTIONS TO FILE defaults to 
TRUE. This means EIM will log transactions under the File_System\eim folder 
with only one marker logged into the S_DOCK_TXN_LOG table. If the parameter 
is set to FALSE, EIM will use set-based transaction logging to reduce database 
contention for S_DOCK_TXN log by only recording one txn per EIM set in 
S_DOCK_TXN_LOG. 

It can take some time for the Transaction Processor and the Router to work 
through the created backlog and route the changes to your mobile users. 
Multiple routers or reextracting the mobile users will speed up processing. 

6 If you are still having a problem, contact Technical Support and provide 
Transaction Processor and Router log files with the following trace flags set: 

■ Change the following log events (in srvrmgr):

❏ evtloglvl sql=4

❏ sqlParseandExecute=4 
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❏ genericlog=4

■ Run the Siebel Remote component with SQL Flag=2, Trace Flag=1

7 Also run the following from the <Siebel_server_root>\bin directory, and 
supply the two TXT files to Siebel Tech Support: 

Siebenv 

txnutl /u SADMIN /p SADMIN /C <ODBC Datasource> /D <tableowner> /
w TxnOut1.txt /K LOWSCANMARK /L Y /Z N > TxnOut2.txt 

In addition to the steps above, you should examine the indexes on 
S_DOCK_TXN_LOG and S_DOCK_TXN_SET.

The P1 index is on an ID column that counts upwards. Lower IDs are deleted. This 
can lead to many index leaf rows pointing to rows that are no longer there. 

For this reason, you should rebuild the indexes in the S_DOCK_TXN_LOG and 
S_DOCK_TXN_SET tables regularly.
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This appendix describes how to repair orphaned records on the server created by 
the merge process occurring while child records are being created on mobile Web 
clients. The solution involves tracking the merge process and then, using a 
workflow process, reassociating the orphaned child records with their appropriate 
parents.
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The combination of actions below will create orphaned child records on the server. 

■ Merging on the server that deletes a parent record.

■ Before invoking a synchronization session that would merge the same records 
on the local database, the user creates or associates child records to the parent 
that was deleted on the server. 

■ When synchronization does occur, the child record associated with the deleted 
parent is orphaned on the server.

The following example illustrates the sequence of events that may occur to create 
the client-side merge problem. Keep in mind that a client-side merge refers to 
actions initiated from the user interface rather than another type of merge such as 
an EIM merge.

To begin, both the mobile Web client and the server have equivalent records such 
as:

■ Account A with Activity 1 as a child record

■ Account B with Activity 2 as a child record

The client-side merge problem arises if the following sequence of activities takes 
place:

1 Account A and Account B are merged on the server into Account B. As a result, 
the following happens on the server:

■ Account A is deleted.

■ Account B has both Activity 1 and Activity 2 as children. This happens 
because the object manager issues a multirow update statement for each 
possible child table of the Account A table.

■ The above actions generate transactions that are placed in the outbox for the 
mobile Web client.

2 Before the transactions in Step 1 are routed to the mobile Web client, the 
following occurs:
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■ The mobile Web client inserts Activity 3 as a child record of Account A and 
synchronizes.

3 The mobile Web client synchronizes and the following occurs:

■ Activity 3 is routed up to the server. An Activity 3 is created with parent 
Account A on the server. This activity is an orphaned record because its 
parent does not exist on the server.

■ The merge operations on the server described in Step 1 are sent down to the 
mobile Web client. Activity 3's parent is reset to Account B on this mobile 
Web client. Consequently, the client-side merge does not create an orphaned 
record on the mobile Web client.
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This section describes the solution and how to repair the client-side merge problem.

The solution is to provide the ability to repair orphaned data on the server. To do 
this you will use the following: 

■ Log all merge transactions on the server

■ Use a batch process to reassociate orphaned child records with the appropriate 
parents using the log

■ A view that shows the content of the log for administration and system 
management 

For organizations with the client-side merge problem, use the following procedures 
to repair the orphaned child records.

To turn on CSM Logging

1 Navigate to the Application Administration screen and from the Show drop-
down list, click System Preferences. 

2 Select System Preference Name=CSM Logging.

3 Set the System Preference Value=TRUE. 

4 Restart the Siebel Server. 

This allows system preferences to take effect.

5 Restart the Siebel Remote components.

See “Starting and Stopping Siebel Remote Server Components” on page 142.

The next step should be to create a workflow process that calls the appropriate 
business service. Create a workflow process that calls the CleanUp business service. 
To control the size of this log, create another workflow process to remove old merge 
transactions.

The following two procedures describe how to create these workflows. Two 
workflows should be created for each method of CSM Log Service.
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To repair orphaned child records

This is also called the CleanUp () function.

1 Create a workflow with three steps: Start, CleanUp, and End.

See Siebel Business Process Designer Administration Guide for details on how to 
create workflows.

2 For the CleanUp step, set the following:

a Set Business Service to CSM Log Service.

b Set Method to CleanUp.

c There is no input argument or output argument for this method.

To delete entries in the CSM log

This is also called the RemoveOldEntry () function.

1 Create a workflow with three steps: Start, RemoveOldEntry, and End.

See Siebel Business Process Designer Administration Guide for details on how to 
create workflows.

2 For the RemoveOldEntry step, set the following:

a Set Business Service to CSM Log Service.

b Set Method to RemoveOldEntry.

3 Create one input argument and set Input Argument=TransactionId. 

4 Find the value of this input argument in the CSM Log View. 

This workflow deletes records in the CSM Log table that have a transaction ID 
smaller than the input argument.

To run a workflow from the command line

1 From a DOS (or shell) prompt, change the current directory to:

<Siebel Installation directory>\siebsrvr\bin

2 Enter: 
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srvrmgr /g <gateway> /e <enterprise> /s <siebsrvr> /u <username> 
/p <password>

3 To run wfprocmgr, enter:

start task comp wfprocmgr with ProcessName="<Workflow Name>"

Administrators determine how frequently to repair orphaned child records and 
delete CSM log entries. Typically, the frequency should be determined by how often 
Merging is used to clean up duplicate entries.
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This appendix includes three sections. 

■ The first section, “Routing Definition Differences in Docking Objects” on 
page 280, includes a table that provides an overview of the differences between 
the docking objects in Siebel 7.5 and Siebel 7.0.3.

■ The second section, “Visibility Level Changes for Docking Objects” on page 287, 
includes four tables to identify the docking objects that changed visibility levels 
to help optimize mobile database size. For example, some docking objects 
changed visibility from Enterprise to Regional.

■ The third section, “New Regional Docking Objects” on page 290, includes one 
table to identify the new regional docking objects that further optimize mobile 
database size. 
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Table 27 compares the routing definition differences between Siebel 7.0.3 and 
Siebel 7.5 docking objects, and lists new ones for Siebel 7.5. The table provides a 
comparison of pairs of docking objects between the two versions, or identifies new 
docking objects for Siebel 7.5. To read Table 27 use the following:

■ If the Version field of a row reads 7.0.3, compare it with the 7.5 row immediately 
below it. 

■ If the Version field of a row reads 7.5 and the Version field of the row 
immediately above it also reads 7.5, a docking object is new in Siebel 7.5.

Table 27. Docking Comparison - Docking Object Differences

Version Docking Object Visibility Level Primary Table DO Active?

7.5 AppLicense Private S_APP_LICENSE Y

7.0.3 AssignGroup Enterprise S_ASGN_GRP Y

7.5 AssignGroup Limited S_ASGN_GRP Y

7.5 AssignRuleGroup Limited S_ASGN_RULE_GRP Y

7.0.3 BusComp Audit Enterprise S_AUDIT_BUSCOMP Y

7.5 BusComp Audit Limited S_AUDIT_BUSCOMP Y

7.5 CFGCache Private S_CFG_CACHEREQ Y

7.5 CFGConstrain Enterprise S_CFG_CNSTR_TBL Y

7.5 CFGRuleNode Private S_CFG_RULENODE Y

7.0.3 CFGUIGrp Enterprise S_CFG_UIGROUP Y

7.5 CFGUIGrp Limited S_CFG_UIGROUP Y

7.0.3 CHAMP Enterprise S_CHMPINTV Y

7.5 CHAMP Limited S_CHMPINTV Y

7.0.3 CTI Cfg Enterprise S_CTI_CFG Y

7.5 CTI Cfg Limited S_CTI_CFG Y
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7.5 CalendarResource Enterprise S_CAL_RSRC Y

7.0.3 Call Script Page Enterprise S_CS_PAGE Y

7.5 Call Script Page Limited S_CS_PAGE Y

7.0.3 Call Script Path Enterprise S_CS_PATH Y

7.5 Call Script Path Limited S_CS_PATH Y

7.0.3 Call Script Question Enterprise S_CS_QUEST Y

7.5 Call Script Question Limited S_CS_QUEST Y

7.0.3 Call Script Style Enterprise S_CS_STYLE Y

7.5 Call Script Style Limited S_CS_STYLE Y

7.0.3 Catalog Enterprise S_CTLG Y

7.5 Catalog Limited S_CTLG Y

7.0.3 Catalog Category Enterprise S_CTLG_CAT Y

7.5 Catalog Category Limited S_CTLG_CAT Y

7.0.3 CommTemplate Enterprise S_COMM_TMPL Y

7.5 CommTemplate Private S_COMM_TMPL Y

7.5 CompPlan Budget Private S_CP_BDGT Y

7.5 CompPlan Guideline Private S_CP_GDLN_SET Y

7.5 CompPlan Job Private S_JOB Y

7.5 CompPlan Job Family Private S_JOB_FAMILY Y

7.5 CompPlan Plan Private S_CP_PLAN Y

7.5 CompPlan Region Private S_CP_REGN Y

7.5 CompPlan Salary Grade Private S_SALARY_GRADE Y

7.5 CompPlan Salary Plan Private S_SALARY_PLAN Y

7.5 CompensationCap Enterprise S_IC_CAP Y

Table 27. Docking Comparison - Docking Object Differences

Version Docking Object Visibility Level Primary Table DO Active?
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7.5 CompensationCapTxn Private S_IC_CAP_RUNTXN Y

7.5 CompensationDrawTxn Private S_IC_DRAW_RNTXN Y

7.5 CompensationPayTxn Private S_IC_PAY_RUNTXN Y

7.5 CompensationPaymentRelease Limited S_IC_PAY_RLSE Y

7.5 CompensationPlanCap Limited S_IC_PLAN_CAP Y

7.5 CompensationSkew Enterprise S_IC_SKEW Y

7.5 Competency Private S_CMPTNCY Y

7.5 Content Set Limited S_CB_CNTNT_SET Y

7.5 Content Type Limited S_CB_CNTNT_TYPE Y

7.5 Curriculum Course Person Private S_CURR_CRSE_PER Y

7.5 Curriculum Step Person Private S_CURR_STEP_PER Y

7.0.3 DD Attribute Family Limited S_DD_ATTRFAM Y

7.5 DD Attribute Family Private S_DD_ATTRFAM Y

7.0.3 DD Data Object Limited S_DD_DATA_OBJ Y

7.5 DD Data Object Private S_DD_DATA_OBJ Y

7.0.3 DD DbConnector Limited S_DD_DB_CNCTR Y

7.5 DD DbConnector Private S_DD_DB_CNCTR Y

7.0.3 DD Dimension Limited S_DD_DIM Y

7.5 DD Dimension Private S_DD_DIM Y

7.0.3 DD Extract Limited S_DD_EXTRACT Y

7.5 DD Extract Private S_DD_EXTRACT Y

7.5 Deal Limited S_DEAL Y

7.5 DecisionBroker Enterprise S_BRKR_DECISION Y

7.0.3 DockRoute Enterprise S_DOCK_ROUTE Y

Table 27. Docking Comparison - Docking Object Differences

Version Docking Object Visibility Level Primary Table DO Active?
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7.5 DockRoute Limited S_DOCK_ROUTE Y

7.5 DockSession Private S_DOCK_SESSION Y

7.0.3 Docking Object Enterprise S_DOCK_OBJECT Y

7.5 Docking Object Limited S_DOCK_OBJECT Y

7.5 Dynamic Hierarchy Private S_DYN_HRCHY Y

7.0.3 EAILookupMap Enterprise S_EAI_LOOKUPMAP Y

7.5 EAILookupMap Limited S_EAI_LOOKUPMAP Y

7.5 ETL Country Region Private S_ETL_CTRYREGN Y

7.5 ETL Curr Run Private S_ETL_CURR_RUN Y

7.5 ETL Day Private S_ETL_DAY Y

7.5 ETL Industry Private S_ETL_INDUS_VER Y

7.5 ETL String Private S_ETL_STRINGS Y

7.5 ETL Time Day Private S_ETL_TIME_DAY Y

7.5 ETL VI Image Private S_ETL_VI_IMAGE Y

7.5 ETL VR Image Private S_ETL_VR_IMAGE Y

7.5 EmployeeAward Private S_PER_AWARD Y

7.5 EmployeeCompetency Private S_EMP_CMPTNCY Y

7.5 EmployeeEduQualification Private S_PER_EDU_QUAL Y

7.0.3 EmployeePerformanceRating Enterprise S_PERF_RATING Y

7.5 EmployeePerformanceRating Enterprise S_PERF_RTNG_SCL Y

7.0.3 EmployeePerformanceReview Enterprise S_PERF_RVW Y

7.5 EmployeePerformanceReview Enterprise S_PERF_RVW_TMPL Y

7.5 EmployeeProfCertification Private S_PER_PROF_CERT Y

7.5 EmployeeProfMembership Private S_PER_PROF_MBR Y

Table 27. Docking Comparison - Docking Object Differences

Version Docking Object Visibility Level Primary Table DO Active?
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7.5 EmployeeReviewComponent Private S_RVW_COMP Y

7.5 EmployeeWorkExperience Private S_PER_WRK_EXP Y

7.5 Event Location Limited S_EVTLOC Y

7.5 GroupNews Limited S_CONTENT_PATH Y

7.0.3 IntegrationObjectMap Enterprise S_INT_OBJMAP Y

7.5 IntegrationObjectMap Limited S_INT_OBJMAP Y

7.0.3 InternalOrg Enterprise S_ORG_INT N

7.5 Job Profile Private S_JOB_PROFILE Y

7.5 LicenseUsage Private S_LICENSE_USAGE Y

7.0.3 ListofValue Enterprise S_LST_OF_VAL Y

7.5 ListofValue Limited S_LST_OF_VAL Y

7.5 Localization Limited S_LOCALE Y

7.0.3 MasterForecast Enterprise S_MSTR_FCST Y

7.5 MasterForecast Private S_MSTR_FCST Y

7.5 NamedUser Private S_NAMED_USER Y

7.5 News Package Enterprise S_NEWS_PKG Y

7.5 Nquire Account Private S_NQ_ACCT Y

7.5 Nquire Job Private S_NQ_JOB Y

7.5 OnLink Category Private S_ONL_CATEGORY Y

7.0.3 OpptyForecast Limited S_OPTY_FCST Y

7.5 OpptyForecast Private S_OPTY_FCST Y

7.0.3 OpptyProdForecast Limited S_OPTYPRD_FCST Y

7.5 OpptyProdForecast Private S_OPTYPRD_FCST Y

7.0.3 OrgForecast Limited S_ORG_FCST Y

Table 27. Docking Comparison - Docking Object Differences

Version Docking Object Visibility Level Primary Table DO Active?
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7.5 OrgForecast Private S_ORG_FCST Y

7.5 Partner Web Service Port Private S_PRTNR_WS_PORT Y

7.0.3 PersonForecast Limited S_PER_FCST Y

7.5 PersonForecast Private S_PER_FCST Y

7.0.3 Position Enterprise S_POSTN N

7.0.3 Product Business Unit Limited S_PROD_INT_BU Y

7.5 ProductBusinessUnit Limited S_PROD_INT_BU Y

7.5 ProductDefectProductLine Limited S_PRDFCT_PRODLN Y

7.0.3 ProductForecast Limited S_PROD_FCST Y

7.5 ProductForecast Private S_PROD_FCST Y

7.5 Project Attachment Log Private S_PROJ_ATT_LOG Y

7.5 ProxyAccessUser Private S_USER_PROXY Y

7.0.3 Responsibility Enterprise S_RESP Y

7.5 Responsibility Limited S_RESP Y

7.5 Revenue Template Enterprise S_REVN_TMPL Y

7.5 SA Application Limited S_SA_APPL Y

7.5 SA ContentType Limited S_SA_CNTNT_TYPE Y

7.5 SA NameValueDef Limited S_SA_NMVAL_DEF Y

7.5 SalesHierarchy Limited S_SLS_HIER Y

7.5 SalesHierarchyVersionRule Private S_SLSHR_VER_RL Y

7.5 SalesTerritory Limited S_SLS_TERR Y

7.5 SalesWarehouseHierarchy Private S_SLS_TERR_WHIR Y

7.5 SystemKeyMapping Private S_SYS_KEYMAP Y

7.5 Task Based Process Limited S_TASK_PROCESS Y

Table 27. Docking Comparison - Docking Object Differences

Version Docking Object Visibility Level Primary Table DO Active?
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7.5 TeamCompetency Private S_TEAM_CMPTNCY Y

7.5 Test Run Question Category Private S_TSTRUN_CATSTS Y

7.5 TestCore1 Private T_MASTER Y

7.5 TestCore2 Private T_DETAIL Y

7.0.3 Time Zone Enterprise S_TIMEZONE Y

7.5 Time Zone Limited S_TIMEZONE Y

7.5 Training Course Private S_PROD_INT N

7.5 UniversalInboxItem Limited S_UNVBX_ITEM Y

7.5 UniversalInboxItmTyp Limited S_UNVBX_ITMTYPE Y

7.5 UsageSummary Private S_USAGE_SUMMARY Y

7.5 User Role Task Limited S_USER_TASK Y

7.5 Web Application Private S_WEB_APPL Y

7.5 Web Service Enterprise S_WS_WEBSERVICE Y

7.5 Web Service Port Type Enterprise S_WS_PORT_TYPE Y

7.0.3 Workflow Enterprise S_WF_STEP Y

7.5 Workflow Limited S_WF_STEP Y

7.0.3 XAClass Enterprise S_XA_CLASS Y

7.5 XAClass Limited S_XA_CLASS Y

7.5 ePortalItem Private S_PRTL_ITEM Y

7.5 ePortalPage Private S_PRTL_PAGE Y

Table 27. Docking Comparison - Docking Object Differences

Version Docking Object Visibility Level Primary Table DO Active?
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The tables in this section identify the docking objects that changed visibility levels 
from Siebel 7.0.3 to Siebel 7.5, such as Enterprise to Regional. These changes help 
optimize mobile database size.

To read Table 28 through Table 32, compare a pair of rows—the 7.03 Version with 
the 7.5 Version immediately below it. The docking objects listed in Table 28 through 
Table 32 on page 289 are double entries in the Dock Object field, which allows 
comparison between the two versions.

Table 28. Docking Objects Changed from Enterprise to Regional

Version Docking Object Visibility Level

7.0.3 AssignGroup Enterprise

7.5 AssignGroup Regional

7.0.3 BusComp Audit Enterprise

7.5 BusComp Audit Regional

7.0.3 CHAMP Enterprise

7.5 CHAMP Regional

7.0.3 CTI Cfg Enterprise

7.5 CTI Cfg Regional

7.0.3 DockRoute Enterprise

7.5 DockRoute Regional

7.0.3 Docking Object Enterprise

7.5 Docking Object Regional

7.0.3 EAILookupMap Enterprise

7.5 EAILookupMap Regional

7.0.3 IntegrationObjectMap Enterprise

7.5 IntegrationObjectMap Regional
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These docking objects pick up a routing value from the user interface. Their 
visibility levels can be set to enterprise, regional, or private depending upon the 
value entered through the UI.

Table 29. Docking Objects Changed from Enterprise to UI Based

Version Docking Object Visibility Level

7.0.3 Call Script Question Enterprise

7.5 Call Script Question User-Interface Based

7.0.3 ListofValue Enterprise

7.5 ListofValue User-Interface Based

7.0.3 Workflow Enterprise

7.5 Workflow User-Interface Based

Table 30. Docking Objects Changed from Enterprise to Private

Version Docking Object Visibility Level

 7.0.3 CommTemplate Enterprise

 7.5 CommTemplate Private

Table 31. Docking Objects Changed from Enterprise to Limited

Version Docking Object Visibility Level

 7.0.3 Responsibility Enterprise

 7.5 Responsibility Limited
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Table 32. Docking Objects Changed from Limited to Regional

Version Docking Object Visibility Level

7.0.3 Comm Limited

7.5 Comm Regional

7.0.3 DD Filter Limited

7.5 DD Filter Regional

7.0.3 DD Hierarchical Attribute Limited

7.5 DD Hierarchical Attribute Regional

7.0.3 DD List Format Limited

7.5 DD List Format Regional

7.0.3 DD Measure Limited

7.5 DD Measure Regional

7.0.3 DD Measure-based Attribute Limited

7.5 DD Measure-based Attribute Regional

7.0.3 DD Sort Family Limited

7.5 DD Sort Family Regional

7.0.3 DD Source Code Format Limited

7.5 DD Source Code Format Regional

7.0.3 Note Limited

7.5 Note Regional

7.0.3 OrgSource Limited

7.5 OrgSource Regional

7.0.3 ProductDefect Limited

7.5 ProductDefect Regional

7.0.3 PrspCon Limited

7.5 PrspCon Regional
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New Regional Docking Objects
New Regional docking objects listed below help prevent routing of regional data to 
mobile Web clients. This also helps to optimize the mobile database size.

Table 33. New Regional Docking Objects

Version Docking Object Visibility Level

7.5 AssignRuleGroup Regional

7.5 Content Set Regional

7.5 Content Type Regional

7.5 GroupNews Regional

7.5 ProductDefectProductLine Regional

7.5 SA Application Regional

7.5 SA ContentType Regional

7.5 SA NameValueDef Regional

7.5 Task Based Process Regional

7.5 UniversalInboxItem Regional

7.5 UniversalInboxItmTyp Regional
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This appendix describes the routing models in Siebel Financial Services that are 
different from the routing models in Siebel Remote and Replication Manager. 
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Using Routing Models in Siebel Financial Services
This section describes the routing models available out-of-the box in Siebel 
Financial Services. Each model determines what data will be extracted to, and what 
follow-on transactions will be routed to, mobile Web clients belonging to that 
model. 

Each mobile user is associated with one routing model. A Routing Model includes 
a set of routing rules. The union of the routing rules determines whether a record 
will be routed to a mobile Web client. By careful application of specific routing 
models, local database sizes can be reduced, and, as a result, so are synchronization 
times and transaction application times.

Caution: Make sure Routing Models are consistent with the responsibilities and 
positions of the mobile users. The responsibilities and position of an employee 
determine the access that person has to the Server database. Balancing the data 
routing model with a user’s access helps to optimize the size of that user’s local 
database. 

Siebel Financial Services includes the following, pre-defined, financial-services-
specific routing models as indicated Table 34 on page 292.

Table 34. Pre-defined Siebel Financial Services Routing Models

Routing Model Siebel Responsibility Type

Institutional Finance 
Sales Manager

Institutional Finance Sales 
Manager

Specialized

Institutional Finance 
Analyst

Institutional Finance Analyst Specialized

Credit Originator Credit Originator Specialized

Insurance Sales Agent Insurance Sales Agent Specialized

Insurance Sales 
Manager

Insurance Sales Manager Specialized

Claims Adjuster Claims Adjuster Specialized

Claims Manager Claims Manager Specialized
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Each of these models should be used with a specific Siebel Responsibility as shown 
above. For customers that have a business requirement to reduce the amount of data 
replicated to mobile users, use one of the specialized routing models may be 
appropriate. Before deploying Siebel Remote with any of these specialized routing 
models, it is strongly recommended that you discuss this with Siebel Technical 
Support. 
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Analyzing the Use of Routing Models
Before using the specialized Siebel Routing Models, assess and consider the impact 
of the following:

■ Analyze the mobile users' usage patterns. Determine what data the users need 
and what they do not need when using Siebel Financial Services in the local 
mode. 

■ Compare the usage pattern with the definition of each routing model. Each 
model was designed for a specific class of mobile users. 

■ Perform a review of your Siebel installation and consider the following:

■ Did you modify any of the views assigned to the Siebel Responsibilities?

If an MVG field were added to an existing view, a mobile user could set the 
value of the MVG field to a “No Match” row-id by modifying any fields in the 
row or selecting the MVG field. The reason is that no data for the MVG was 
downloaded to mobile Web client. This action implicitly creates an update 
transaction to be replicated to the server during the next synchronization 
session. Database integrity is compromised when the transaction is applied 
on the server.

■ Did you modify any of the Siebel Responsibilities by adding new views that 
are accessible in local mode?

Generally, views that contain data from limited visibility objects should have 
routing rules to support them. If a view is added that does not have 
corresponding routing rules, then no data will be replicated for that specific 
view. If such a view was added to a Siebel Responsibility and the 
implementation uses Client Wins for update conflict resolution, the following 
undesirable situation could occur—this should be avoided. 

❏ A mobile user creates a new record using the newly added view on the 
mobile Web client.

❏ The mobile user synchronizes with the server.

❏ A Web client user makes changes to the same record on the server.

❏ The mobile user synchronizes and does not see the updates by the Web 
client to the same record.
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❏ The mobile user makes changes to the record in the mobile Web client.

❏ The mobile user synchronizes and overwrites the content of the record on 
the server.

In this manner, a mobile user could unintentionally overwrite updates made 
by another user to the same record.

■ Exposing a custom foreign key in a Siebel view and business component.

A custom foreign key may not have any Siebel Remote routing support, 
because routing rules were either deactivated out-of-the-box or no rule was 
created. As a result, no data will be routed to support the foreign key. If any 
base record containing this foreign key is touched or updated by a mobile 
user in their local database, it may inadvertently reset the reference to null 
and in turn, replicate this change to the server.

■ If the answer to any of the above questions was yes, do not use any of the 
specialized routing models in Table 34 on page 292. 

■ If the answer to all the above questions was no, conduct a field test with a small 
group of representative mobile users. Use the appropriate routing models and 
assess the impact of the specialized routing models on the Transaction Router. 
During the test, observe the following:

■ Local database size and the amount of data being replicated—should be 
reduced. 

■ Mobile users can still perform business tasks—no data is missing that 
prevent the users from completing a critical business process.

■ Synchronization times—should be shorter.

■ Every server transaction should be routed to the mobile Web client except for 
those explicitly excluded in the routing models—if not, the users 
responsibilities may not match the routing model.

■ Every view that has data on the server should show the same data on the 
mobile client—if not, there is a strong possibility the wrong views were 
included in the users’ responsibilities.

■ If you have acceptable results from the field test, you are ready to deploy the 
routing models to the appropriate mobile users. 
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Descriptions of Financial Services Routing Models
The descriptions on the following pages include the routing models available out-
of-the-box in Siebel Financial Services. For more information about other Siebel 
eBusiness Applications routing models and application of these, see “Using Routing 
Models” on page 100.

Insurance Sales Agent
The Insurance Sales Agent model should be used for insurance field sales agents in 
your organization. This routing model should also be used for other remote users 
such as health insurance sales agents and site-visit coordinators. Users assigned the 
Insurance Sales Agent routing model receive a database extract and follow-on 
transactions dealing with information relevant to their positions. 

The business components associated with this model include the following: 

■ Activities 

■ Applications

■ Calendar Access 

■ Companies

■ Contacts

■ Events

■ Facilities

■ Households 

■ Opportunities

■ Policies

■ Providers

■ Claims

■ Service Requests
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Insurance Sales Manager
This routing model should be used for insurance sales managers in your 
organization. Users assigned the Insurance Sales Manager routing model will 
receive database extracts and follow-on transactions dealing with information 
relevant to a manager of insurance sales agents. All records routed to any of a 
manager's direct reports will also be routed to the manager. 

The business components associated with this model include those listed above for 
the Insurance Sales Agent in addition to the manager's Team's data associated with 
those business components.

Claims Adjuster
The Claims Adjuster model should be used for insurance field claims adjusters in 
your organization. The business components associated with this model include the 
following:

■ Households

■ Contacts

■ Policies

■ Service Providers

■ Claims

■ Claim Elements

■ Service Requests

■ Activities

■ Calendar Access
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Claims Manager
This routing model should be used for insurance claims managers in your 
organization. Users assigned the Claims Manager routing model will receive 
database extracts and follow-on transactions dealing with information relevant to a 
manager of claims adjusters. All records routed to any of a Claims Manager's direct 
reports will also be routed to the Claims Manager. 

The business components associated with this model include those listed above for 
the Claims Adjuster in addition to the manager's Team's data associated with those 
business components.

Credit Originator
This routing model should be used for individuals in your organization responsible 
for originating mortgages or other consumer loans and for managers of these 
individuals. Users assigned the Credit Originator routing model will receive 
database extracts and follow-on transactions dealing with information relevant to 
loan origination. Managers will see all records for themselves and for all of their 
direct reports. A manager who does not have any direct reports will not receive any 
team-based data.

The business components associated with this model include the following:

■ Activities

■ Applications

■ Contacts

■ Events

■ Opportunities

■ Products
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Institutional Finance Sales Manager
Users assigned the Institutional Finance Sales Manager routing model will receive 
database extracts and follow-on transactions dealing with information relevant to a 
manager of institutional finance sales. Managers see all records for themselves and 
all of their direct reports. A manager who does not have any direct reports will not 
receive any team-based data. This routing structure allows this model to be used for 
managers and nonmanagers alike, making for a simpler setup and administration 
process.

The business components associated with this model include the following:

■ Activities

■ Applications

■ Calendar Access

■ Call Reports

■ Companies

■ Contacts

■ Employees

■ Events

■ Expense Reports

■ Financial Accounts

■ Holdings and Interests

■ Households

■ Literature

■ Opportunities

■ Products

■ Securities
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■ Service Requests

NOTE: Literature routing is handled somewhat differently. Links to the literature are 
synched to the client but the actual literature attachments are only synched upon 
request. 

Institutional Finance Analyst
Users assigned the Institutional Finance Analyst routing model receive database 
extracts and follow-on transactions dealing with information relevant to a 
institutional finance analyst. Managers see all records for themselves and for all of 
their direct reports. A manager who does not have any direct reports will not receive 
any team-based data. This routing structure allows this model to be used for 
managers and non-managers alike, making for a simpler setup and administration 
process. 

The business components associated with this model include the following:

■ Activities

■ Calendar Access

■ Call Reports

■ Companies

■ Contacts

■ Employees

■ Events

■ Expense Reports

■ Holdings and Interests

■ Literature

■ Products

■ Securities

■ Service Requests
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administrator password, changing 244
All List view, restriction 66
All Opportunity List view, restriction 

on 66
analyst routing model 115
application servers, setting up, regional 

nodes 234
attachment files, monitoring 151, 152
authentication

mobile client passwords 121
Replication Manager 244
synchronization authentication, types 

of 25
Authentication parameter 74
autodial preferences 86
AutoStopDB parameter 24

C
cache size parameters 75
CDDir parameter 130
CD-ROM, extracting to 129
child records, repairing orphaned 

records 274
CleanFilesIter parameter 69
CleanTxnsIter parameter 69
Client parameter 130, 222
Client Status view 146, 151
Client Wins rule 53
ClientDbType parameter 82
ClientRootDir parameter 87
ClientVersion parameter 131, 222
commit interval 63
configuration file, setting preferences 87
conflict detection 52

conflict resolution
about 23, 52
deleting conflicts 55
duplicate conflicts 54
merging conflicts 55
notification, system preference 

setting 63
system preference settings 61
system preferences 61
updating conflicts 53

connected users
adding 237
downloading changes to local database, 

process 43
regional node support 197

connection parameters, encryption 91
connection time evaluation 159
consultant routing model 114
CSM log

activating 276
deleting entries 277

CSM Logging 63
CSSSISDockFgetACKMsg 262

D
data

conflicts between mobile users 52
divergence 52
recovery 245
storage, about 27

data integrity, corruption of 66
data routing models

about 100
analyst 115
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consistency with positions and 
responsibilities 101

consultant 114
field engineer 110
field technician 102
minimal data 116
mobile client extract only 117
mobile client standard 117
mobile partner user 117
sales manager standard 102
sales representative standard 101
senior field technician 104

database
See also local database
components, start-up parameters 81
database commit, interval 63
foreign key relationships 66
initialization 32
objects populated with data 224
template generation at server setup 36

database extract
about 33
about running for mobile client 124
client database initialization of 133
concurrency rules 51
conflict resolution rules 53
extract file location parameter 222
extract parameters 130, 132
extracting to a CD-ROM directory 129
InitMethod parameter 222
list of users, extracting 127
multiple extracts 124
parallel extract size 

recommendation 222
parameters table 222
reporting hierarchies, condition of 125
running 126
sample server directory tree 222
Target node error message 133

database files. See database templates
Database Init Method parameter 222
database server

about 17
access, about 18

hardware failure 177
media failure 178
RDBMS failure 177
types of data stored 27

database snapshot
Generate New Database component, 

running 80
Database Template Utility 32, 79
database templates

about 79
creating 80
distributing 82
regenerating, timing of 32

database volatility 160
DatFileSize parameter 131, 222
DBA password, changing 77
DbaPwd parameter 81
DbfFile parameter 81
DbTmplFile parameter 130
DBX: Vis Rules Per Statement 1 64
DBX: Vis Rules Per Statement N 64
dbxtract task 220
DCK-00123 error 260
DCK-00164 error 260
DCK-00213 error 261
DCK-00214 error 261
Default Processes parameter 232
diccache.dat file 234
dicdata.dat file 234
dictionary files 234
directories, application server 31
disk space requirements 159
distmpl, invoking 82
dock objects

about 198
defined 34

DockConnString machine 24
DockConnString parameter 87
docking

changing routing rules 34
database template, creating new 79
directory, about creating 21
hardware architecture 17
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Docking: Get All PostnCon Rows 62
Docking: Transaction Logging 61
DockRepositoryName parameter 88
DockTxnsPerCommit parameter 89
Download Statistics view 152
duplicate conflicts 54
DX files

editing restriction (caution) 266
size parameter 240
storage of 21
transaction exchange 30

E
ErrorMode parameter 73
ExtractRepos parameter 130
ExtractSince parameter 130

F
field engineer routing model 110
field technician routing model 102
file server, media failure 177
File System Manager, duties of 214
foreign key relationships, problems 

with 66

G
Generate New Database

about 32
database template, creating 79

Generate New Database component, 
running 80

H
hardware configuration, docking 17
headquarters node

about 196
administration tasks, listed 235
sample configuration diagram 196
territory structures, importance of 

stabilizing 215
using routing group - full copy as 

backup 197

Headquarters Server, processes 202
hierarchy of regional nodes. See regional 

nodes
HQ Application Server Comm Param 

parameter 239
HQ Application Server Name 

parameter 239

I
IdDbRecreate parameter 72
IFaceTbls parameter 81
initialization

See also regional database, initializing
local database 32
problems, troubleshooting 262
troubleshooting problems 262

InitMethod parameter 130
ISpace parameter 81

L
Language Code parameter 222
Language parameter 131, 222
Local Area Network (LAN)

connections 18
synchronization 17

local database
about 29
creating, view 37
database schema template, about 32
failure, recovering from 180
initialization diagram 39
initializing 37, 39
mobile user change process 45
performance considerations 29
preventing loss of transactions 125
process flow, downloading changes 43
refreshing 162
sizing considerations 33

Local Database Initialization program 32
local file system, about 29
LOGMGR: Vis Rules Per Statement 64
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MaxCtxCache parameter 74, 75
Maximum number of operations written per 

file parameter 240
Maximum Number of Transactions to Merge 

per Database Commit Cycle 
parameter 241

MaxRead parameter 69, 71
MaxTasks parameter 74
MaxWrite parameter 71
media failures

database server 178
file server 177
Siebel Database Server 178
Siebel File Server 177
Siebel Remote Server 176

message-of-the-day 161
MinCtxCache parameter 74, 75
minimal data routing model 116
mobile clients

 See also mobile users
authentication 49
autodial preferences, setting 86
client status, about monitoring 146
configuring Regional Node, 

overview 231
configuring Siebel Regional Node 

for 231
database, initializing 135
deactivating 164, 166
deleting 166
initialization failure, recovery 180
network connectivity 85
NT user, creating 122
ODBC code page settings 84
password, creating 122
productivity evaluation 160
reactivating 164
registering 94, 96
reinitialization, synchronization 

requirement 224
remote status, viewing 138

repository upgrades, preparing for 252
server directories, creating 31
synchronization requests, handling 33
synchronization start-up process 136, 

137
task overview 83, 123
transaction log truncation, consequences 

of 28
mobile clients, database

adding to regional database 236
assignment to 218
authentication with database 49
initializing 134
local database, use of 29

mobile clients, database extract
about running 124
client database initialization 133
extract parameters 130, 132
extracting to a CD-ROM directory 129
list of users, extracting 127
multiple extracts 124
reporting hierarchies, condition of 125
running 126

mobile clients, routing models
about 100
analyst 115
consultant 114
field engineer 110
field technician 102
minimal data 116
mobile client extract only 117
mobile client standard 117
mobile partner user 117
sales manager standard 102
sales representative standard 101
senior field technician 104

mobile clients, synchronization
procedure 48
process, overview 40, 42

mobile partner user routing model 117
mobile users

See also mobile clients
about 15
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All List view, restriction 66
All Opportunity List view, restriction 66
change process 45
conflicting data resolution 52, 55
directories 31
local database, creating 37
message-of-the-day 161
registration prerequisite 36
routing model, changing 168
sending messages to 161
Siebel Remote and Siebel Replication 

Manager, comparison of 194
Siebel Remote client, starting 30
starting synchronization session 41, 42
synchronization frequency 159
unable to view records, 

troubleshooting 268
modem connections

about 18
servers 160

monitoring tasks 244
Move parameter 131
MRG: Docking Timestamp Source 61
MRG: System Conflict Resolution 61
MRG: Txns per Commit 63
MRG: User Friendly Notification 63, 138

N
nodes

node hierarchy, about 215
parent node, defined 194
regional node, defined 194

NTDomain parameter 74
Number of iterations parameter 241

O
ODBC

code page settings 84
drivers 212

Oracle database
enabling srvrinit utility 213

storage parameters for Regional 
Database 214

orphaned child records, about 
repairing 274

OutputDir parameter 222

P
parent node

defined 194
password, changing administrator 

password 244
pdbxtract task 221

Q
quiet mode 24

R
RDBMS

failure 177
requirements for regional nodes 213

ReadClientsIter parameter 72
Receive files from the HQ server 

parameter 240
Receive txns from the HQ server 

parameter 240
regional database

about data recovery 245
about synchronizing 238
about upgrading 250
accounts, about creating 230
adding mobile users 236
backing up data 245
connected users, adding 237
determining contents of 197
extraction, single thread 219
installation prerequisites 213
mobile databases, adding 218
parallel extraction 220
required accounts 213
rollback segment size requirement 225

Regional Database Server, about 
installation 213, 214
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about initializing 224
about restarting initialization 

process 226
Initialization utility 224
post-initialization tasks 230
procedures 225, 226
restarting initialization 226

regional database, routing group
about changing 242
role of 197

Regional Node
overview of configuring for mobile 

clients 231
regional nodes

about defining 215
about regional node hierarchy 195
about reinitializing 224
administration tasks, listed 235
application servers, setting up 234
connected users, adding 237
data contents 197
deactivating 247
defined 194
implementation process overview 209, 

210
installation prerequisites 209
mobile clients, adding 236
RDBMS requirement for 213
reactivating 248
registering 216, 217
required components 199, 201
sample configuration diagram 196
sample server directory tree 222
Siebel components, required 211
Siebel Database Server, about 

installing 213
Siebel File System requirement 214
Siebel Gateway Server installation 212
Siebel Server, about installing 212
synchronization tip 215
territory structures, importance of 

stabilizing 215

types of users supported 197
upgrading the repository 250, 253

Regional Server - Full Copy option. See 
routing group, full copy option

Regional Server - Standard option. See 
routing groups, standard option

remote implementation
changing routing rules 34
database template, creating 79

remote server. See Siebel Remote Server
remote status, viewing 138
Replication Agent

about 238
parameter table 239, 241
starting 232, 238

Replication Manager
architecture 195
authentication 244

repository. See Siebel Repository
responsibilities, routing model 

consistency 101
rollback segment, reducing size of 225
routing group

about 242
changing 242
modification of 199
and Regional Nodes 197

routing group, full copy option
about 197
compared to routing group - 

standard 198
routing group, standard option

about 197
compared to routing group, full 

copy 198
guideline for using 198

routing models
about 100
analyst 115
changing for mobile user 168
consistency with positions and 

responsibilities 101
consultant 114
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minimal data 116
mobile client extract only 117
mobile client standard 117
mobile partner user 117
sales manager standard 102
sales representative standard 101
senior field technician 104

routing rules
about 34, 198
number checked, system preference 

setting 64
preconfigured routing rules 35

S
S_DOCK_TXN_LOG

flow diagram 21
troubleshooting 270
truncation, consequences of 28

sales manager routing model 102
sales representative routing model 101
Selective retrieval 17
Send txns to the HQ server parameter 240
senior field technician routing model 104
Server Manager, monitoring Siebel Remote 

server tasks 157
server modem connections 160
Server Wins rule 53
Session Manager 40
SetAppName parameter 71
Siebel Administrator account 213
Siebel Anywhere, repository upgrade 251
Siebel Assignment Manager, role in regional 

node definition 215
Siebel Client database

recovering from failure 180
refreshing 162

Siebel Database Server
downloading changes to local database, 

process 43
headquarters node 196
media failure 178

mobile user change process 45
Regional Nodes, about installing for 213

Siebel database, about 17
Siebel File Server, troubleshooting media 

failure 177
Siebel File System

about 18
contents of 28
File System Manager, role of 214
headquarters node 196
local file system, about 29
requirement for regional nodes 214

Siebel Gateway Server, about 
installing 212

Siebel Mobile Web Client. See mobile clients 
entries 19

Siebel Remote
about 15
architecture diagram 17
compared to Siebel Replication 

Manager 194
conflicting data, resolution 52
data flow diagram 25, 26
hardware components 17, 19
process overview 20, 24
server tasks, monitoring 157
system preferences, setting 58
transmission failure 176
Windows NT user rights, enabling 76

Siebel Remote client
about 18, 30
communication protocol 30
setup overview 256
standalone synchronization 30

Siebel Remote Server
about 18
between synchronization sessions 42
components, configuring for mobile 

clients 231
components, starting/stopping 142
contents of 22
database template generation 36
databases, distributing 82
Version 7.5, Rev. A Siebel Remote and Replication Manager Administration Guide 307



Index
directories for mobile users 31
media failure 176
routing and merging diagram 40
server failure 176
setup overview 256
start-up parameters 67

Siebel Remote Synchronization Manager, 
security and authentication 49

Siebel Replication Manager
administration tasks, listed 235
architecture 195, 197
benefits of 195
compared to Siebel Remote 194
overview 194
sample configuration diagram 196

Siebel Repository
about upgrading 250
upgrading (without Siebel 

Anywhere) 252, 253
upgrading with Siebel Anywhere 251

Siebel Server
about installing for regional nodes 212
authentication process 49
headquarters node 196
installing for Regional Node 212

Siebel Tableowner account 213
Siebel Tools 250
Siebel Upgrade Wizard 225
Siebel Web Server Extension (SWSE) 230
SleepTime parameter

Replication Agent parameter 239
Transaction Merger startup 

parameter 73
Transaction Processor startup 

parameter 69
Transaction Router startup parameter 71

SQL
number routing rules checked, system 

preference setting 64
routing rules system preference 

setting 64
SQL Anywhere, suppressing window at 

startup 24

SRF file. See Siebel Repository
srvrinit utility

about implementing 213
enabling in Oracle 213
location 224
parameters and command-line 

flags 227, 228
Stand-Alone Synchronizer 136, 137
storage parameters, Oracle requirements for 

Regional Database 214
synchronization

See also Synchronization Manager; 
Replication Agent

about repairing orphaned child 
records 274

about synchronizing regional 
database 238

after failure 245
authentication parameter 25
authentication process 49
background synchronization 30
between sessions 42
configuration parameters 87
connection parameter encryption 91
defined 15
diagnosing and restoring database 

synchronization 178, 179
frequency managing 159, 160
local transaction log, clearing 45
mobile clients, procedure 48
overview 40, 42
process overview 22
recommended frequency 25
Stand-alone 30
starting session, mobile user 41, 42
starting Siebel Remote client 30
transactions forwarding from Siebel 

Remote 29
troubleshooting 262

Synchronization Manager
authentication and security 49
concurrency rules 51
database connections 75
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system preferences

CSM Logging 63
DBX: Vis Rules Per Statement 1 64
DBX: Vis Rules Per Statement N 64
Docking: Get All PostnCon Rows 62
Docking: Transaction Logging 61
LOGMGR: Vis Rules Per Statement 64
MRG: Docking Timestamp Source 61
MRG: System Conflict Resolution 61
MRG: Txns per Commit 63
MRG: User Friendly Notification 63, 138
setting 58

T
TableOwner parameter 88
tablespaces, data and index 214
Target node error message 133
timestamp system preference settings 61
trace file 266
Transaction Log table, managing 246
transaction logs

log table, deleting entries 270, 272
modifying 45
monitoring 154

Transaction Merger
about 23, 35
concurrency rules 51
configuring 68
enabling logging, system preference 63
optimal number, determining 145
process diagram 40
starting 68
start-up parameters 73
troubleshooting 266

Transaction Processor
about 28, 34
concurrency rules 51
routing transactions 28
setup rules 143
starting 67

start-up parameters 68, 70
transaction log table, deleting entries 

from 270, 272
Transaction Router

about 28, 34
concurrency rules 51
configuring 71
optimal number, determining 144
parallel processes, about running 144
performance of 35
preference setting for S_POSTN_CON 

table 62
process diagram 40
setup rules 144
starting 67, 68
start-up parameters 71

transactions
about processing 15
between synchronization sessions 42
log file (S_DOCK_TXN_LOG) 21
processing, flow description 21
transaction log, truncation warning 28
transaction logging system preference 

setting 61
viewing transaction information 151, 

152
transmission failures 176
troubleshooting

client initialization failure, recovery 180
CSSSISDockFgetACKMsg 262
DCK-00123 error 260
DCK-00164 error 260
DCK-00213 error 261
DCK-00214 error 261
DX file editing restriction 266
initialization problems 262
mobile users unable to see records 268
RDBMS failure 177
Siebel Database Server media 

failure 178
Siebel File Server media failure 177
Siebel Remote Server failure 176
Siebel Remote Server media failure 176
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trace file 266
transaction log table 270, 272
transaction merger failure 266

TruncateTSTable parameter 132
TSBlockSize parameter 69, 132
TSCacheSize parameter 70, 71, 132
TSpace parameter 81
TSTableNum parameter 132
txnroute.exe file, startup parameters 71

U
update conflicts 53
Upload Statistics view 151
UseDdlFile parameter 81
UseTxnLog parameter 81

V
visibility

dock object classification 34
mobile client standard routing 

model 117
mobile users, restriction 66
troubleshooting problems with 268

W
WAN connections, about 18
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Windows NT user rights, enabling 76
WriteCompressed parameter 69, 71
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